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Overview
MYOB Corporate Compliance is used for ensuring that your corporate clients comply 
with the Corporations Act 2001. Corporate Compliance does this by producing and 
lodging all major Australian Securities and Investments Commission (ASIC) forms and 
documents quickly and easily.

Key benefits

 Developed using the latest Windows technology.

 Contains an intuitive interface with a Task Bar (see “Task bar” on page 9) and a 
display panel (see “Display panel” on page 10).

 Integrated with MYOB AE, MYOB AO, and other members of the MYOB suite.

 Compliant with all reporting requirements for ASIC.

 Produces all major ASIC forms (see “Working with ASIC forms” on page 170) and 
minutes with ease.

 Able to electronically lodge major ASIC forms and download data from ASIC (see 
“Requesting agent reports from ASIC” on page 201).

 Prompts for ASIC forms to be prepared and lodged in response to changes from 
MYOB AE and MYOB AO. See “Changes from AE/AO” on page 12.

 Contains intuitive workflow wizards (see “Workflow wizards” on page 168) to 
guide you through the process of generating forms and documents.

 Includes an easy to use backup and restore utility (see “Backup and restore” on 
page 259).

Related topics
Using Corporate Compliance
ASIC Forms

Using Corporate Compliance

Corporate Compliance is a web-style application with a simple and consistent 
interface that is easy to learn and use.

The interface consists of the following components:

 A Task bar (see “Task bar” on page 9)

 A display panel (see “Display panel” on page 10)

 Workflow wizards (see “Workflow wizards” on page 168)

 A preview screen (see “Previewing forms and documents” on page 40) that 
displays forms and reports.

Corporate Compliance also includes its own Backup and Restore utility (see “Backup 
and restore” on page 259). 
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Related topics
Overview
ASIC Forms
Previewing forms and documents
Backup and restore

Task bar

The Corporate Compliance interface includes a Task bar and a display panel or main 
window (see “Display panel” on page 10).

The Task Bar contains the following modules, each of which expands when clicked to 
reveal specific options for the current window:

 Corporations

 People

 Company statements

 ASIC Forms

 Lodgement

 Agents.

For example, when you click Corporations, the Search for Corporation page opens, 
and the Task Bar list under Corporations contains the options below.

Related topics
Display panel
Using Corporate Compliance
Previewing forms and documents
ASIC Forms
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Display panel

In addition to the Task Bar, the Corporate Compliance interface includes a display 
panel which occupies the rest of the screen. 

The display panel is comprised of the following:

Selection list

A Selection list contains a list of all records in the Corporations, People and Agents 
modules. To view more details, double-click the record in the list. The Details tab for 
each module then displays. 

Details tabs

In the Corporations, People and Agents modules, you can double-click a record to 
display further information in a series of Details tabs.

For example, tabs available in the Corporations module are: Details, Addresses, 
Officers, Capital, Members, Auditors, Name History, Address History, ASIC Forms and 
Documents.

To return to the Selection list, click Close.

Right-click menu

Right-click the display panel to open a drop-down menu containing appropriate 
options.

For example, on the Corporations selection list the right-click options are Open 
corporation details and Delete corporation.

Related topics
Task bar
Using Corporate Compliance
Previewing forms and documents
ASIC Forms

Corporate Compliance and MYOB AE/AO

Corporate Compliance integrates with MYOB AE/AO, so that data for corporations 
and people are stored in both systems. This means that corporations and people 
cannot be added directly into Corporate Compliance. They must be added first to 
MYOB AE/AO, then completed in Corporate Compliance.

See the following topics:

 “Adding and changing integrated data” on page 11

 “Changes from AE/AO” on page 12
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 “Updating from MYOB AE” on page 13

 “Multiple tasks generated for addresses shared in MYOB AE/AO” on page 13

 “Deleting tasks” on page 14.

Related topics
Adding and changing integrated data

Adding and changing integrated data

The following data must be added and maintained in MYOB AE/AO.

All remaining data (for example, office appointments, capital, members) is added and 
maintained in Corporate Compliance.

To add data

1. Enter corporate and people data, as per the table above, into MYOB AE/AO.

2. Add the corporation’s data to Corporate Compliance, according to whether it is 
an existing corporation (see “Creating corporations using an imported data file” 
on page 22) or newly registered corporation (see “Adding a corporation” on 
page 21).

To change data

1. Enter changes to MYOB AE/AO data for corporations and people.

2. View the changes in Corporate Compliance using one the following methods:

 If Corporate Compliance is not running: Run Corporate Compliance.

 If Corporate Compliance is running: Depending on your product, select 
Tools > Update from AE or Tools > Update from AO.

Corporations People

Namea

a.  Once a corporation’s name is added to MYOB AE/AO, it can only be 
changed in Corporate Compliance (whereas people’s names can only be 
changed in MYOB AE). See “Changing corporation names” on page 49.

(AE only) Name

Addressesb

b.  Except registered office details, which are maintained in Corporate 
Compliance.

Addresses

ABN and ACN Date of birth
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The following message will display on the Messages module on the Task Bar 
(depending on your product):
There are changes from AE/AO. Click here to view.

3. Click the message to display the Changes from AE/Changes from AO window.

4. Generate a form to notify ASIC of the change.

Note: If a change is made in MYOB AE/AO to an address that is shared by 
another person or corporation, then separate tasks will be 
generated in the Changes from AE/Changes from AO module for 
each other person or corporation that shares the address. 
 
If you then generate and complete a form from one of the shared 
change of address tasks (as detailed in the instructions below), all 
other people or corporations affected by the change will be 
included in the form. The task that you used as the basis for the 
form, and all related tasks, will then be deleted from the Changes 
from AE/Changes from AO module. See the online help in MYOB 
AE/AO for more information about sharing addresses.

Related topics
Overview
Changes from AE/AO
Adding corporations

Changes from AE/AO

When the MYOB AE/AO data for any person or corporation is changed, Corporate 
Compliance generates a task to inform you of the change. 

For example, if a corporation has been added to Corporate Compliance (from MYOB 
AE/AO) then any changes made to the corporation’s data in MYOB AE/AO (for 
example, registered address) will be automatically copied to Corporate Compliance.

You can access these tasks by clicking Changes from AE/Changes from AO on the Task 
Bar. Alternatively, you will be notified of the changes from the Messages module.

From this module, you can:

 Notify ASIC of the change by generating a form.

 Not notify ASIC of the change by deleting the task.

Related topics
Deleting tasks
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Corporate Compliance and MYOB AE/AO

Updating from MYOB AE

Corporate Compliance checks for changes to data in MYOB AE/AO when:

 Corporate Compliance first opens, or

 Tools > Update from AE or Tools > Update from AO is selected from the main 
menu.

When the system detects changes to MYOB AE data, the Messages module displays 
the following warning (depending on your product):

There are changes from AE/AO. Click here to view. 

Click this message to view the changes entered in MYOB AE/AO.

The Changes from AE/Changes from AO module displays (see “Changes from AE/AO” 
on page 12).

The warning in the Messages module is then removed and the module closes. It 
remains closed until Corporate Compliance detects that further tasks have been 
added to MYOB AE/AO.

Tip: You can refresh your screen to display data recently entered in Corporate 
Compliance. To do this, select View > Refresh from the main menu.

Related topics
Messages
Changes from AE/AO
ASIC Forms

Multiple tasks generated for addresses shared in MYOB AE/AO

If a change is made in MYOB AE/AO to an address that is shared by another person or 
corporation, separate tasks will be generated in the Changes from AE/Changes from 
AO module for every other person or corporation that shares the address. 

If you then generate and complete a form from one of the shared change of address 
tasks (as detailed in the instructions below), all other people or corporations affected 
by the change will be included. The task you used as the basis for the form, and all 
related tasks, will then be deleted from the Changes from AE/Changes from AO 
module.

For example, M. Brown shares her address in MYOB AE/AO with P. Brown. If you 
change M. Brown’s address in MYOB AE/AO, two separate change of address tasks 
will be generated in the Changes from AE/Changes from AO module. If you then 
generate a form using one of the tasks (e.g., M. Brown’s task), then P. Brown will be 



Overview

MYOB AO Corporate Compliance | Version 3.0 User Guide | 14

included in M. Brown’s form. When the form is generated and completed, both tasks 
will be deleted from the Changes from AE/Changes from AO screen. 

See the online help in MYOB AE/AO for more information about sharing addresses.

To generate a form in the Changes from AE/Changes from AO module

1. Select a task from the list.

2. Click Generate form.

3. If the change relates to a person, the Notify change of name or address wizard 
opens (see “Notifying ASIC of changes to names or addresses” on page 139).
If the change relates to a corporation the Notify change of address wizard 
opens (see “Notifying ASIC of corporate changes of address” on page 54).

4. Complete the wizard and lodge the form (see “Completing forms” on page 180 
and “Forms lodgement” on page 182).

Note: After you have generated a form and completed it (as outlined 
above), the task will be deleted from the Changes from AE/
Changes from AO screen. Additional tasks that were generated as 
a result of a change to a shared address will also be deleted.

Related topics
Changes from AE/AO
Deleting tasks
Messages
ASIC Forms

Deleting tasks

When changes to names or addresses are entered in MYOB AE/AO, a record of the 
change is generated in the Changes from AE/Changes from AO module.

The Delete task function is used to delete the change of name or address from the 
screen. Use this function if you do not need to advise ASIC of the change.

To delete a task

1. Select a task from the list.

2. Click Delete task.
A message box asks:
Are you sure you want to delete this task? 
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3. Click Yes to delete the task. The task will be removed from the list.
Or click No to retain the task.

Related topics
Changes from AE/AO
Completing forms
Messages
ASIC Forms

Messages

Messages are shown on the Task Bar (in the Messages module) if Corporate 
Compliance informs you of certain system changes, such as changes to names and 
addresses in MYOB AE/AO (in case you need to advise ASIC of the change) or forms 
that your practice may have received from ASIC (such as a company statement).

Corporate Compliance checks for these changes when:

 It opens, or

 You select Tools > Update from AE or Tools > Update from AO from the main 
menu.

The messages that the system displays and the action required are listed below.

After a message is clicked it is removed from the Messages module.

Message Module displayed when 
message is clicked Required action

(AE) There are changes 
from AE. Click here to 
view.
(AO) There are changes 
from AO. Click here to 
view.

(AE) Changes from AE
(AO) Changes from AO

Generate a form to 
inform ASIC of the 
change or delete the 
task. 

ERROR generating TXID Agent Try to lodge the form 
again. If the message 
displays again, contact 
MYOB Support.

Errors occurred 
generating EDGE files

Agent Try to lodge the form 
again. If the message 
displays again, contact 
MYOB Support.
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Related topics
Changes from AE/AO
Updating from MYOB AE

Validation errors 
occurred during forms 
generation

Lodgement Try to lodge the form 
again. If the message 
displays again, contact 
MYOB Support.

ERROR generating TXID Lodgement Try to lodge the form 
again. If the message 
displays again, contact 
MYOB Support.

EDGE Transmission 
report arrived

Lodgement View the transmission 
report.

EDGE Validation report 
arrived

Lodgement View the validation 
report.

Sorry, no new forms or 
reports for you from 
EDGE

Lodgement You have previously 
connected to ASIC to 
receive pending forms or 
reports, however no such 
documents were 
pending. No action 
required.

New forms/reports 
arrived from ASIC at (dd/
mm/yyyy)

Lodgement View the agent or 
corporation forms or 
reports received from 
ASIC.

Message Module displayed when 
message is clicked Required action
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Corporations
The Corporations module is used to:

 add corporations

 maintain corporation details

 delete corporations.

To access this module, click Corporations on the Task Bar. 

The Corporations selection list then appears in the main display area. 

Corporations in Corporate Compliance consist of both the companies that you do 
corporate work for, and all other companies that are associated with them. For 
example, as a member or an auditor. All non-individuals are maintained in the 
Corporations area.

Corporations that you perform compliance work for are called “managed” companies 
in Corporate Compliance. Only companies “managed” by your practice can have ASIC 
forms created for them. “Non-managed” companies are the corporations that are 
setup to be used as members or auditors.

The main corporations window lists all the companies in the Corporate Compliance 
database. From here you can select the required company and then select any task 
from the Task Bar. Or you can select the required company and open it to see all 
details for the corporation. The details are grouped under the following tabs:

 Details

 Addresses

 Officers

 Capital 

 Members

 Shares & Units Held

 Auditors

 Name History

 Address History

 Holding Company

 ASIC Forms

 Documents

 Charges

 Positions Held.

This list contains all corporations that have been added to Corporate Compliance. 
Select Show managed corporations only to display only managed companies. 

To include all corporations from MYOB AE / MYOB AO in the list, select  Include all 
Corporations from AE / Include all Corporations from AO respectively.
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Related topics
Working with corporations
Using Corporate Compliance
Adding corporations
Changing corporation details
Deleting corporations

Working with corporations

This section includes:

 “Corporate keys” (see page 18)

 “Adding corporations” (see page 19)

 “Changing corporation details” (see page 23)

 “Deleting corporations” (see page 25)

 “Searching for corporations or people” (see page 26)

 “Requesting company data from ASIC” (see page 26)

 “Changing ultimate holding company details” (see page 119)

 “Updating details with data received from ASIC” (see page 28)

 “Appointing and ceasing agents” (see page 32)

 “Applying for registration” (see page 33)

 “Applying for deregistration” (see page 37)

 “Previewing forms and documents” (see page 40).

Related topics
Using Corporate Compliance
Adding corporations
Changing corporation details
Deleting corporations

Corporate keys

The ASIC maintains a unique identifier for each company, called the Corporate Key. 
This is an 8 digit number, that is associated with the ACN of the company. This 
identifier is used for security purposes. The ASIC has provided this as a “a security 
feature to prevent unauthorised persons altering your company information”.

http://www.asic.gov.au/asic/asic_srchlodg.nsf/byheadline/
ASIC+Corporate+Key?openDocument 

http://www.asic.gov.au/asic/asic_srchlodg.nsf/byheadline/ASIC%2bCorporate%2bKey?openDocument
http://www.asic.gov.au/asic/asic_srchlodg.nsf/byheadline/ASIC%2bCorporate%2bKey?openDocument
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The Corporate Key is private information, which is only known to ASIC and the person 
who received the Company Statement. The Corporate Key is updated by ASIC each 
year for security reasons.

To enter the Corporate Key (as displayed on the Company Statement received)

1. Click Corporations and select the Corporation from the list.

2. Click Open.

3. Click the Details tab.

4. Click Change Details.

The Corporate Key is printed on the paper copy of these forms:

 Form 484 — change to company details.

 Form 370 — notification of resignation.

 Form 362 — appointment or cessation of a registered agent.

Related topics
Adding corporations
Changing corporation details
Deleting corporations
Searching for corporations or people
Requesting company data from ASIC
Changing ultimate holding company details
Updating details with data received from ASIC
Appointing and ceasing agents
Previewing forms and documents

Adding corporations

Corporations cannot be added directly to Corporate Compliance. They are added first 
in MYOB AE/AO then copied to Corporate Compliance, when a new corporation is 
registered or an existing corporation is added.

There are two ways that corporations can be added to Corporate Compliance:

 Manually enter all corporation details (see “Adding a corporation” on page 21).

 Import the corporation’s details from a file received from ASIC or other sources. 
(see “Creating corporations using an imported data file” on page 22).

Related topics
Using Corporate Compliance
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Corporations
Changing corporation details
Holding companies
Deleting corporations
Reserving corporation names
Corporate keys
Adding corporations
Changing corporation details
Deleting corporations
Searching for corporations or people
Requesting company data from ASIC
Changing ultimate holding company details
Updating details with data received from ASIC
Appointing and ceasing agents
Previewing forms and documents

Viewing corporation details

To view corporation details

1. Click Corporations on the Task Bar.
The Corporations selection list opens.

2. If necessary, find the corporation by searching or sorting.

3. Select the corporation and press [Enter] or double-click the corporation.
The Details screen displays, with more tabs available.

Related topics
Corporate keys
Adding corporations
Changing corporation details
Deleting corporations
Searching for corporations or people
Requesting company data from ASIC
Changing ultimate holding company details
Updating details with data received from ASIC
Appointing and ceasing agents
Previewing forms and documents
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Selecting a corporation

To view a corporation in Corporate Compliance

1. Click Corporations on the Task Bar.
The Corporations selection list opens.

2. If necessary, find the corporation by searching or sorting 

3. Select the corporation and click OK. 
The corporation opens at the Details tab.

Related topics
Corporate keys
Adding corporations
Changing corporation details
Deleting corporations
Searching for corporations or people
Requesting company data from ASIC
Changing ultimate holding company details
Updating details with data received from ASIC
Appointing and ceasing agents
Previewing forms and documents

Adding a corporation

To add corporations from MYOB AE/AO

1. Add the Corporation to MYOB AE/AO (name, addresses, ACN, ABN, contact 
numbers), if you have not already done so.

2. In Corporate Compliance, click Corporations on the Task Bar.
The Corporations selection list opens.

3. Select  Include all Corporations from MYOB AE / Include all Corporations 
from MYOB AO.
The complete list of corporations from MYOB AE/AO displays.

4. Double-click the corporation in the selection list.
The corporation is added to Corporate Compliance, and it opens at the Details 
tab. 
The corporation’s MYOB AE/AO data has been added to Corporate Compliance.
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Related topics
Corporate keys
Adding corporations
Changing corporation details
Deleting corporations
Searching for corporations or people
Requesting company data from ASIC
Changing ultimate holding company details
Updating details with data received from ASIC
Appointing and ceasing agents
Previewing forms and documents

Creating corporations using an imported data file

Use this procedure to add previously registered corporations to Corporate 
Compliance, for example if a corporation moves from another practice to your 
practice.

To add an existing corporation

1. Add the corporation to Corporate Compliance using the Include from AE / 
Include from AO option in the Add Corporation wizard (see “Adding 
corporations” on page 19). You only need to enter the company name, agent, 
entity type and ACN.

2. Use the Appoint or Cease Registered Agent wizard (see “Appointing and 
ceasing agents” on page 32) to create the ASIC Form 362 for this company. As 
there are no officers entered for this company, step 2 of this wizard allows you 
to enter the name of the signing officer.

3. Lodge Form 362 with ASIC.

4. When Form 362 has been accepted by ASIC, use the Request data from ASIC 
wizard to create Form RA71.

5. Lodge Form RA71 with ASIC.

6. When Form RA71 has been accepted, ASIC will send you the company’s data as 
Form RA72.

7. When Form RA72 has been received, use the Update from ASIC data received 
wizard (see “Updating details with data received from ASIC” on page 28) to 
import the details of the company into your Corporate Compliance database.
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Related topics
Using Corporate Compliance
Corporations
Adding corporations
Appointing and ceasing agents
Requesting company data from ASIC
Changing corporation names
Changing corporation details
Holding companies
Changing registered office details
Share issue details
Officers
Adding auditors
Deleting corporations
ASIC Forms
Forms lodgement

Changing corporation details

From the Corporation Details tab you can change information relating to a company’s 
registration, such as its corporate key, ASIC agent, company type and class, parent 
and trustee companies and date of incorporation.

Changes to the names, addresses, the ACN and ABN need to be entered in MYOB AE/
AO. The changes then flow through to Corporate Compliance. 

To change corporation details

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab.
Select Change details from the Task Bar to change any of the following fields:

 Corporation Name

 Corporate Key

 The Practice is the registered agent for this corporation.

 Type of company

 Class of company

 Annual review date

 Registration date

 State of registration
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 Country of registration

 Company status

 Deregistration date.

2. Click the Other details tab.
You can change the following fields:

 Forms signatory

 Chairperson for meetings

 Parent company

 Trustee company

 Financial year end date

 Current AGM date

 Quorum for meetings: Director and Member

 For public companies, select either The company has a constitution or The 
company will rely entirely on replaceable rules.

 Partner

 Notes.

3. Click OK. 
The data on the Details tab is updated.

Note: If you change the Class of company field to or from Limited by 
Guarantee, the following message will display: 
 
“Changing the company class to or from ‘Limited by Guarantee’ will 
affect the related Capital and Members data. Continue saving?” 
 
If you are changing the company class to Limited by Guarantee, the 
Capital screen will be removed because a company of this class 
cannot issue shares. The structure of the Members screen will also 
change. 
 
If you are changing the company class from Limited by Guarantee, 
the Capital screen will be added so that the company can issue 
shares. The structure of the Members screen will also change.

Related topics
Using Corporate Compliance
Corporations
Adding corporations



Corporations

MYOB AO Corporate Compliance | Version 3.0 User Guide | 25

Holding companies
Deleting corporations
Changing corporation names
Changing corporation addresses
Notifying ASIC of corporate changes of address
Notifying ASIC of address changes to more than one contact

Deleting corporations

You can delete a Corporation from the Corporations selection list.

To delete a corporation

1. Click Corporations on the Task Bar.

2. Right-click the corporation you want to delete, and select Delete corporation 
from the menu.
One of the following messages displays:

 Are you sure you want to delete corporation (name and code) from the 
database?

This means that the selected company is not linked to another company, 
and does not have any currently appointed officers or members so it can be 
deleted. To delete the corporation, click Yes.

 Cannot delete contact (Corporation name and code) This contact is the 
ultimate holding company/parent company/trustee company/member 
company, the auditor for one or more companies.

This means that the selected company is linked to another company, so it 
cannot be deleted. Click OK and the corporation will be retained.

Or

 (Corporation name and code) has current officer and member details. Are 
you sure you want to delete this corporation and all associated details from 
the database?

This message means that the company has a currently appointed officers 
and/or members. Click Yes to delete the corporation and its associations 
with other contacts, and all ASIC forms sent and received. The people that 
are officers, and the people or other companies that are members will not 
be deleted.

Related topics
Using Corporate Compliance
Corporations
Adding corporations
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Changing corporation details
Holding companies
Transferring and transmitting shares

Searching for corporations or people

The Search screen is used in several wizards to find people or corporations (i.e., 
contacts). You can also search for and find a wide range of names, companies, 
documents using the Search function in any Selection list.

To search for corporations or people

1. Click  to open the appropriate Find screen.

2. Enter your search terms (e.g., name or first few characters) in the search field 
above the list.

3. Optionally, click  to display the Search options. These options are specific to 
the each type of search (e.g., Find a Corporation, Search for Person).
Select the options you want to include in your search.
To include contacts from MYOB AE/AO, select  Include all Corporations/
People from AE or Include all Corporations/People from AO respectively.

4. Click Search. The matching results display in the selection list.
If you cannot find the contact, add it to MYOB AE/AO, then add it to Corporate 
Compliance (see “Adding corporations” on page 19).

Related topics
Using Corporate Compliance
Corporations
Adding corporations
Deleting corporations
People
Adding people
Deleting people

Requesting company data from ASIC

The Request data from ASIC wizard is used to request a corporation’s data from ASIC.

You can request the current company data in company statement format. This PDF 
shows your current company details in the same format as the Company Statement. 



Corporations

MYOB AO Corporate Compliance | Version 3.0 User Guide | 27

The report is received as an RC05, and is listed in Lodgement > ASIC Forms received 
and on the ASIC Forms tab of the corporation.

You can also re-request the last Annual Company Statement issued by ASIC. Only 
statements issued electronically by ASIC in the last 60 days can be re-requested. This 
is received as ASIC form 480 and is displayed in the Company Statements list.

Corporations data includes:

 Corporation registration details

 Registered address

 Business address

 Ultimate holding company

 Officers

 Share capital

 Shareholders.

To obtain data from ASIC

1. Select and open the corporation.
See “Selecting a corporation” on page 21.

2. Click Request data from ASIC on the Task Bar.
The Request data from ASIC wizard opens.

3. Select the required format for the data to be received:
Request for data download. Select this option to perform the Update from ASIC 
data received.
Request current company details in Company Statement format.
Request to re-issue last Annual Company Statement. Only annual company 
statements issued by ASIC in the last 60 days can be re-requested.

4. Enter the signing date or use the drop-down calendar.

5. Click Next.
The Finish screen opens.

6. Click Finish.
The request form (RA71) displays on the Print preview screen (see “Previewing 
forms and documents” on page 40).

7. Lodge the request form (see “Forms lodgement” on page 182).

8. Receive the data from ASIC (see “Receiving forms from ASIC” on page 185).

9. To view your requested data:
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a. Select Lodgement from the Task Bar, then click the ASIC Forms Received 
tab.

b. Select Form RA72 in the list and click View form on the Task Bar.

c. Select Reports > Corporations > ASIC data received, select the Corporation 
and click OK.

d. Open the Corporation and click the ASIC Forms tab. Select the received 
Form RA72 and click View form on the Task Bar.

You can also download Agent reports from ASIC (see “Requesting agent reports 
from ASIC” on page 201).

Related topics
Using Corporate Compliance
Corporations
Adding corporations
Company statements
ASIC forms received

Updating details with data received from ASIC

ASIC form RA71 is a request to ASIC for the current details of a corporation. Corporate 
Compliance allows you to update the corporation with the details contained in this 
file.

When the requested form is received back from ASIC (form RA72), select 
Corporations > Update from ASIC data received.

This wizard allows you to update the corporation with details of:

 General details such as company type and incorporation details

 Registered address

 Business address

 Ultimate holding company

 Officers

 Issued shares

 Shareholders.

The Update from ASIC data received wizard can only be used where the corporation 
does not already have any officer or member details. This is because the ASIC data 
would duplicate records if the corporation has existing officer or shareholder records.
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Note: You must be the registered agent of the company to request its data details. 
If you have not already done so, you must lodge a form 362 for the company 
before you can lodge the RA72. 

Appointing or ceasing registered agents

You can enter the officer’s name manually at the Signing detail step of this wizard, if 
no other officer is entered for this company. This must be entered exactly as notified 
to ASIC.

To update data for new companies in your database

1. If the agent does not already exist in Corporate Compliance(or in MYOB AE/AO), 
add their name plus ACN or ABNin MYOB AE/AO.

2. Add the company to Corporate Compliance (see “Adding corporations” on 
page 19).

3. Use Appoint or cease registered agent to create a form 362 for this company.

4. Lodge the form 362.

5. When the form 362 has been accepted, use Request data from ASIC to create a 
form RA71 for the company.

6. Lodge the form RA71.

7. When form RA71 has been accepted, ASIC will provide an RA72. 

8. Check that the RA72 has been received on the company’s ASIC Forms tab. 

Each form RA71 sent will have a corresponding RA72 form with the same 
document trace number.

9. Print these details by selecting the form RA72, and clicking View Form on the 
Task Bar. 

10. View the form from Reports > Corporations > ASIC data received.

11. Select to Update from ASIC data received.

Corporations > Update from ASIC data received 

Shows the name of the selected company, and the date when the data request file 
was last received.
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Corporation details

Displays the general details such as company type, incorporation details and annual 
review date.

Registered address details

Displays the registered address as received in the ASIC data file, and the registered 
address as currently held in your database.

To update the address in your database with the address received from ASIC, select 
 Update the registered address with the ASIC details. When this is selected, any 

address links to other contacts are lost, and a new, unlinked address is created.

Business address details

Displays the business address as received in the ASIC data file, and the business 
address as currently held in your database.

To update the address in your database with the address received from ASIC, select 
 Update the business address with the ASIC details. When this is selected, any 

address links to other contacts are lost, and a new, unlinked address is created.

Ultimate holding company

This step is not displayed if the selected corporation has no ultimate holding 
company.

Displays the ultimate holding company as received in the ASIC data file. Enter the date 
when this company started as an ultimate holding company.

If the system finds a corporation with the same ACN, the matched company is 
displayed. It cannot be changed.

If the system does not match the ultimate holding company to an existing company 
in your Corporate Compliance database, you can either:

 Create a new contact for the holding company.

or

 Click Select Contact to link the holding company to an existing contact

Officer details

Displays the officer details as received in the ASIC data file. Details received are the 
officer’s name, home address, birth details and positions held.

When there is an exact match in your Corporate Compliance database to this officer, 
based on the surname and given name as received, the system displays the matched 
contact code in one column, and the contact’s name and address and birth details as 
currently held in the database in another column.

If you want to link the officer to the selected contact, leave as displayed.
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If the system has matched with an incorrect person of the same name, click Clear 
Contact to unlink the details. You can either click Select Contact to link to the correct 
existing contact, or leave the Contact code blank.

If the Contact code is left blank, a new contact record will be created for the displayed 
person.

Issued share details

Lists each class of shares currently issued by the company.

The details as received from ASIC consolidate all share issues and do not include a 
date of issue. For example, if 1000 ORD shares were issued in 2000, and a further 
1000 ORD shares issued in 2002, these will not display as two entries. There is one line 
displayed for these ORD shares, showing 2000 issued. If you want to enter the true 
history of the issued shares of the corporation, this must be done manually. The data 
as provided by ASIC is a summary of the current issues only.

Share members

Displays the member details as received in the ASIC data file. This list displays each 
member once, including joint holders. Details received are:

 For people: surname, given name and address.

 For corporations: name, address and ACN.

To link the member to an existing contact in your database, click Select Contact.

If the Contact code is left blank, a new contact record will be created for the displayed 
person or company.

Share holdings

Displays the shares currently held in the corporation.

The details as received from ASIC consolidate all like shares held by each member and 
do not include a date acquired. The date acquired will be set to be the date of issue 
as entered for that share class at the Issued share details step. You are required to 
enter a certificate number to uniquely identify each share holding.

For example, if a member acquired 1000 ORD shares in 2009, and a further 1000 ORD 
shares in 2011, these will not display as two entries. There is one line displayed for 
these ORD shares, showing 2000 held. If you want to enter the true history of the 
shares held in the corporation, this must be done manually. The data as provided by 
ASIC is a summary of the current holdings only.

Related topics
ASIC forms received
Requesting company data from ASIC
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Appointing and ceasing agents

You can view a corporation’s appointed ASIC Agent from the Corporation Details 
screen (see “Viewing corporation details” on page 20).

An agent must be appointed to act for a corporation to be able to lodge ASIC forms 
on its behalf. 

A corporation ceases the appointment of their agent using the Appoint or cease 
registered agent wizard. When a new agent is appointed, the previous agent is 
dismissed automatically — there is no need to cease the current agent’s appointment 
first.

An agent can cease their own appointment as a corporation’s agent using the wizard 
in the Agents module (see “Ceasing acting as a registered agent” on page 205).

To appoint a corporation’s agent

1. Select and open the corporation.
See “Selecting a corporation” on page 21.

2. Click Appoint or cease registered agent on the Task Bar.
The Appoint or cease registered agent wizard opens, showing existing details 
(including any existing agent) for the company.

3. Click  Appoint new registered agent, then:

 If there is no existing agent:

Select an agent from the Select agent drop-down list.

 If there is already an agent: 

Select the new agent from the Select agent drop-down list. The “old” agent 
is replaced by the new one (and does not need to resign — this occurs 
automatically).

4. Click Next to open the Select documents screen.
The ASIC form is already selected.

5. Enter the Date signed (dd/mm/yyyy) or select it from the drop-down calendar.

6. Select the Signing officer from the drop-down list.

7. Click Next.

8. Select the form you want to preview and click Finish.
If you selected to preview documents (above), they display on the Print preview 
screen. Any errors will be listed.
If you did not select to preview documents, the ASIC form validation screen 
opens.
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9. Complete and lodge the form with ASIC.
See “ASIC forms in progress” on page 174 and “Forms lodgement” on page 182.
Allow 1–2 business days for ASIC to process the appointment.

To cease a corporation’s agent

1. Select and open the corporation.
See “Selecting a corporation” on page 21.

2. Click Appoint or cease registered agent on the Task Bar.
The Appoint or cease registered agent wizard opens, showing existing details 
(including the existing agent) for the company.

3. Select  Cease the registered agent.

4. Click Next to open the Select documents screen.
The ASIC form is already selected.

5. Enter the Date signed (dd/mm/yyyy) or select it from the drop-down calendar.

6. Select the Signing officer from the drop-down list.

7. Click Next.

8. Select the form you want to preview and click Finish.
If you selected to preview documents (above), they display on the Print preview 
screen. Any errors will be listed.
If you did not select to preview documents, the ASIC form validation screen 
opens.

9. Complete and lodge the form with ASIC.
See “ASIC forms in progress” on page 174 and “Forms lodgement” on page 182.

Related topics
Corporations
Agents
Adding Agents
Ceasing acting as a registered agent

Applying for registration

For a company to be registered, it must meet the following conditions.

 The company must have a state of registration.

 The company must have a current business address.
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 The company must have a current registered address.

 The company must have at least one director.

 If the company is limited by guarantee, it must have at least one member.

 If the company is not limited by guarantee, it must have at least one share 
issued.

 For each share issue — the number of shares issued must match the total 
number of shares held by the associated members.

Note: A foreign company and a registered Australian body cannot be 
registered.

To generate an application for registration of an Australian company

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab.

2. Click Application for registration on the Task Bar.
The Application for registration wizard appears.
If the selected company has already been registered, the following Application 
for registration message opens:

Company status is set to registered. Do you want to produce the form 201?

To cancel, click No. To proceed, click Yes. The Company details screen appears.

Note: A company that is not yet registered with ASIC will not have an ACN. 
For example, in Corporate Compliance you cannot appoint officers 
to a company which does not have an ACN. Since Form 201 requires 
officers to be appointed, set the status of the company to 
Unregistered. An unregistered status will bypass the validation 
request for an ACN when appointing officers to the company. The 
status of the company can be set in the corporation’s Details.

3. In the Company Details screen, the following information is shown:

 Company name

 State of registration

 Type of company

 Class of company.
Enter the Name reservation number (optional, with a maximum of 9 
characters). (If you have previously lodged an ASIC Form 410 to reserve the 
proposed company name, you will have a Name reservation number.)
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4. Click Next.
The Business names screen opens.

5. Click Yes or No to:
Is the proposed name identical to a registered business name(s)?
The default selection is No. If you click Yes, you must provide the business name 
registration details in the table. The table provides a list of all Australian states 
and territories.
Enter the Business Number beside the state to which the number applies. 

6. Click Next and go to Step 7., if the selected company is not a public company.
If the selected company is a public company, the Public company governance 
screen appears.

7. If the company is limited by guarantee, The amount of the member’s guarantee 
is field is enabled.
Enter the amount and click Next.
or
If the field is disabled, click Next.
The Applicant details screen appears.

8. Enter the Date signed (dd/mm/yyyy) or select the date from the drop-down 
calendar. The default date is the current system date. This is optional.

9. Select the applicant.

 Individual — by default, the individual is selected. Click  to search for a 
person.

 Corporation — click  to search for a corporation. When you select this 
option, the Signed by fields are displayed. Enter the Given names and 
Surname under Signed by or select from the drop-down list.

10. Click Finish now to generate the Form 201, or click Next to check and view the 
details entered for the company.
If you click Finish, Form 201 displays on the Print Preview screen.
If you click Next, the Addresses of the selected applicant displays. The current 
Business address and Registered office address is shown.

11. Click Finish now to generate the Form 201, or click Next to check and view the 
details entered for the company.
If you click Next, the Registered office details of the selected address displays. 
The registered office occupier and the registered office hours is shown.

12. Click Finish now to generate the Form 201, or click Next.
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If you click Next, the Ultimate holding company details displays. This displays 
only if the selected company has a current holding company.
If the ultimate holding company is an Australian company, its state of 
incorporation is shown.
If the ultimate holding company is a foreign company, its country of 
incorporation is shown.

13. Click Finish now to generate the Form 201, or click Next.
If you click Next, the Officer details of the selected applicant displays. A current 
office holding is a position without a date of ceasing.
The following information is shown for each officeholder.

 Officer: Surname, given name (code).

 Birth details: Date of birth and state or country of birth.

 Address: The current residential address.

 Position: Indicates whether the person is a current Director and/or 
Secretary.

Note: New registrations can only appoint an officer as Director or 
Company Secretary (i.e., not as Alternate Director). Alternate 
Directors are not included on this list and are not included on 
Form 201. Only officers with a current position of Director and/or 
Secretary are listed. This list of officers cannot be changed here.

14. Click Finish now to generate the Form 201, or click Next.
If you click Next, the current Issued share details of the selected applicant 
displays. This will not display for a company limited by guarantee.

By default, the issued capital is sorted by Share Class order. The issued capital is 
not consolidated by class. All issues for each class are listed separately.

15. To view details of the share issue, select a share issue row and click View issue 
details.
The View Share Issue screen opens.

16. To return to the Issued share details, click Close.

17. Click Finish now to generate the Form 201, or click Next.
If you click Next, the Member details displays. This is displayed only if the 
selected company is limited by guarantee.
If the selected company has shares issued, a list of current primary and joint 
shareholders is shown.
The following information is shown for each shareholder/member in descending 
name order:
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 Name: Member’s surname, given names if the member is a person. 
Corporation Name and ACN if the member is a company.

 Code: Client code.

 Address: If the member is a company, the current business address is 
shown. If the member is a person, the current residential address is shown.

18. Click Finish now to generate the Form 201, or click Next.
If you click Next, the Finish screen opens.

19. Select the documents you want to preview.

20. Click Finish. 
If you selected to preview documents on the previous screen, they open in the 
Print Preview screen.
If you did not select to preview documents, the ASIC Form Validation screen 
opens.

21. Complete and lodge the forms with ASIC.

Related topics
Applying for deregistration

Applying for deregistration

The following procedure is used to produce Form 6010 — Application for voluntary 
deregistration of an Australian company for electronic lodgement with ASIC.

To generate an application for deregistration of an Australian company

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab.
If the selected corporation is managed by the practice, the following basic 
company details are required for the deregistration notification of a company:

 ACN

 Company type and company class

 Date of deregistration

 ASIC Agent.

2. Click Application for deregistration on the Task Bar.
The Application for deregistration wizard opens.
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3. Enter the Deregistration date (dd/mm/yyyy) or select the date from the drop-
down calendar.
By default,  Set this company to be not managed by your practice upon 
completion of this deregistration wizard is selected. You can deselect this 
option to leave the deregistered company as a managed company.

4. Click Next.
The Applicant details screen opens.

Applicant details

5. Select the applicant who will lodge the form.

 Company — By default, the company itself is selected. Select a nominee 
from the drop-down list under Select the officer nominated to receive the 
notice of deregistration.

 Director — Select a Director from the drop-down list.

 Member — Select a Member from the drop-down list.

 Liquidator — When you select this option, the Signed by fields are 
displayed.

6. Click Next.
The Select documents screen opens.

Note: If you select the applicant as a member or liquidator, then ASIC 
Form 6010 must be lodged as a paper form, not electronically.

Select documents

7. By default, both documents are selected. 
You can retain the selections or deselect one of the options as required.

8. Enter the Date signed (dd/mm/yyyy) or select the date from the drop-down 
calendar. 
The default date is the deregistration date but you may change this date.

Note: The signing date must be on or after the deregistration date.

9. Select the Payment method.
Two options are available:

 Invoice issued for payment, or

 Payment from agent’s Direct Debit account.
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Note: In order to use the Payment from agent’s Direct Debit account 
option, the agent must be authorised with ASIC for direct debit.

10. Click Next.
The Minutes of directors’ meeting screen opens.

Minutes of directors’ meeting

11. Enter the Date of meeting (dd/mm/yyyy) or select the date from the drop-down 
calendar. 
The default date is the deregistration date but you may change this date.

12. Either enter the Time of meeting or use the up and down arrows.

13. Either enter the Meeting closed time, or use the up and down arrows.

14. Select the address Held at. 
By default, the Business address is selected. You can change it to Registered 
address, if required.

15. Select the Chairperson from the drop-down list.

16. Select the Officers present. 
By default, all officers are selected. You can retain the selections or deselect one 
or more absentees as required.

17. Click Next.
The Finish screen opens.

Finish

18. Select the documents you want to preview. 
By default, both documents are selected. You can retain the selections or 
deselect one of the options as required.

19. Click Finish.
The Forms Completion Report displays on the Print Preview screen.

20. Select to view each document under the Preview Items list.

21. Click Close to exit the report and return to the main window.

Related topics
Applying for registration
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Documents

The Documents tab in the Corporations module displays all associated documents 
(for example, minutes of meetings, letters, applications for shares) that have been 
produced in the course of generating an ASIC form using a workflow wizard (see 
“Workflow wizards” on page 168).

For example, if the Appoint or cease officers wizard has been used to appoint an 
officer to a corporation, the following documents will display on the Documents 
screen:

 Minutes of the directors’ meeting

 Officer’s consent to act form.

ASIC forms that are generated by completing a wizard display on the corporation’s 
ASIC Forms screen (see “Working with ASIC forms” on page 170).

You can also export documents to a file when you select to view them.

To view a corporation’s documents

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Documents tab. 
The Documents screen opens.

3. From here you can:

 View and export documents to file.

 Edit documents (see “Editing documents” on page 42).

 Delete documents (see “Deleting documents” on page 44).

4. To return to the Corporations selection list, click Close.

Related topics
Corporations
Workflow wizards
Previewing forms and documents

Previewing forms and documents

The Print preview screen displays the selected form, document or report as it would 
print (see “Working with ASIC forms” on page 170, “Tools” on page 221 or “Reports” 
on page 207). It also allows you to export documents to a range of file formats.



Corporations

MYOB AO Corporate Compliance | Version 3.0 User Guide | 41

This screen opens when you:

 Select to preview forms and documents you have generated at the end of a 
workflow wizard.

 Select View form or View document from the Task Bar (e.g., in the ASIC Forms 
and Lodgement modules).

 Select a report from the Reports menu.

 Select File > Print preview from the main menu.

Previewing multiple documents

The Print preview screen usually contains multiple documents that you can view by 
selecting each document in the Preview items list on the Task Bar.

Using the Print preview icons

You can also access the following functions by clicking the icons at the top.

Tip: Hover your cursor over an icon to see its name.

 Arrows to scroll from the first page to the last page of the document.

 Go to a specific page.

 Print the displayed document.

 Refresh the data in the displayed document.

 Export the displayed document to file, for example, Microsoft Word, PDF or RTF.

 Zoom in or out.

Publish documents to MYOB Portal

Use the Share It button on any print preview windows to easily transfer forms, 
reports and documents directly to your portal.

Related topics
Previewing forms and documents
Viewing corporation documents
Editing documents
Deleting documents
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Viewing corporation documents

To find, open and review company documents

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Documents tab.
The Documents screen opens. 

3. Select the document and click View document on the Task Bar.
The document displays on the Print preview screen (see “Previewing forms and 
documents” on page 40).

4. Click the appropriate icon (see “Using the Print preview icons” on page 41) to:

 Print the document, or 

 Export the document to a file.

Related topics
Using Corporate Compliance
Workflow wizards
ASIC Forms
Tools
ASIC Forms
Lodgement
Reports

Editing documents

Use the company’s Documents tab to edit, style, and format documents used for the 
company.

To edit company documents

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Documents tab.
The Documents screen opens. 

3. Select the document and click Edit document on the Task Bar.
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The Document Editor screen opens.

4. Change the required text, formatting and margins using the toolbar and menus.
File menu:

 Save

 Print

 Page Setup (allows you to set margin options)

 Revert to Master (is only enabled when editing a document template that 
has a custom template, use this option if you want the template to be 
reverted to the MYOB Master.)

 Close.
Edit menu: 

 Undo

 Redo

 Cut

 Copy

 Paste.
Format menu: 

 Font (lists available fonts, styles and size)

 Paragraph

 Bullets and Numbering.
Table menu:

 Insert

 Delete

 Select

 Properties.

5. Select File > Save to save the document.

Related topics
Previewing forms and documents
Viewing corporation documents
Editing documents
Deleting documents
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Deleting documents

To delete a document

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Documents tab.
The Documents screen lists the available documents. 

3. Select the document.

4. Click Delete document on the Task Bar.

Related topics
Using Corporate Compliance
Workflow wizards
ASIC Forms
Tools
ASIC Forms
Lodgement
Reports

Corporation names

From the Corporations module, corporation names can be:

 Reserved (see “Reserving corporation names” on page 45)

 Changed (see “Changing corporation names” on page 49).

Names previously held by corporations (name histories) can also be:

 Viewed (see “Corporation name histories” on page 47)

 Changed (see “Changing former corporation names” on page 48).

Related topics
Reserving corporation names
Changing corporation names
Corporation name histories
Changing former corporation names
Deleting former corporation names from the name history
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Reserving corporation names

Use the Reservation of corporation name wizard if the corporation would like to 
reserve a specific name with ASIC in preparation for a future name change. This 
wizard can only be used for corporations which are already registered.

The Reservation of corporation name wizard generates an ASIC form 410, which you 
can then lodge from the Lodgement module (see “Lodgement” on page 182).

To reserve a corporation name

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Reserve name on the Task Bar.
The Reservation of corporation name wizard opens.

3. Enter the proposed new name including the legal elements.
The new name is limited to a maximum of 200 alphanumeric characters.

4. Select the type of change.
That is, change of name, extension of reservation or new registration.

Note: If you are reserving a name for a new company (New registration 
option), Form 410 must be lodged by paper.

5. Selecting the Request application to be manually reviewed checkbox enables 
you to enter the reason for a manual review.

6. Click Next.

Identical business name 

7. Select whether the proposed name is identical to a registered business name.

a. If you select The business name was registered on or after 28 May 2012 
checkbox, enter the ABN of the registered business name.

b. If you select The business name was registered before 28 May 2012 
without an ABN checkbox, enter the associated business number for one or 
more states in the table.

8. Click Next.
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Select documents

9. To generate an application for reservation of name form, select  ASIC Form 
410.

10. Select the Signing officer from the drop-down list.

11. Enter the Date signed.

12. Select the Payment method.
Two options are available:

 Invoice issued for payment, or

 Payment from agent’s Direct Debit account.

Note: In order to use the Payment from agent’s Direct Debit account 
option, the agent must be authorised with ASIC for direct debit.

13. Click Next.

Finish

14. To preview the application for reservation of name, select  Form 410.

15. Click Finish.
If you selected to preview documents on the previous screen, they display on 
the Print preview screen (see “Previewing forms and documents” on page 40).
If you did not select to preview documents, the ASIC Form Validation screen 
opens (see “ASIC forms validation” on page 176).

16. You can now lodge the form with ASIC (see “ASIC forms in progress” on 
page 174 and “Forms lodgement” on page 182).

Note: The confirmation letter for the name reservation is received as a 
PDF, which is listed as a form RC05. You can view it from both the 
Corporation > ASIC Forms tab and from the Lodgment > ASIC Forms 
Received tab.

Related topics
Corporations
Adding corporations
Corporation names
Changing corporation names
Corporation name histories
Changing former corporation names
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Corporation name histories

From the Name History screen in the Corporations module, you can view the 
selected company’s name history. The information on this screen includes Previous 
name and Date changed.

The history of names is updated each time a corporation’s name is changed using the 
Change of name wizard (see “Changing corporation names” on page 49). 

Corporation address histories are also maintained in Corporate Compliance (see 
“Corporation address histories” on page 60).

To view a corporation’s name history

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Change former name on the Task Bar, or right-click the Details tab and 
select Change former name from the menu.
The Change former name screen opens. From here you can:

 Add former names (see “Adding former corporation names” on page 47)

 Change former names (see “Changing former corporation names” on 
page 48)

 Delete former names (see “Deleting former corporation names from the 
name history” on page 52).

3. To return to the Corporations selection list, click Close.

Related topics
Corporations
Corporation names
Changing corporation names
Reserving corporation names
Adding former corporation names
Changing former corporation names
Deleting former corporation names from the name history

Adding former corporation names

From the Details tab in the Corporations module, you can add former names to the 
selected company’s name history from the Name History tab. The information on the 
Name History tab includes Former name and Date of change.

You can also add to the Name history for people (see “Name history” on page 137).
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To change a corporation’s name history

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Add former name on the Task Bar.
The Add former name screen opens.

3. You can enter a former name and the Date of Change.

4. Click OK.
The former name is added to the Name History screen.

Related topics
Corporations
Corporation names
Changing corporation names
Reserving corporation names
Corporation name histories
Adding former corporation names
Changing former corporation names

Changing former corporation names

From the Details tab in the Corporations module, you can change former names in 
the selected company’s name history from the Name History tab. The data in the 
Name History tab includes Former name and Date of change.

You can also change the name history for people (see “Name history” on page 137).

To change a corporation’s name history

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Change former name on the Task Bar or right-click the Details tab and 
select Change former name from the menu.
The Change former name screen opens.

3. You can change the Former name and the Date of change.

4. Click OK.
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The former name is updated on the Name history screen.

Related topics
Corporations
Corporation names
Changing corporation names
Reserving corporation names
Adding former corporation names
Corporation name histories
Deleting former corporation names from the name history

Changing corporation names

Use the Change of corporation name wizard if:

 The corporation has previously reserved its new name and has now resolved to 
change its name. See “Reserving corporation names” on page 45.

or

 The corporation has changed its name and needs to notify ASIC of the change.

A company that resolves to change its name, and then uses the Change of 
corporation name wizard, may first reserve the corporation’s new name (see 
“Reserving corporation names” on page 45).

When a corporation resolves to change its name, you do not need to enter the change 
in MYOB AE/AO first. 

You can make the change in Corporate Compliance only, using the Change of 
corporation name wizard. When the wizard completes, the corporation’s name will 
be updated in the Corporation selection list in Corporate Compliance.

When a corporation’s name is changed using the Change of name wizard, the 
corporation’s former name is recorded on the Name History screen (see 
“Corporation name histories” on page 47).

To change a corporation name

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Change name on the Task Bar.
The Change of corporation name wizard opens.

3. Select whether you want to use the ACN as the new company name.
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a. By default No is selected, so that you can enter the proposed new name 
including the legal elements.

b. Select Yes to use the ACN as the new company name. Enter just the legal 
elements to be used with the ACN as the name.

The proposed new name should have the correct legal elements for the 
company type and class.

The new name is limited to a maximum of 200 alphanumeric characters.

4. Select the Date of change (dd/mm/yyyy).

5. Select whether a name reservation has been lodged.
If you select Yes, enter the name reservation number. 
See “Reserving corporation names” on page 45 for more information.

6. Selecting the Request application to be manually reviewed checkbox enables 
you to enter the reason for a manual review.

7. Click Next.

Registration details

8. Select whether the proposed name is identical to a registered business name.

a. If you select The business name was registered on or after 28 May 2012 
checkbox, enter the ABN of the registered business name.

b. If you select The business name was registered before 28 May 2012 
without an ABN checkbox, enter the associated business number for one or 
more states in the table.

9. Click Next.

Select documents

10. Select the documents to be generated from the following:

  ASIC Form 205 — Notification of resolution.

  ASIC Form 484 — Change of name for member and/or ultimate holding 
company.

  Minutes of the meeting of directors proposing the name change.

  Minutes of the meeting of members approving the name change.

11. Select the Signing officer from the drop-down list.

12. The Date signed is set as the Date of change entered in the first stage.
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13. Select the Payment method.
Two options are available:

 Invoice issued for payment, or

 Payment from agent’s Direct Debit account.

Note: In order to use the Payment from agent’s Direct Debit account 
option, the agent must be authorised with ASIC for direct debit.

14. Click Next.
The Change of name of ultimate holding company screen opens, with a list of 
all subsidiary companies affected by the change.

15. Click Edit details to select the name of the Signing officer. 

16. Click OK to close the Edit signing officer screen.

17. Click Next.

Minutes of directors meeting

18. If you selected to produce the minutes of the directors’ meeting at Step 10., 
enter the meeting details. Click Next.

Note: The date of the directors’ meeting cannot not be after the Date of 
change.

Minutes of members meeting

19. If you selected to produce the minutes of the members’ meeting at Step 10., 
enter the meeting details. Click Next.

Finish

20. Select each of the following documents you would like to preview:

 ASIC Form 205 — Notification of resolution.

 ASIC Form 484 — Change of name for member and/or ultimate holding 
company.

 Minutes of the meeting of directors proposing the name change.

 Minutes of the meeting of members approving the name change.

21. Click Finish.
If you selected to preview the ASIC forms and minutes, a preview of the 
document will display on the Print preview screen (see “Previewing forms and 
documents” on page 40).
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22. You can now lodge the form (see “Lodgement” on page 182).

Note: The certificate for new name is received as a PDF which is listed as 
a form RC05. This can be viewed from both the Corporation > ASIC 
Forms tab and from the Lodgment > ASIC Forms Received tab.

Related topics
Corporations
Corporation names
Reserving corporation names
Corporation name histories
Changing former corporation names

Deleting former corporation names from the name history

From the Details tab in the Corporations module, you can delete former names from 
the selected company’s name history using the Name History tab. The data in this tab 
includes Former name and Date of change.

You can also add to the name history for people (see “Name history” on page 137).

To delete a corporation’s name history

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Delete former name on the Task Bar, or right-click the Details tab and 
select Delete former name from the menu.
A Confirm delete message screen opens.

3. Click OK.
The former name is deleted from the Name History screen.

Related topics
Corporations
Corporation names
Changing corporation names
Reserving corporation names
Adding former corporation names
Corporation name histories
Changing former corporation names
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Corporation addresses

From the Addresses tab in the Corporations module, you can view the following 
details for a corporation:

 Business address

 Postal address

 Postal address file setting

 Registered office

 Registered office details.

Addresses that are entered in MYOB AE/AO are copied into Corporate Compliance.

To view corporation addresses

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Addresses tab.
The Addresses screen opens. From here you can change:

 Address details (see “Changing corporation addresses” on page 54).

 Registered office details (see “Changing registered office details” on 
page 59).

 Postal address file settings.
You can only change other address details from MYOB AE/AO, then notify ASIC 
of the change (see “Changing corporation addresses” on page 54). 

3. To return to the Corporations selection list, click Close.

Related topics
Corporations
Changing corporation addresses
Changing registered office details
Notifying ASIC of corporate changes of address
Notifying ASIC of address changes to more than one contact
Corporation address histories
Deleting former corporation addresses
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Changing corporation addresses

Changing a company’s address is a two-stage process:

1. Change the address details:

 For all address details, except registered office details: Change the details in 
MYOB AE/AO.

 For registered office details only: Change the registered office details in 
Corporate Compliance (see “Changing registered office details” on 
page 59).

2. Notify ASIC of the change in Corporate Compliance. See “Notifying ASIC of 
corporate changes of address” on page 54.
After generating a form using the Notify change of address wizard, the former 
address is added to the Address History tab (see “Corporation address 
histories” on page 60).
If you do not need to notify ASIC of the change made in MYOB AE/AO, delete the 
task in the Changes from AE/Changes from AO module (see “Changes from AE/
AO” on page 12).

Related topics
Corporations
Corporation addresses
Changing company postal address file (PAF) settings
Changing registered office details
Notifying ASIC of corporate changes of address
Notifying ASIC of address changes to more than one contact
Corporation address histories
Deleting former corporation addresses

Notifying ASIC of corporate changes of address

After changing a corporation’s address, notify ASIC of the change to the business 
address and/or change of registered hours using the Notify Change of Address 
wizard. You can access this wizard from the Corporations module (see “Corporations” 
on page 17).

To notify of changes of address

1. To change a corporation’s business address or registered address, enter the 
change in MYOB AE/AO.
To change a corporation’s registered office hours (for foreign corporations and 
Australian registered bodies only), enter the change at Step 6 of the Notify 
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change of address wizard, or from the Change Registered Address screen (see 
“Changing registered office details” on page 59).

2. Open Corporate Compliance.

3. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

4. Click Notify change of address on the Task Bar.
Or 
Select the changed address record in the Changes from AE/Changes from AO 
module (see “Changes from AE/AO” on page 12), then click Generate task on 
the Task Bar.

5. The Change of corporation address wizard opens.

6. Select the type of change by selecting from the following:

  Notify change of business address 

  Notify change of registered address 

  Notify change of registered office hours.

7. Click Next.

8. Select from the following options based on the options you chose at Step 6.

 Notify change of business address:

The Change of business address screen opens.

Enter the date (dd/mm/yyyy) or select it from the drop-down calendar.

Indicate whether the Address meets Post Address File rules.

 Notify change of registered address:

The Change of registered address screen opens.

Enter the date (dd/mm/yyyy) or select it from the drop-down calendar.

Indicate whether the Address meets Post Address File rules.

Click Yes or No to indicate whether the company occupies the registered 
address.

Enter the Occupier’s name.

 Notify change of registered office hours:

The Change of registered office hours screen opens.

Enter the date of change (dd/mm/yyyy) or select it from the drop-down 
calendar.

Select an option to indicate the opening hours of the registered office.
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If the addresses displayed in the wizard are incorrect, click Cancel and change 
the address in MYOB AE/AO. Delete the former change address task in the 
Changes from AE/Changes from AO module (see “Changes from AE/AO” on 
page 12). Then restart the Notify change of address wizard. 

9. Click Next.

10. Enter the Date of Change or select it from the drop-down calendar.

11. If you know the address does NOT meet the PAF rules, select Address does not 
meet Postal Address File rules. 
This will stop ASIC from checking this address.

12. Click Next.

13. If you are notifying ASIC of a change of registered address, select Yes or No to 
indicate whether the company occupies the registered address.
If you select No, enter the occupiers name.

14. Click Next.
The Select the documents you want to produce screen opens.

15. Select which of the following documents to generate:

 ASIC Forms 484, 489 and/or 490

 Minutes of the meeting of the directors resolving to change the registered 
address (see “Tools” on page 221).

16. Click Next.
The Confirm signing officer and date signed screen opens.

17. Click Change details.
The Change signing details screen opens.

18. Enter the details of the Signing Officer and Date Signed (if available).
If relevant, indicate if this form is being generated In response to a company 
statement (as required for Form 484C).

19. Click OK and then click Next.

20. If you have selected to print minutes, enter the meeting details.

21. Click Next.
The Finish screen opens.

22. Click Finish.
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23. If you selected to preview documents, they will display on the Print preview 
screen (see “Previewing forms and documents” on page 40).
If you did not select to preview documents, the ASIC Form Validation screen 
opens (see “ASIC forms validation” on page 176).

24. Complete the form (see “ASIC forms in progress” on page 174) and lodge the 
form with ASIC (see “Forms lodgement” on page 182).

Related topics
Corporations
Changing corporation addresses
Changing corporation addresses
Changing registered office details
Corporation address histories
Deleting former corporation addresses
Notifying ASIC of address changes to more than one contact

Notifying ASIC of address changes to more than one contact

The task Notify address changes of multiple contacts allows you to select all the 
officeholders or shareholders of a corporation who require notification to ASIC of an 
address change. One ASIC Form 484A is produced for that corporation that includes 
all the selected officeholders and shareholders.

This process generates ASIC Form 484A for the selected corporation only. This 
process would typically be used after receiving your company statement from the 
ASIC. If there are several officeholders or shareholders with out of date address 
details, you can update their address details, and then use this task to generate the 
one ASIC Form 484A with all these address changes listed.

ASIC Form 484A will not be generated for other corporations that the selected 
contacts are an officeholder or member of.

ASIC Form 484A will not be generated for other contacts that share the address with 
the selected contacts.

To generate ASIC Form 484A for all the corporations that a person is an officeholder 
or shareholders of, select that person from the People list, and then select the task 
Notify change of name or address. This process will also include other contacts that 
share the address of the selected person on the ASIC Forms generated.

To generate ASIC Form 484A for all the corporations that another corporation is a 
shareholder of, select that corporation from the Corporations list, and then select the 
task Notify change of address. This process will also include other contacts that share 
the address of the selected person on the ASIC Forms generated.
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To run the notify address changes of multiple contacts task

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Notify address changes of multiple contacts on the Task Bar.
The Notify Change of Address window opens, at the Select Contacts step.
For proprietary companies, the contact list is all the current officeholders and 
current shareholders of this corporation.
For public companies, the contacts list is all the current officeholders of this 
corporation.

3. Enter the date of the address change.

4. Select all the contacts whose address change is to be notified on this ASIC Form 
484A.

5. Click Next.
The Notify Change of Address window moves to the Select Documents step.

6. Select the documents to be produced.

7. Click Next.

8. If the document for the Minutes of the directors meeting to resolve change of 
registered address has been selected at the previous step, then the Minutes of 
Directors Meeting step is displayed, otherwise the Finish step is displayed.

9. Enter the details of the directors meeting.

10. Click Next.

11. The Notify Change of Address window moves to the Finish step.
Select the documents to be previewed.

12. Click Finish.
If a document has been selected for preview, the print preview window opens.
If no documents are selected for preview, system returns to the corporation.

Related topics
Corporations
Changing corporation addresses
Changing corporation addresses
Changing registered office details
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Corporation address histories
Deleting former corporation addresses
Notifying ASIC of corporate changes of address

Changing registered office details

From the Addresses tab you can change the following registered office details:

 Whether the company occupies the registered office.

 Occupier’s name.

 Registered office hours.

If the registered office details for foreign corporations and Australian registered 
bodies are changed, notify ASIC using the Notify change of address wizard (see 
“Notifying ASIC of corporate changes of address” on page 54).

To change business, postal or registered addresses, use MYOB AE/AO then notify ASIC 
of the address changes using the Notify change of address wizard (see “Notifying 
ASIC of corporate changes of address” on page 54).

To change registered office details

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Addresses tab.

3. Click Change Registered Office Details on the Task Bar or right-click the 
Addresses screen and select Change Registered Office Details from the menu.
The Registered Address Details screen opens.

4. If the corporation occupies this address, select Yes. If not, select No. 
If you select No, you must enter the name of the occupier. 

5. Select Registered office is open from at least 10am to 12 noon and 2pm to 
4pm.
or 
Select Registered office is open for at least 3 hours between 9am and 5pm and 
then enter the opening and the closing times.

6. Click OK.
The Addresses screen displays updated registered office details.
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7. For foreign corporations and Australian registered bodies, inform ASIC of the 
changes by using the Notify change of address wizard (see “Notifying ASIC of 
corporate changes of address” on page 54).

Related topics
Corporations
Changing corporation addresses
Changing corporation addresses
Notifying ASIC of corporate changes of address
Corporation address histories
Deleting former corporation addresses

Corporation address histories

From the Address History screen in the Corporations module, you can view the 
selected company’s name history. The data in this screen displays:

 Address

 Address type

 Date Started

 Date Ceased.

The history of addresses is updated each time a corporation’s address is changed in 
MYOB AE/AO and when ASIC is notified of the change of address (see “Notifying ASIC 
of corporate changes of address” on page 54).

Corporation name histories are also maintained in Corporate Compliance (see 
“Corporation name histories” on page 47). 

To view corporation address histories

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Address History tab.
The Address history screen opens.

3. To return to the Corporations selection list, click Close.

Related topics
Corporations
Changing corporation addresses
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Corporation addresses
Changing registered office details
Notifying ASIC of corporate changes of address
Notifying ASIC of address changes to more than one contact
Deleting former corporation addresses

Deleting former corporation addresses

Use the Addresses tab to delete a corporation’s former addresses.

To change corporation address histories

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Address History tab.
The Address History screen opens.

3. Select the address to be deleted.

4. Click Delete former address on the Task Bar.

5. The following message displays:
Are you sure you want to delete this former address? 

6. Click OK.
The former address is deleted from the Address history screen.

Related topics
Corporations
Changing corporation addresses
Corporation addresses
Changing registered office details
Notifying ASIC of corporate changes of address
Notifying ASIC of address changes to more than one contact
Corporation address histories

Postal address file (PAF) setting

With the introduction of CLERP 7 in July 2003, ASIC checks all addresses against 
Australia Post’s Postal Address Rules. These rules check the street against the suburb 
and the suburb against the postcode, thereby ensuring the address complies with the 
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Postal Address File (PAF). Addresses in ASIC forms that do not comply with the PAF 
will be rejected with the validation error:

V444 Australian address failed to pass matching rules for the Postal Address File.

If a form is rejected with this error, and you are sure the address is correct, change 
your PAF setting to override the ASIC PAF check. This will allow the address to pass 
ASIC validation.

You can override the PAF check in the following screens and wizards:

 Corporations > Notify Change of Address wizard

 Corporations > Addresses

 People > Notify Change of Name or Address wizard

 People > Details.

Related topics
Changing postal address file settings for people
Changing company postal address file (PAF) settings

Changing company postal address file (PAF) settings

You can exempt a selected company from the Postal Address File (PAF) check by ASIC 
(see “Postal address file (PAF) setting” on page 61). 

The PAF check applies only to business and registered addresses, not to postal 
addresses.

To exempt an address from the PAF check

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Addresses tab.

3. Click Change postal address file setting on the Task Bar or right-click the 
Addresses tab screen and select Change postal address file setting from the 
menu.
The Change Postal Address File Setting screen opens.

4. Indicate whether or not the Business and/or Registered address meets the PAF 
rules.

5. Click OK.
Any business or registered addresses marked on the Addresses screen as not 
meeting the PAF rules will not be checked by ASIC.
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Related topics
Corporations
Corporation addresses

Officers

The Officers screen displays current and former officers who have been appointed to 
the selected corporation.

To view an officer’s details

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Officers tab.
The Officers screen opens.

3. To add more details for the officer, double-click the officer’s entry or select 
 Show further details. 

4. To include the details of previous officers in the list, select  Include former 
officers.
From this screen, you can:

 Appoint and cease officers (see “Appointing company officers” on page 63 
and “Ceasing company officers” on page 66)

 Change officer details (see “Changing officer details” on page 68)

 Delete officers (see “Deleting officers” on page 69).

5. To return to the Corporations selection list, click Close.

Related topics
Corporations
Officers
Changing officer details
Deleting officers

Appointing company officers

Use the Appoint or Cease an Officer wizard to appoint people to the positions of 
Director, Secretary or Alternate Director. 
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You can also use this wizard to cease officers (see “Ceasing company officers” on 
page 66).

To appoint an officer

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Appoint or Cease Officers on the Task Bar.
The Appoint or Cease Officers wizard opens.

3. Select Appoint Officers.

4. Click Next.
The Select Officers to be Appointed window opens.

5. Click Add.

6. To select a Person name/code, click .
The Find a Person window opens.

7. If necessary, find the person by scrolling through the Name list or by searching.

8. Select the person in the search list.
If you cannot find the person, add their details from MYOB AE/AO (see “Adding 
people” on page 128).

9. Select an Office held (i.e., Director, Company Director or Alternate Director).

Note: If you select Alternate Director: 
 
Select the applicable Director from the Alternate for drop-down.  
 
Enter the Effective to date, or select the date from the drop-down 
calendar.

10. Enter the Date of appointment or select the date from the drop-down calendar.

11. Click OK.
The officer is added to the list of Officers to be appointed.

12. To appoint further officers to the same corporation, repeat Step 5. to Step 11. 
for each additional officer.
To delete officers from the list, click Delete.



Corporations

MYOB AO Corporate Compliance | Version 3.0 User Guide | 65

13. Click Next.
The Select the documents you wish to produce window opens.

14. Select the documents you need to produce: 

 ASIC form 484 — notification of change to office holders 

If you selected ASIC form 484, the form signatory fields are enabled.

Select the Form Signatory from the drop-down list. (If the officer required is 
not on the list, they have not been appointed as an officer.)

Enter the Form Sign Date or select the date from the drop-down calendar. 

 Minutes of the directors’ meeting 

 Officer’s consent to act form.
If you did not select any documents to generate, a message box opens. 

15. Click Yes then go to Step 16.

16. Click Next.

17. If you selected Minutes of the directors meeting at the previous Step, the Enter 
details of the directors meeting window opens.
Enter the date of the meeting or select the date from the drop-down calendar.
Enter the Time of the meeting and when the Meeting closed.
Select where the meeting was held (i.e., Business Office or Registered Office).
Select the Chairperson for the meeting from the drop-down list.
Select the Officers present.

18. If you did not select Minutes of the directors meeting in the previous window, 
go to the next Step.

19. Click Next.
The Finish window opens with the list of appointed officers.
To make changes, click Back.

20. Select the documents you need to preview.

 ASIC form 484 — notification of change to office holders 

 ASIC form 370 — notification by office holder of resignation 

 Minutes of the directors meeting, and/or 

 Officer’s consent to act form.

21. Click Finish.
If you selected to preview documents in the previous window, they display on 
the Print preview screen (see “Previewing forms and documents” on page 40).
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If you did not select to preview documents, the ASIC Form Validation window 
opens (see “ASIC forms validation” on page 176).

22. Complete the form (see “ASIC forms in progress” on page 174) and lodge the 
form with ASIC (see “Forms lodgement” on page 182).

Related topics
Corporations
Officers
Changing officer details
Deleting officers

Ceasing company officers 

Use the Appoint or Cease an Officer wizard to cease an officer’s position of Director, 
Secretary or Alternate Director. 

This wizard ensures that a history of all positions previously held within in each 
company will be maintained on the Officers screen.

You can also use this wizard to appoint officers (see “Appointing company officers” 
on page 63).

To cease an officer’s position

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Appoint or Cease Officers on the Task Bar.
The Appoint or Cease Officers wizard opens.

3. Select Cease Officers.

4. Click Next.
The Select officers to be ceased screen opens.

5. Click Add.
The Ceasing Officer screen opens.

6. Select the Officer from the drop-down list. 
If the officer is not listed, they have not been appointed as an officer of the 
selected corporation. See “Appointing company officers” on page 63.

7. Enter the Date of Ceasing or select it from the drop-down calendar.
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8. Select a Reason for Ceasing (optional).

9. Click OK.
The officer is added to the Officers to be ceased list.

10. If you need to resign other officers from the same corporation, repeat Step 5. to 
Step 9. for each officer.

11. Click Next.
The Select the documents you wish to produce screen opens.

12. Select each document you require: 

  ASIC form 484 — notification of change to office holders. (The form 
signatory fields are enabled.)

Select the Form Signatory from the drop-down list. (If the officer required is 
not in the list, they have not been appointed as an officer.)

Enter the Form Sign Date or select it from the drop-down calendar. 

  ASIC form 370 — notification by office holder of resignation 

  Minutes of the directors’ meeting 

  Officer’s notice of resignation.

13. Click Next.
If you selected Minutes of the directors’ meeting at the previous step, the Enter 
details of the directors’ meeting screen opens.

a. Enter the date of the meeting or select it from the drop-down calendar.

b. Enter the Time of the meeting and when the Meeting closed.

c. Select where the meeting was held (i.e., Business Office or Registered 
Office).

d. Select the Chairperson for the meeting from the drop-down list.

e. Select the Officers present.

If you did not select Minutes of the directors’ meeting at the previous screen, go 
to the next step.
If you did not select any documents to be produced, a message box will state: 
“You have selected to produce no documents. Are you sure?”. Click Yes then go 
to the next step.

14. The Finish screen lists resigning officers.
To make changes, click Back.

15. Select the documents you need to preview:
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 ASIC form 484 — notification of change to office holders

 ASIC form 370 — notification by office holder of resignation

 Minutes of the directors’ meeting

 Officer’s consent to act form.

16. Click Finish.
If you selected to preview documents in the previous window, they display on 
the Print preview screen (see “Previewing forms and documents” on page 40).
If you did not select to preview documents, the ASIC Form Validation window 
opens (see “ASIC forms validation” on page 176).

17. Complete the form (see “ASIC forms in progress” on page 174) and lodge the 
form with ASIC (see “Forms lodgement” on page 182).

Related topics
Corporations
Officers
Changing officer details
Deleting officers

Changing officer details

Use the Officers tab in the Corporations module, to change the following data relating 
to an officer:

 Office held

 Date of appointment 

 Date of ceasing

 Reason for ceasing

 Alternate Directors.

Changes made to an officer’s details from this screen do not generate an ASIC 
Form 484. If ASIC needs to be notified of the changes to the officer’s details, generate 
an ASIC Form 484 using the Appoint or cease officers wizard (see “Appointing 
company officers” on page 63 or “Ceasing company officers” on page 66).

To change an officer’s details

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Officers tab.
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3. The Officers screen opens.

4. Select the officer who needs to be changed.

5. Click Change officer details on the Task Bar, or right-click the Officers tab and 
select Change Officer Details from the menu.
The Officer details for (officer’s name and code) screen opens.

6. Enter your changes.

7. Click OK to save the changes. 

8. Read the directions in the message box when it opens:
If you click OK:

a. Your changes will be confirmed and the Officers tab will display the updated 
officer’s details.

b. If you entered a Date of ceasing, the officer will be deleted from the list of 
officers. To display the officer, select  Include former officers.

If you click Cancel:

a. Your changes will be discarded. A message box will ask: “You have amended 
data, do you wish to discard changes?”

b. If you click Yes, your changes will be discarded and the Officers screen will 
display unchanged data. 

If you click No, the Officer details for (officer’s name and code) screen will 
display updated data.

Related topics
Corporations
Officers
Deleting officers

Deleting officers

Use Delete Officer (on the Officers tab of the Corporations module) to permanently 
delete officers who were incorrectly appointed using the Officers tab screen. 

However, if ASIC must be informed of the resignation, use the Appoint or cease 
officers wizard (see “Appointing company officers” on page 63 or “Ceasing company 
officers” on page 66). 
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To delete an officer

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Officers tab.
The Officers screen opens.

3. Select the officer that needs to be changed.

4. Click Delete officer on the Task Bar, or right-click the Officers tab and select 
Delete officer from the menu.

5. When the message box opens:
Click Yes to delete the officer from the Officers screen.
or
Click No to retain the officer.

Related topics
Corporations
Officers
Changing officer details

Trusts

The following topics provide information about:

 Appointing trustees

 Changing trustee details

 Ceasing trustees

 Deleting trustees.

Related topics
Corporations
Officers
Changing officer details

Appointing trustees

The following method is used to appoint trustees to trusts. It is used for both:
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 Unit Trusts — a trust in which the trust property is divided into a number of 
defined shares called units. The beneficiaries subscribe for the units in much the 
same way as shareholders in a company subscribe for shares.

 Discretionary Trusts — generally a trust under which the distribution of income 
or capital to beneficiaries is made at the discretion of the trustee. Until the 
trustee exercises its discretion, the beneficiaries generally have no interest in 
the property of the trust. A discretionary trust is sometimes called a “family 
trust” (for tax reasons, however, a family trust means a trust that has made a 
family trust election).

To appoint a trustee

1. Click Corporations on the Task Bar.
The Corporations selection list opens.
If the list is long, find the trust by searching or sorting.

2. Select the trust and press [Enter], or double-click the trust.
The trust opens at the Details tab. 

3. Click the Officers tab to display its contents.

4. Click Appoint trustee on the Task Bar, or right-click the Officers tab and select 
Appoint trustee… from the menu. 
The Add Trustee window opens.

5. Click  to open the Find a Contact screen 

6. Find the desired person or company to act as trustee by searching or sorting.

7. Click OK.
To close the Find screen and add the new trustee.

8. Select the Appointment Date from the drop-down calendar.

9. Click OK.
The new trustee’s details are added to the trust’s Officers tab.

Related topics
Corporations
Officers
Changing trustee details
Ceasing trustees
Deleting trustees
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Changing trustee details

The following method is used to change a trustee’s Appointment Date and/or add a 
Ceased Date for trusts. The same method is used for both Unit Trusts and 
Discretionary Trusts.

Note: If you add a Ceased Date here, the trustee will also be ceased on that date. If 
the date entered is after today, the trustee will not be ceased until that date 
arrives. The trustee will then be removed from this trust’s Officers tab, but 
not from the database. 

If you want to delete a trustee from both this trust’s Officers tab and from the 
Corporate Compliance database, see “Deleting trustees” on page 73. 

To change trustee details

1. Click Corporations on the Task Bar.
The Corporations selection list opens.
If the list is long, find the trust by searching or sorting.

2. Select the trust and press [Enter], or double-click the trust.
The trust opens at the Details tab. 

3. Click the Officers tab to display its contents.

4. Select the trustee whose details you want to change from the table.

5. Either click Change trustee details on the Task Bar, or right-click the trustee and 
select Change trustee details… from the list.
The Change Trustee Details screen opens.

6. If required, change the Appointment Date by overtyping, or by selecting from 
the drop-down calendar.

7. If you want to cease the trustee, add a Ceased Date by overtyping, or by 
selecting from the drop-down calendar. 

8. Click OK when finished.

Related topics
Corporations
Officers
Appointing trustees
Ceasing trustees
Deleting trustees
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Ceasing trustees

The following method is used to cease a trustee from a trust. The same method is 
used for both Unit Trusts and Discretionary Trusts.

To cease a trustee

1. Click Corporations on the Task Bar.
The Corporations selection list opens.
If the list is long, find the trust by searching or sorting.

2. Select the trust and press [Enter], or double-click the trust.
The trust opens at the Details tab. 

3. Click the Officers tab to display its contents.

4. Select the trustee you want to cease from the table.

5. Either click Cease trustee on the Task Bar, or right-click the trustee and select 
Cease trustee… from the list.
The Cease Trustee screen opens.

6. Add the Ceased Date by overtyping, or by selecting from the drop-down 
calendar. 

7. Click OK.

Note: If the date entered is after today, the trustee will not be ceased 
until that date arrives. 

The trustee is removed from this trust’s Officers tab, but not from the database. 
(See “Deleting trustees” on page 73 if you want to completely remove a 
trustee).

Related topics
Corporations
Officers
Appointing trustees
Changing trustee details
Deleting trustees

Deleting trustees

The following method is used to delete a trustee from a trust — and to permanently 
remove that trustee’s details from your Corporate Compliance database. The same 
method is used for both Unit Trusts and Discretionary Trusts.
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To delete a trustee from a trust and from your CC database

1. Click Corporations on the Task Bar.
The Corporations selection list opens.
If the list is long, find the trust by searching or sorting.

2. Select the trust and press [Enter], or double-click the trust.
The trust opens at the Details tab. 

3. Click the Officers tab to display its contents.

4. Select the trustee whose details you want to change in the table.

5. Either click Delete trustee on the Task Bar, or right-click the trustee and select 
Delete trustee… from the list.

6. Read the Delete Trustee message.

7. Click Yes to completely remove the trustee from the trust and from the 
Corporate Compliance database.

Related topics
Corporations
Officers
Appointing trustees
Changing trustee details
Ceasing trustees

Capital

From the Capital screen you can maintain share and shareholder details using the 
following functions:

 View share issue details (see “Shares & units held” on page 114)

 Change amounts paid (see “Changing amounts paid to shares” on page 76)

 Add share issues (see “Adding share issues” on page 92)

 Change share issues (see “Changing share issues” on page 94)

 Delete share issues (see “Deleting shares issued” on page 95)

 Notify the issue of shares (see “Notifying ASIC of share issues” on page 78).

 (AE) Add, edit and delete share dividends (see “Maintaining share dividends” on 
page 87).
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Note: This screen is not available for corporations which cannot issue 
shares (i.e., are limited by guarantee).

To view a corporation’s shares

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Capital tab.
The Capital screen opens.

3. Select  Show share issue transactions.
The various shares tasks on the Task Bar are enabled.

4. To return to the Corporations selection list, click Close.

Related topics
Corporations
Share issue details
Notifying ASIC of share issues
Changing amounts paid to shares
Transferring and transmitting shares
Cancelling classes of shares

Share issue details

The Share Issue screens are used for:

 Viewing share issue details (see “Shares & units held” on page 114)

 Adding share issues (see “Adding share issues” on page 92)

 Changing issued share details (see “Changing share issues” on page 94)

 Deleting issued shares (see “Deleting shares issued” on page 95)

 Notifying the issue of shares (see “Notifying ASIC of share issues” on page 78)

 Changing the amounts paid (see “Changing amounts paid to shares” on 
page 76).

These screens display share details in two tabs:

 Issue details — This tab contains data relating to the share class and issue date, 
amount paid and consideration details.
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 Allotment details — This tab contains the shareholders’ details, which can also 
be viewed from the Members tab in the Corporations module and the Shares 
held tab in the People module.

If you want to allot shares to a member who is not listed, first add their details in 
MYOB AE/AO.

To access the share issue screens

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Capital tab.
The Capital screen opens.

3. Click one of the following tasks on the Task Bar:

 View share issue details (see “Shares & units held” on page 114)

 Add share issues (see “Adding share issues” on page 92)

 Change share issues (see “Changing share issues” on page 94)

 Delete share issues (se “Deleting shares issued” on page 95)

 Notifying the issue of shares (see “Notifying ASIC of share issues” on 
page 78)

 Changing the amounts paid (see “Changing amounts paid to shares” on 
page 76).

Related topics
Capital
Notifying ASIC of share issues
Changing amounts paid to shares
Members
Shares held
Changing joint holdings

Changing amounts paid to shares

The Changes to amounts paid wizard is used to:

 Enter payment instalments on partially paid shares.

 Generate a form to notify ASIC of the change.

You can also use this wizard to enter the payment instalments and generate 
documents later.
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If you need to change the details of shares issued previously, rather than notify ASIC 
of a payment instalment, enter the details on the Change share issue screen (see 
“Changing share issues” on page 94).

To change amounts paid to shares

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Capital tab. (see “Capital” on page 74).

3. Select the share issue to be changed.

4. Click Changes to amounts paid on the Task Bar.

5. If the share issue is partly paid: The Changes to Amounts Paid wizard opens. 
Click Next.
If the share issue is fully paid: A message box opens. 

 To notify ASIC of a change that was entered previously, click OK to continue. 

The Changes to Amounts Paid wizard opens.

Click Next.

 To correct share issue data without notifying ASIC, click Cancel. 

Enter the changes on the Change share issue screen.

The Enter the changed payment details screen opens.

6. Enter the Date of change (dd/mm/yyyy) or select the date from the drop-down 
calendar.

7. If you need to enter the payment instalment details now, enter the Additional 
amount paid in the Per share or Total fields. This amount should be less than or 
equal to the Amount paid field.
If you do not need to enter the payment instalment details, leave the Additional 
amount paid fields blank.

8. Click Next.
The Confirm the members affected screen opens.

9. If the list of members is correct, click Next. 
The Select the documents you want to produce screen opens.
If the list of members is not correct, click Cancel and enter the changes on the 
Change share issue screen.

10. If you want to notify ASIC of the change now:
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a. Select the documents you want to generate from the list. 

b. Select the Signing officer from the list. 

c. Enter the Date signed (dd/mm/yyyy) or select the date from the calendar.

If relevant, indicate if this form is being generated In response to a company 
statement (as required for Form 484C).

d. Click Next. 

The Finish screen opens.

e. Select the documents you want to preview.

f. Click Finish. 

If you selected to preview documents in the previous screen, they display 
on the Print preview screen.

If you did not select to preview documents, the ASIC Form Validation 
screen opens.

g. Complete and lodge the form with ASIC.

11. If you want to notify ASIC of the change later: 

a. Deselect the documents to be generated.

b. Click Next. 

The Finish screen opens.

c. Click Finish.

Related topics
Capital
Notifying ASIC of share issues
Changing amounts paid to shares
Members
Shares held

Notifying ASIC of share issues

The Notify issue of shares wizard is used to inform ASIC that a corporation has issued 
one or more of its shares.
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Note: The ASIC form 484C that is produced, automatically includes all share issues 
and all share allotments for the selected class and date. Ensure that you have 
added all the required share issues and allotments for the class and date 
before you generate the form to notify ASIC.

Before using this wizard, you must have already issued shares (see “Adding share 
issues” on page 92).

To notify ASIC of the issue of shares

1. If you have not done so already, enter the details of shares that have been 
issued (see “Adding share issues” on page 92).

2. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

3. Click the Capital tab (see “Capital” on page 74).

4. Select the share issue to be notified to ASIC.

5. Click Notify issue of shares on the Task Bar. 
The Notify Issue of Shares wizard opens.

6. Click Next.

7. Confirm the share issue details.
If they are correct, click Next.
The Select the documents you wish to produce screen opens.
If not correct, click Cancel and click Change share issue to correct the share 
issue details.

8. Select the documents you want to generate from the list.

9. Select the Signing officer from the list.

10. Enter the Date signed (dd/mm/yyyy) or select the date from the calendar.
If relevant, indicate if this form is being generated In response to a company 
statement (as required for Form 484C).

11. Click Next.
Enter the details of the directors’ meeting held.

12. Click Next.
The Finish screen opens.
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13. Select the documents you want to preview.

14. Click Finish.
If you selected to preview documents in the previous screen, they display on the 
Print preview screen (see “Previewing forms and documents” on page 40).
If you did not select to preview documents, the ASIC Form Validation screen 
opens (see “ASIC forms validation” on page 176).

15. Complete and lodge the form with ASIC (see “ASIC forms in progress” on 
page 174 and “Forms lodgement” on page 182).

Related topics
Capital
Share issue details
Changing amounts paid to shares
Members
Shares held

Transferring and transmitting shares

The Transfer shares wizard is used to:

 Transfer title in shares from a person or corporation to another person or 
corporation.

 Transmit title in shares from a person to another person or corporation.

Note: If you need to transfer title in shares from a corporation that has 
been de-registered, use the Transfer shares wizard to generate the 
ASIC form, as described below. Then amend the associated 
documents (e.g., minutes) to record the circumstances of the 
transfer.

To transfer or transmit title in shares

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Transfer shares on the Task Bar. 
The Transfer Shares wizard opens.

3. Click the drop-down under Select the member… and select the member who is 
currently listed as holding the shares.
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4. Select either:

 Transfer — go to “To transfer shares” on page 81
or

 Transmission — go to “To transmit shares” on page 83.

To transfer shares

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Transfer shares on the Task Bar. 
The Transfer Shares wizard opens.

3. Click the drop-down under Select the member… and select the member who is 
currently listed as holding the shares.

4. Select  Transfer 

5. Click Next.
The Enter transfer details screen opens.

6. Select a Share class from the list of share classes that have been issued to the 
transferring member.

7. Enter the Date of transfer (dd/mm/yyyy) or select the date from the drop-down 
calendar.

8. Select whether the transferring member wants to transfer All shares held or 
Some shares held.
If you select Some shares held, enter the Number of shares to be transferred.

9. Enter the Per share or Total amount paid for the share transfer.

10. Click Next.
The Select the transferees screen opens.

11. Click Transfer.
The Member details for the transfer screen opens.

12. Select the transferee using either the:

 Select member from existing shareholders and officers list drop-down
or 

 Select member from the full contact list. 

Click . then search for the company or person.
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13. Enter the number of Shares to transfer.

14. Enter the Certificate number.

15. Select Yes or No to indicate whether the transferee is the Beneficial owner.
A beneficial owner of stock is any person or entity with sole or shared power to 
vote or dispose of the stock. This SEC definition is intended to include a holder 
who enjoys the benefits of ownership although the shares may be held in 
another name.

16. Click OK.
The Select the transferees screen reopens.
If the transferee details are incorrect, click Undo and repeat above steps.

17. Click Next.
The Select the joint holders for the transferees screen opens.

18. If the shares are 
Not to be held by joint shareholders, then proceed to Step 19.. 
To be held by joint share holders, then:

a. Click Joint Holders… to open the Joint shareholders screen.

b. Click Add. The Find a contact screen opens.

c. Search for the company or person.

d. Click OK and Close.

19. Click Next.
The Confirm the share transfer details screen opens.

20. If the details are:

 Incorrect, click Back to correct the data.

 Correct, click Next. The Select the documents you wish to produce screen 
opens.

21. Select the documents you require. 

22. Enter the signatory details.

23. If relevant, indicate if this form is being generated In response to a company 
statement (as required for Form 484C).

24. Click Next.
The Enter the details of the directors’ meeting... screen opens.
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25. Enter the meeting details.

26. Click Next.
The Finish screen opens.

27. Select the documents you want to preview.

28. Click Finish.
If you selected to preview documents in the previous screen, they open in the 
Print preview screen.
If you did not select to preview documents, the ASIC Form Validation screen 
opens.

29. Complete and lodge the form with ASIC (see “ASIC forms in progress” on 
page 174 and “Forms lodgement” on page 182).

To transmit shares

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Transfer shares on the Task Bar. 
The Transfer shares wizard opens.

3. Select the member who is currently listed as holding the shares from the drop-
down.

4. Select  Transmission. 

5. Click Next.
The Share transmission details screen opens.

6. Enter the Date of death of the shareholder (dd/mm/yyyy) or select the date 
from the calendar.

7. Enter Transfer date.

8. Click  beside the Select the member... field.
The Find a contact screen opens. 
Search for the corporation or person.

9. Click OK.
The Enter the share transmission details screen reopens.

10. Select whether the shares are to be Beneficially owned.
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11. If the shares:
Are not to be held by joint shareholders, go to Step 12. 
Are to be held by joint share holders:

a. Click Joint Holders… The Joint shareholders screen opens.

b. Click Add. The Find a contact screen opens.

c. Search for the corporation or person. 

d. Click OK and Close.

12. Click Next.
The Confirm the share transmission details screen opens.

13. If the details are:

 Incorrect, click Back to correct the data.

 Correct, click Next. The Select the documents you wish to produce screen 
opens.

14. Select the documents you require. 

15. Enter the signatory details.

16. If relevant, indicate if this form is being generated In response to a company 
statement (as required for Form 484C).

17. Click Next.
The Finish screen opens.

18. Select the documents you want to preview.

19. Click Finish.
If you selected to preview documents in the previous screen, they open in the 
Print preview screen.
If you did not select to preview documents, the ASIC Form Validation screen 
opens.

20. Complete and lodge the form with ASIC (see “ASIC forms in progress” on 
page 174 and “Forms lodgement” on page 182).

Related topics
Capital
Changing transfer details
Cancelling classes of shares
Notifying ASIC of share issues
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Changing amounts paid to shares
Members
Shares held

Cancelling classes of shares

The Cancel Shares wizard is used to cancel all or some shares of a particular class that 
have been issued by the selected corporation.

This wizard is available for all corporations, except corporations that are limited by 
guarantee, as indicated in each corporation’s Details screen (see “Viewing 
corporation details” on page 20).

To cancel a class of shares

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Cancel shares on the Task Bar. 
The Cancel Shares wizard opens.

3. Select the Share class you want to cancel from the list of share classes that have 
been issued by the corporation.

4. Select whether you want to cancel some or all shares of the class.

5. Click Next.
The Enter cancellation details screen opens.

6. Enter the Date of cancellation (dd/mm/yyyy) or select the date from the 
calendar.

7. Enter the Total number of shares cancelled.

8. Enter the Amount paid for cancelling each share.
The Total amount paid is automatically calculated.

9. Click Next.
The Select the reason for the share cancellation screen opens.

10. Select a reason for the share cancellation from the list.

11. Click Next.
The Select the documents to be produced screen opens.
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12. Select the documents to be produced: Form 484 — Cancellation of Shares, 
Minutes and Share Certificates.

13. Select the Signing officer from the list.

14. Enter the Date signed (dd/mm/yyyy) or select the date from the calendar.
If relevant, indicate if the form 484 is being generated In response to a company 
statement (as required for Form 484C).

15. Click Next.

16. If you have selected to print minutes, enter the details of each meeting held.

17. Click Next.
The Finish screen opens.

18. Select the documents you want to preview.

19. Click Finish.
If you selected to preview documents in the previous screen, they display on the 
Print preview screen (see “Previewing forms and documents” on page 40).
If you did not select to preview documents, the ASIC Form Validation screen 
opens (see “ASIC forms validation” on page 176).

20. Complete and lodge the form with ASIC (see “ASIC forms in progress” on 
page 174 and “Forms lodgement” on page 182).

Related topics
Capital
Transferring and transmitting shares
Members
Shares held

Adding beneficial owners

This screen is used to add beneficial owners for shares issued previously.

A beneficial owner of stock is any person or entity with sole or shared power to vote 
or dispose of the stock. This SEC definition is intended to include a holder who enjoys 
the benefits of ownership although the shares may be held in another name.

To add a beneficial owner

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 
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2. Click the Capital tab to open the Capital screen.

3. Select the share issue in the list and click Change share issue on the Task Bar.
The Change Share Issue window opens at the Issue details tab.

4. Click the Allotment details tab.

5. Click Beneficial Owners… 
The Beneficial Owners screen opens.

6. Click Add.

7. Find the person or corporation by searching or sorting.
If necessary, click New Contact… to add a new contact.

8. Scroll through the selection list and select a company or person.
The selected contact is added to the list of beneficiaries.

9. Click Close.

Related topics
Capital
Transferring and transmitting shares
Changing beneficial owners

Changing beneficial owners

Use the Transfer shares wizard to generate Form 484C to notify the change to a 
beneficial holding. The process is used to transfer the shares from the current holder 
as beneficial holder to the current holder as non-beneficial holder (or vice versa).

Related topics
Adding beneficial owners
Capital
Shares held
Transferring and transmitting shares

Maintaining share dividends

Accoutants Enterprise only

Use the Share Dividends window (accessed from the Capital tab of the company’s 
Corporations screen) to add, view, edit and delete share dividends, and to produce 
the necessary documents.
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To open the Share Dividends window

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Capital tab to open the Capital screen.

3. Click to select the share issue in the list, and either:

 Click Share Dividends on the Task Bar.

 Right-click and select Share Dividends from the list.

 Select Action > Dividend… on the main menu.
The Share Dividends window opens.

Related topics
Adding and editing share dividends
Listing shareholders receiving dividend payments
Adding and editing share dividends
Deleting share dividends
Producing share dividend documents

Adding and editing share dividends

Accoutants Enterprise only

To add share dividends

1. Open the Share Dividends window
See “To open the Share Dividends window” on page 88.

2. Click Add… to open the Share Dividend Details window.

3. Select the Share Class from the drop-down.

4. Either enter the Declaration and Payment dates, or select them from the drop-
down calendar.

5. If relevant, select  Specify date to determine shareholders and enter the date.
The Number of shares to receive dividend is calculated. 

6. Select the Type of dividend and Franking type from the drop-downs, and enter 
the Franked %.

7. Select either Enter dividend amount per share, or Enter total amount of 
dividend paid, and enter the amount.
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8. Enter the Franking tax rate % and the Company tax rate %.
Corporate Compliance will calculate and display the Franking credit per share, 
Franked amount per share and Unfranked amount per share.

9. Enter appropriate Notes.

10. Click OK to exit.
The Share Dividends window will list the new dividend details.

11. If appropriate, produce relevant documents — see “Producing share dividend 
documents” on page 91 for instructions.

12. Click Close.
To exit to the Share Dividends window.

To edit share dividends

1. Open the Share Dividends window
See “To open the Share Dividends window” on page 88.

2. Click the share dividend you want to change.

3. Click Edit.
The Share Dividend Details window opens.
See “To add share dividends” on page 88 for more information about changing 
these details.

Related topics
Maintaining share dividends
Adding and editing share dividends
Listing shareholders receiving dividend payments
Deleting share dividends
Producing share dividend documents

Listing shareholders receiving dividend payments

Accoutants Enterprise only

You can list all the shareholders who are to receive each dividend payment by clicking 
the View Shareholders button on the Share Dividends screen. This opens the 
Shareholders receiving dividend payment screen.

You can also obtain details of any Joint Holders of each parcel of shares.
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To list all shareholders receiving a dividend payment

1. Open the Share Dividends window
See “To open the Share Dividends window” on page 88.

2. Click View Shareholders.
The Shareholders receiving dividend payment window opens.
All who are receiving this dividend payment are listed with their essential 
details.

3. To view details of any joint holders of share parcels:

a. Select a line which has “Yes” under the Jointly Owned column.

b. Click Joint Holders.

The Joint Shareholders window opens listing the joint holders.

c. Click Close.

To return to the Shareholders receiving dividend payment screen.

4. Click Close.
The Share Dividends window closes.

Related topics
Maintaining share dividends
To edit share dividends
Deleting share dividends
Producing share dividend documents

Deleting share dividends

Accoutants Enterprise only

Corporate Compliance also allows you to delete details of a share dividend record 
using the Delete button on the Share Dividend Details screen.

To delete a share dividend

1. Open the Share Dividends window
See “To open the Share Dividends window” on page 88.

2. Click the share dividend you want to delete

3. Click Delete.
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4. Click Yes to confirm the deletion.

Note: Any documents created for this share dividend are not deleted 
automatically. They can be deleted from the Corporations 
Documents tab

Related topics
Maintaining share dividends
Adding and editing share dividends
Listing shareholders receiving dividend payments
To edit share dividends
Producing share dividend documents

Producing share dividend documents

Accoutants Enterprise only

Corporate Compliance allows you to generate the documentation required for share 
dividends using the Dividend Documents button on the Share Dividend Details 
screen.

To generate dividend documents

1. Open the Share Dividends window
See “To open the Share Dividends window” on page 88.

2. Click the share dividend which requires documentation.

3. Click Dividend Documents.

4. The Share Dividend Documents wizard opens displaying the dividend details.

5. If the details are correct, click Next.
Corporate Compliance lists the available documents, with some selected by 
default.

6. Select/deselect the documents you require and click Next.
Corporate Compliance presents a series of wizard windows (one for each 
document selected at Step 6.) with selections for people attending, dates and 
times.

7. Complete each wizard step and click Next until the wizard Finish window 
appears.

8. Click Finish to review your selected documents in the Preview window.



Corporations

MYOB AO Corporate Compliance | Version 3.0 User Guide | 92

a. If you want to amend a document, click Edit, and make your changes. 

b. Click Save when finished, 

c. Repeat for each document.

9. Click Close.
The Preview window closes.

10. Print the documents.

11. Click Close to return to the company’s Capital tab.

Related topics
Maintaining share dividends
Adding and editing share dividends
Listing shareholders receiving dividend payments
To edit share dividends
Deleting share dividends

Adding share issues

The Add share issue screen in the Corporations module is used to add or issue shares.

To add a share issue

1. Select and open the corporation.
See “Selecting a corporation” on page 21.

The corporation opens at the Details tab. 

2. Click the Capital tab.

3. Click Add share issue on the Task Bar.

4. The Add share issue screen opens at the Issue Details tab.

5. Enter the Issue date or select from the drop-down calendar.

6. Select the Share class from the drop-down.

7. Enter the Number of shares issued.

8. Enter the Amount paid per share. 
The total paid will be calculated automatically.

9. Enter the Amount unpaid per share. 
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The total amount unpaid will be calculated automatically.

10. If all shares have: 
Been issued for cash only, click Yes and go to Step 11.
or,
Not been issued for cash only, click No:

a. If some or all of the shares issued were:

Under a written contract, click Yes and go to Step 11.

or

Not under a written contract, click No: 

b. Select the consideration for which the shares were issued from the drop-
down.

c. Click  to open the Enter details of shares issued for other than cash 
screen. The fields on this screen vary according to the type of consideration 
selected above.

d. Complete all details on the screen.

e. Click OK.

To close the screen and return to the Add Share Issue screen.

11. Click OK to close.

12. After entering the share issue details, notify ASIC of the share issue (see 
“Notifying ASIC of share issues” on page 780.

Note: You can add more than one issue of the same class on the same day 
for a company. This is usually required where some shares are 
issued fully paid, while other shares are issued on the same day for 
the same class, but partly paid (or for a different payment amount).

Related topics
Capital
Notifying ASIC of share issues
Changing amounts paid to shares
Members
Shares held
Changing share issues
Deleting shares issued
Shares issued for other than cash
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Changing share issues

The Change share issue screen is used to change the details of shares previously 
issued.

To change a share issue

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Capital tab to display the list of shares issued.

3. Select the share issue required and click Change share issue on the Task Bar.
The Change share issue screen opens at the Issue details tab.

4. Edit the Number of shares issued.

5. Edit the Amount paid per share. 
The total paid will be calculated automatically.

6. Edit the Amount unpaid per share. 
The total amount unpaid will be calculated automatically.

7. If all shares have: 
Been issued for cash only, click Yes and go to Step 8.
or,
Not been issued for cash only, click No:

a. If some or all of the shares issued were:

Under a written contract, click Yes and go to Step 8.

or,

Not under a written contract, click No: 

b. Select the consideration for which the shares were issued from the drop-
down.

c. Click  to open the Enter details of shares issued for other than cash 
screen. The fields on this screen vary according to the type of consideration 
selected above.

d. Edit details on the screen.

e. Click OK.

To close the screen and return to the Add Share Issue screen.
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8. A message box will display. Click Yes to proceed with the change.

9. If you want to inform ASIC of the changes to the share details, use the 
Amendment to previously lodged form wizard (see “Amending previously 
lodged forms” on page 173).

Note: If you need to record the payment of an instalment, use the Changes to 
amounts paid wizard (see “Changing amounts paid to shares” on page 76). 
 
If you need to change the details of the beneficial ownership of shares, use 
the Transfer shares wizard (see “Changing beneficial owners” on page 87).

Related topics
Capital
Notifying ASIC of share issues
Changing amounts paid to shares
Members
Shares held
Adding share issues
Deleting shares issued
Shares issued for other than cash

Deleting shares issued

The Delete share issue screen in the Corporations module is used to delete selected 
shares from the database.

To delete shares issued

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Capital tab to display the list of shares issued.

3. Select the share issue and click Delete share issue on the Task Bar.
The Delete share issue screen opens at the Issue details tab.

4. Click Delete.
A message box opens. 

5. Click Yes to proceed with the change.
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6. If you want to inform ASIC of the changes to the share details, use the 
Amendment to previously lodged form wizard (see “Amending previously 
lodged forms” on page 173).

Related topics
Capital
Notifying ASIC of share issues
Changing amounts paid to shares
Members
Shares held
Adding share issues
Changing share issues
Shares issued for other than cash

Shares issued for other than cash

The Enter details of shares issued for other than cash screen is used to enter the 
details of non-cash consideration for shares (see “Share issue details” on page 75).

This screen is accessed when:

 Adding share issues (see “Adding share issues” on page 92).

 Changing share issues (see “Changing share issues” on page 94)

To enter non-cash considerations when issuing shares

1. Select and open the corporation.
See “Selecting a corporation” on page 21.

The corporation opens at the Details tab. 

2. Click the Capital tab to display the list of shares issued.

3. Select either Add share issue or Change share issue from the Task Bar.

4. Select No for the following questions:

 Have all the shares been issued for cash only? 

 Were some of the shares issued under a written contract? 

5. Select an option from the Consideration for which shares were issued for other 
than cash list.

6. Click .
The Enter details of shares issued for other than cash screen opens.

7. Enter the details of the non-cash consideration.
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8. Click OK.
The Issue Details screen reopens.

9. Continue the process of adding or changing the shares issued (see “Adding 
share issues” on page 92 or “Changing share issues” on page 94).

Related topics
Capital
Notifying ASIC of share issues
Changing amounts paid to shares
Members
Shares held
Adding share issues
Changing share issues
Deleting shares issued

Unit trusts

If the entity type is a Unit trust, the Task Bar on the Capital tab page contains tasks 
for maintaining the units issued by the trust.

The tasks available are:

 Issue units (see “Adding unit issues” on page 98)

 Change unit issue (see “Changing unit issues” on page 99)

 Unit issue documents (see “Producing unit issue documents” on page 100)

 Transfer units (see “Transferring units issued” on page 101)

 Cancel units (see “Cancelling units issued” on page 104)

 Delete unit issue (see “Deleting units issued” on page 105).

Related topics
Adding unit issues
Changing unit issues
Producing unit issue documents
Transferring units issued
Cancelling units issued
Deleting units issued
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Adding unit issues 

The Add unit issue screen in the Corporations module is used to add or issue units.

To add a unit issue

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Capital tab.

3. Click Add unit issue on the Task Bar.
The Add unit issue screen opens at the Issue Details tab.

4. Enter the Issue date or select from the drop-down calendar.

5. Enter the Number of units issued.

6. Enter the Amount paid per unit. 
The total paid will be calculated automatically.

7. Enter the Amount unpaid per unit. 
The total amount unpaid will be calculated automatically.

8. When finished, click the Allotment details tab.

9. Click Add… 
The Member Details for the Allotment window opens.

10. Either click  Select member from existing members and officers list and select 
from the drop-down.
or

Click  Select member from the full contact list, then click  and search/
select the contact from the Find a Contact window. Click OK when finished.

11. Enter the Number of units allotted and the Amount paid. 
The totals will be calculated automatically, and the Certificate number 
allocated.

12. Select Yes if the units are Beneficially owned, or No if they are not.

13. Click OK.
You are returned to the Member Details for the Allotment window, where the 
details are now listed.

14. Click OK when finished.
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Related topics
Capital
Adding unit issues
Changing unit issues
Producing unit issue documents
Transferring units issued
Cancelling units issued
Deleting units issued

Changing unit issues

This Change unit issue screen is used to change the details of units issued previously.

To change a unit issue

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Capital tab to display the list of units issued.

3. Select the unit issue required and click Change unit issue on the Task Bar.
The Change unit issue screen opens at the Issue details tab.

4. Edit the Number of units issued.

5. Edit the Amount paid per unit. 
The total paid will be calculated automatically.

6. Edit the Amount unpaid per unit. 
The total amount unpaid will be calculated automatically.

7. Click the Allotment details tab to see the details on that tab.

8. Click Edit… 
The Member Details for the Allotment window opens.

9. Edit/change any or all of:

 Number of units allotted

 Amount paid per unit

 Certificate Number

 Beneficial Owner Yes/No.
The totals will update automatically.
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10. Click OK.
You are returned to the Change Unit Issue window.

11. Click OK when finished.

Related topics
Capital
Adding unit issues
Changing unit issues
Producing unit issue documents
Transferring units issued
Cancelling units issued
Deleting units issued

Producing unit issue documents

The Units Issue Documents wizard is used to produce the documents associated with 
an issue. The documents available are:

 Application for allotment of units

 Minutes of trustees meeting to approve unit issues

 Unit certificates.

Before using this wizard, you must have already issued units (see “Adding unit issues” 
on page 98).

To produce unit issue documents

1. If you have not done so already, enter the details of units that have been issued 
(see “Adding unit issues” on page 98).

2. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

3. Click the Capital tab.

4. Select the required unit issue.

5. Click Unit issue documents on the Task Bar. 
The Unit Issue Documents wizard opens.

6. Confirm the unit issue details.
If they are correct, click Next.
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The Select documents screen opens.
If not correct, click Cancel and click Change unit issue to correct the unit issue 
details.

7. Select  the documents you want to generate from the list.

8. Click Next.

9. Enter or use the calendar to select the Date and time of meeting and closing of 
meeting.

10. Select either  Business or  Registered for the location of the meeting.

11. Select the Chairperson and the Officers present.

12. Click Next.
The Finish screen opens.

13. Select  the documents you want to preview.

14. Click Finish.
The selected documents display on the Print preview screen (see “Previewing 
forms and documents” on page 40).

Related topics
Capital
Adding unit issues
Changing unit issues
Producing unit issue documents
Transferring units issued
Cancelling units issued
Deleting units issued

Transferring units issued

The Transfer units wizard is used to transfer title in units from a person or corporation 
to another person or corporation.

To transfer title in units

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Transfer units on the Task Bar. 
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The Transfer Units wizard opens.

3. Click the drop-down under Select the member… and select the member who is 
currently listed as holding the units.

4. Click Next.

5. The Enter transfer details window opens.

6. Enter the Date of transfer (dd/mm/yyyy) or select the date from the drop-down 
calendar.

7. Select whether the transferring member wants to transfer All units held or 
Some units held.
If you select Some units held, enter the number to be transferred.

8. Enter the Amount paid for the unit transfer.

9. Click Next.

10. Select the unit holding to be transferred.

11. Click Transfer… 

12. The Member Details for the Transfer screen opens.

13. Select the transferee using either the:

 Select member from existing members and officers list drop-down
or 

 Select member from the full contact list. 

Click . then search for the company or person.

14. Enter the number of Units to transfer.

15. Select Yes or No to indicate whether the transferee is the Beneficial owner.
A beneficial owner of stock is any person or entity with sole or shared power to 
vote or dispose of the stock. This SEC definition is intended to include a holder 
who enjoys the benefits of ownership although the shares may be held in 
another name.

16. Click OK.
The Transfer Units screen reopens, displaying all details, including the 
transferred units.
If the transferee details are wrong, click Undo and repeat the above steps.
If more units are listed as remaining to transfer, select another certificate and 
repeat the steps from Step 11.
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17. Click Next.
The Select the joint holders for the transferees screen opens.

18. If the units are 
Not to be held by joint holders, then proceed to Step 19.
To be held by joint holders, then:

a. Click Joint Holders… 

The Joint holders screen opens.

b. Click Add. 

The Find a contact screen opens.

c. Search for the company or person

d. Click OK and Close.

19. Click Next.
The Confirm the unit transfer details screen opens.

20. If the details are:
Incorrect, click Back to correct the data.
Correct, click Next. 
The Select documents screen opens.

21. Select the documents you require.

22. Click Next.
The Minutes of trustees meeting... screen opens.

23. Enter the meeting details.

24. Click Next.
The Finish screen opens.

25. Select the documents you want to preview.

26. Click Finish.
The documents open in the Print preview screen.

27. Complete and lodge the form with ASIC (see “ASIC forms in progress” on 
page 174 and “Forms lodgement” on page 182).

Related topics
Capital
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Adding unit issues
Changing unit issues
Producing unit issue documents
Transferring units issued
Cancelling units issued
Deleting units issued

Cancelling units issued

The Cancel Units wizard is used to cancel all or some units that have been issued by 
the selected corporation.

This wizard is available for all corporations, except corporations that are limited by 
guarantee, as indicated in each corporation’s Details screen (see “Viewing 
corporation details” on page 20).

To cancel units

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Cancel units on the Task Bar. 
The Cancel Units wizard opens.

3. Select the unit issue you want to cancel from the list of units that have been 
issued by the corporation.

4. Select whether you want to cancel some or all units.

5. Click Next.
The Enter cancellation details screen opens.

6. Enter the Date of cancellation (dd/mm/yyyy) or select the date from the 
calendar.

7. Enter the Total number of units cancelled.

8. Enter the Amount paid for cancelling each unit.
The Total amount paid is calculated automatically.

9. Click Next.
The Select the reason for the unit cancellation screen opens.

10. Select a reason for the unit cancellation from the list.

11. Click Next.
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The Select documents screen opens.

12. Select the documents to be produced.

13. Click Next.

14. Enter all details of the meeting.

15. Click Next.

16. If you have selected to print minutes, enter the details of each meeting held.

17. Click Next.
The Finish screen opens.

18. Select the documents you want to preview.

19. Click Finish.
The documents display on the Print preview screen (see “Previewing forms and 
documents” on page 40).

20. Complete and lodge the form with ASIC (see “ASIC forms in progress” on 
page 174 and “Forms lodgement” on page 182).

Related topics
Capital
Adding unit issues
Changing unit issues
Producing unit issue documents
Transferring units issued
Cancelling units issued
Deleting units issued

Deleting units issued

The Delete unit issue screen in the Corporations module is used to delete selected 
units from the database.

To delete units issued

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Capital tab to display the list of units issued.
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3. Select the unit issue and click Delete unit issue on the Task Bar.
The Delete unit issue screen opens at the Issue details tab.

4. Click Delete.
A message box opens. 

5. Click Yes to proceed with the change.

Related topics
Capital
Adding unit issues
Changing unit issues
Producing unit issue documents
Transferring units issued
Cancelling units issued
Deleting units issued

Members

The Members screen lists all shareholders or members of the selected corporation.

If the selected corporation is permitted to issue shares (from the Capital screen — see 
“Capital” on page 74), you can:

 View transaction details (see “Viewing transaction details” on page 108)

 Change transaction details (see “Changing transaction details” on page 109)

 Change joint holders (see “Changing joint holdings” on page 111)

 Change beneficial owners (see “Changing beneficial owners” on page 87)

 Delete share transactions (see “Deleting share transactions” on page 113).

If the selected corporation is not permitted to issue shares, you can:

 Add members (see “Adding members” on page 107)

 Delete members (see “Deleting members” on page 108).

(These corporations are limited by guarantee, as entered in the Change Details 
screen in the Corporations module, and they do not include a Capital screen.)

To view a corporation’s shareholders/members

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 
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2. Click the Members tab.
The Members screen opens.

3. Group sort member data by dragging the Member, Code, Share Class or Date 

column heading to the Group bar .
The members will then be grouped by the selected column heading.

4. To return to the Corporations selection list, click Close.

Related topics
Capital
Shares held
Corporations

Adding members

The option to Add members is available from the Members screen if the selected 
company’s class is limited by guarantee. This is set in the Corporation Details screen 
(see “Changing corporation details” on page 23).

To add a member

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Members tab.
The Members screen opens.

3. Click Add member on the Task Bar.
The Add Member screen opens.

4. In the Member field, click .
The Find a Contact screen opens.

5. Select the member from the list.

6. Click OK.
The member’s name displays in the Member field.

7. Enter the Date when membership commenced.

8. Click OK.



Corporations

MYOB AO Corporate Compliance | Version 3.0 User Guide | 108

The member is added to the Members screen.

Related topics
Members
Changing corporation details
Deleting members

Deleting members

To delete a member

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Members tab.
The Members screen opens.

3. Click Delete member on the Task Bar.
A message box asks if you are sure you want to delete this person as a member 
for this company.

4. Click OK.
The member’s details disappear from the Members screen, which then closes. 

Related topics
Members
Changing corporation details
Adding members

Viewing transaction details

The View Share (Allotment/Transfer/Cancellation) Details screen displays the 
details of a transaction that you have selected on the Members screen.

To view a member’s transaction details

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Members tab.
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The Members screen opens.

3. Select the member and click View transaction details on the Task Bar.
The Share (Allotment/Transfer/Cancellation) Details screen lists the members’ 
transaction details.

4. To return to the Members screen, click Close.

Related topics
Members
Capital
Shares held

Changing transaction details

You can change the following share transactions in the Corporations module:

 Transfers (see “Changing transfer details” on page 109)

 Transactions migrated from CSS where the date of issue on the Members screen 
does not match the issue date on the Capital screen (see “Changing allotment 
details” on page 110)

 Shares that have been issued using the Capital screen (see “Changing share 
issues” on page 94.

If you want to reverse a share transfer or cancellation, delete the transaction from the 
Members screen (see “Deleting share transactions” on page 113).

Related topics
Members
Capital
Shares held
Changing joint holdings

Changing transfer details

From the Corporation Members tab, select the share transaction and click Change 
Transaction Details on the Task Bar. The Change Share Transfer Details screen 
displays the complete details of the transfer of shares to the selected member. From 
this screen you can change the following details:

 Date of transfer

 Amount paid for the transfer.
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If the details to be changed are the certificate number, distinctive numbers, beneficial 
owner or joint owners, open the Capital tab and click Change Share Issue on the Task 
Bar. This transaction will be available beside the issue date shown in the Details of 
original issue.

If the share has been transferred to the wrong new member or the incorrect number 
of shares has been transferred, delete the transfer transaction and re-process it. To 
revert the transfer transaction, select the transaction and click Delete share 
transaction from the Task Bar. The shares that have been transferred will then be 
returned to the original holder. Use the Transfer Shares wizard to transfer the shares.

To change a member’s transaction

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Members tab.
The Members screen opens.

3. Select the member and click Change transaction details on the Task Bar.
The Change Share Transfer Details screen opens.

4. Change the details as required.

5. Click OK.
The details of the transaction are updated on the Members screen.

Related topics
Members
Capital
Shares held
Transferring and transmitting shares

Changing allotment details

The Corporations Members Change Share Allotment Details screen displays the 
complete details of selected transactions. You can change the Date of issue to match 
the date on the Capital screen. This process also updates the amounts paid and 
unpaid to match the Capital screen.

Note: This screen is only available for share transactions migrated from CSS where 
the date of the transaction (on the Members screen) is different from the 
issued date (on the Capital screen).
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To change a member’s date of issue

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Members tab.
The Members screen opens.

3. Select the member and click Change transaction details on the Task Bar.
The Change Share Allotment Details screen opens.

4. Select the Date of issue from the drop-down list of share issue dates for this 
share class (as displayed on the Capital tab screen).

5. Click OK.
A message box tells you that the amounts paid and unpaid for the transaction 
will be replaced by the amounts paid and unpaid from the Capital screen. The 
payment amounts for this transaction will be replaced by the amounts paid and 
unpaid for the share issue.

6. Click Yes to update the date of issue, amounts paid and amounts unpaid to 
match the data on the Capital screen. The share issue date on the Members 
screen is now the same as on the Capital screen.
If you click No, this data will not be updated.

Related topics
Members
Capital
Shares held

Changing joint holdings

The Joint Holders screen is used to:

 View joint holders of the selected member’s share allotment.

 Add joint holders to an allotment.

 Delete joint holders from an allotment.

To change joint holdings from the Capital screen

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 
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2. Click the Capital tab.
The Capital screen opens.

3. Select the holding to be changed. 

4. Select the member and click Change share issue on the Task Bar.
The Share Issue Details screen opens (see “Share issue details” on page 75). 

5. Select the Allotment Details tab.

6. Click Joint holders on the Task Bar.
The Joint shareholders screen opens.

7. Add or delete joint holders as required.

8. Click OK.

Note: If you add or delete joint holders and have already notified ASIC of 
the original allotment, you must lodge an amendment to the 
previously lodged form (see “Amending previously lodged forms” 
on page 173).

To change joint holdings from the Members screen

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Members tab.
The Members screen opens.

3. Select the holding to be changed and click Joint Holders on the Task Bar. 
The Joint Holders screen opens.

4. Add or delete joint holders as required.

5. Click OK.

Note: If you add or delete joint holders and have already notified ASIC of 
the original allotment, you will have to lodge an amendment to a 
previously lodged form (see “Amending previously lodged forms” 
on page 173).

Related topics
Capital
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Members
Share issue details

Deleting share transactions

You can delete (i.e., reverse) the following share transactions from the Members 
screen:

 Transfers (If the share issue has been transferred more than once, you can 
change only the latest transfer.) See “Transferring and transmitting shares” on 
page 80.

 Cancellations (see “Cancelling classes of shares” on page 85).

To delete a member’s shares that were allotted from the Capital screen

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Capital tab.
The Capital screen opens.

3. Click the transaction to be deleted and click Delete share issue on the Task Bar.
See also “Changing share issues” on page 94 and “Deleting shares issued” on 
page 95.

To reverse a share transfer or cancellation from the Members screen

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Members tab.
The Members screen opens.

3. Select the share transaction. 
For share cancellations, select  Include former holdings to display the 
transaction.

4. Click Delete share transaction on the Task Bar.
A message box says “You have selected to delete this share transaction. By 
doing so, the shareholdings will revert back to the status as at prior to this 
transaction. Are you sure? Yes/No”.

5. Click Yes to reverse the transaction.
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Click No to cancel the reversal.

Related topics
Members
Capital

Shares & units held

The shares held by a corporation are listed on the corporation’s Shares Held tab.

To view the shares held by a corporation

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Shares & Units Held tab.
The Shares & Units Held screen lists the shares held by the selected company in 
other companies. The list displays:

 Company

 Type (showing either share class code or units)

 Number held

 Certificate number

 Beneficially owned

 Jointly held

 Date.
It also contains the  Include former holdings option for viewing all current and 
former shareholdings.
For companies which are members of corporations that are limited by 
guarantee, only the following details display:

 Company name and code.

 Date the company became a member.
The share columns are left blank.

3. To return to the Corporations selection list, click Close.

Related topics
Capital
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Notifying ASIC of share issues
Changing amounts paid to shares
Members
Adding share issues
Changing share issues
Deleting shares issued
Shares issued for other than cash

Auditors

The Auditors window allows you to:

 View auditors (see “Viewing auditors” on page 115)

 Change auditors (see “Changing auditors” on page 116)

 Delete auditors (see “Deleting auditors” on page 117).

Viewing auditors

From the Auditors window you can view a corporation’s current and former auditors.

To view a corporation’s auditors

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Auditors tab.
The Auditors screen lists the corporation’s current auditors.

3. To display the corporation’s former auditors, select  Include former auditors.

4. The following functions are available for auditors:

 Change auditor (including cease an auditor’s appointment). See “Changing 
auditors” on page 116.

 Add auditor (see “Adding auditors” on page 117). 

 Delete auditor (see “Deleting auditors” on page 117). 

Related topics
Adding auditors
Changing auditors
Deleting auditors
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Corporations

Changing auditors

From the Change auditor details screen you can change the details of the 
corporation’s current auditor. 

You can also cease the appointment of an auditor, so that they become listed as a 
former auditor on the Auditors screen (see “Auditors” on page 115).

Alternatively you can permanently delete an auditor from this screen (see “Deleting 
auditors” on page 117).

To change an auditor

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Auditors tab.

3. The Auditors screen opens

4. Select the auditor and click Change auditor details on the Task Bar.
The Change auditor screen opens.

5. Change the Contact name, Date of appointment, Date of ceasing as required.
If you entered a Date of ceasing, you can also enter the Reason for ceasing.

6. Click OK.
The auditor’s details are updated on the Auditors screen.

Note: If you entered ceasing details, the auditor can only be viewed by 
selecting  Include former auditors.

Related topics
Auditors
Adding auditors
Changing auditors
Deleting auditors
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Adding auditors

From the Auditors tab of the Corporations module, you can add an auditor for a 
corporation.

To add an auditor

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Auditors tab.

3. Click Add an auditor on the Task Bar.
The Add an auditor screen opens.

4. Click  beside the Auditor field.
The Find a contact screen opens.

5. Search for the auditor in the list and select the auditor.

6. Click OK.

7. Enter the Contact name.

8. Enter the Date of appointment (dd/mm/yyyy) or select the date from the 
calendar.

9. Click OK.
The new auditor is listed on the Auditors screen.

Related topics
Auditors
Changing auditors
Deleting auditors

Deleting auditors

Use the Corporations Auditors tab to delete a corporation’s current and former 
auditors permanently.

If you need to cease an auditor’s appointment but maintain a record of that 
appointment, however, use the Change auditor details function instead (see 
“Changing auditors” on page 116).
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To delete auditors

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Auditors tab.
The Auditors screen lists the corporation’s current auditors.
(To list the corporation’s former auditors, select  Include former auditors.)

3. Click Delete an auditor on the Task Bar.

Related topics
Auditors
Adding auditors
Changing auditors

Holding companies

You can view a corporation’s ultimate holding company from the Corporations 
Details screen (see “Viewing corporation details” on page 20). 

Use the Change ultimate holding company wizard to change a corporation’s ultimate 
holding company.

To change a corporation’s ultimate holding company

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click Change ultimate holding company on the Task Bar. 
The Change ultimate holding company wizard displays the company’s ACN and 
Start date(from MYOB AE/AO).

3. Click .
The Find a Corporation screen lists your corporations.

4. If necessary, find the corporation by scrolling through the list or by searching.
If you cannot find the corporation, add it to MYOB AE/AO (see “Adding 
corporations” on page 19).

5. Select the corporation.
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6. Click OK.

7. Enter the date when the corporation became or will become the ultimate 
holding company or select the date from the drop-down calendar.

8. Click Next.
The Select the documents you wish to produce screen opens.

9. To inform ASIC of the change, select  ASIC Form 484.

10. Select the Signing officer from the drop-down or enter the name in the field.

11. Enter the Date signed or select the date from the drop-down calendar.

12. Click Next.
The Finish window opens.
If you selected to produce an ASIC Form 484 on the previous screen, the option 
to preview the form displays.
Select  ASIC Form 484 to preview it.

13. Click Finish.
If you selected to preview documents on the previous screen, they display on 
the Print preview screen (see “Previewing forms and documents” on page 40).
If you did not select to preview documents, the ASIC Forms Validation screen 
opens (see “ASIC forms validation” on page 176).

14. Complete and lodge the form with ASIC (see “ASIC forms in progress” on 
page 174, and “Forms lodgement” on page 182).

Related topics
Using Corporate Compliance
Corporations
Viewing corporation details
Changing corporation details
Adding corporations
Deleting corporations

Changing ultimate holding company details

The Corporations Holding Company tab displays the history of the Ultimate Holding 
Companies for the selected corporation. 

The Task Bar options available are:

 Change holding company details — allows you to edit the start or ceased dates.
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 Delete holding company — removes the record from the database.

 Change ultimate holding company — lets you add a new holding company, 
change the holding company or remove the holding company. It then helps you 
to notify ASIC of this change.

Related topics
Corporations

Charges

The Charges screen lists the current charges for a corporation. These charges are 
reflected in the Corporations Detailed Report (see “Corporations detailed report” on 
page 208) and Register of Charges report (see “Register of charges report” on 
page 213).

To view a corporation’s charges

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Charges tab. 
A list of the corporation’s current charges are displayed. The default sort order is 
by Date, with the most recent date at the top.

3. To display the corporation’s former charges, select  Include former charges.

4. Select a charge in the list and click one of the following options on the Task Bar:

 Add charge

 Change charge details

 Delete charge.

5. To return to the Corporations selection list, click Close.

Related topics
Adding charges
Changing charge details
Deleting charges
Corporations detailed report
Register of charges report
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Adding charges

Add company charges using the Charges tab.

To add a charge

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Charges tab.

3. Click Add charge on the Task Bar.
The Add charge screen opens at the Charge Details tab.

a. Enter the Registration number (a maiximum of 10 alphanumeric 
characters). It must be unique across all charges. This field is optional.

b. Enter the Date created (dd/mm/yyyy) or select the date from the drop-
down calendar.

c. Select the Type of charge from the drop-down list.

d. Select how the Charge was created from the drop-down list.

e. Select what the Charge is created against from the drop-down list.

f. Details of other conduct is required, but only if you selected By other 
conduct from the Charge was created drop-down list.

g. Enter a Liability description for the charge.

h. Enter the Max prospective liability amount.

i. Enter a Property description if the charge is over a property. This field is 
optional. You can leave it blank.

j. If the Type of charge is floating or fixed and floating, the options for “For a 
floating charge, is the creation of subsequent charges restricted?” is 
enabled. Select Yes or No.

4. Click the Chargee Details tab. 
You can select the chargee and set the financial benefit to the chargee on this 
tab.

a. Enter the Financial benefit to the chargee.

b. Click  beside the Chargee Name field.

The Find a Contact window with a list of companies and persons opens.
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c. To add a new contact, click New Contact… 

The selection list is sorted by Name. You can also sort by other columns.

d. Click any column heading in the selection list (e.g., Name). 

The data is sorted by the selected column in ascending order.

e. To sort the data in descending order, click the column heading again.

If a company or person is not listed, use search.

f. Scroll down the selection list and double-click a company or person. 

The selected corporation’s or person’s name is displayed in the Chargee 
Name field.

5. Click the Variation Details tab.
After a charge is notified to the ASIC, you need to notify ASIC of any variation to 
the charge. There may be a change to the chargee, a change to the liability 
secured by the charge, or a prohibition or restriction of subsequent charges on 
the property. The details of any such variation to the charge must be recorded 
on this tab.

a. Enter the Previous registration number (a maximum of 10 alphanumeric 
characters). 

This field is optional; you can leave it blank.

b. Enter the Date of change (dd/mm/yyyy) or select the date from the drop-
down calendar.

c. Enter a Description of change. 

This field is optional; you can leave it blank.

6. Click the Discharge Details tab.
When a charge is paid or released, you must enter the discharge details on this 
tab.

a. Enter the Discharge date (dd/mm/yyyy) or select the date from the drop-
down calendar.

b. Enter the Discharge details of the charge. 

This field is optional; you can leave it blank.

7. Click OK.
The charge is added to the Charges list.
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Related topics
Changing charge details
Deleting charges
Corporations detailed report
Register of charges report

Changing charge details

Change Charge details using the Charges tab.

To change the details of a charge

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Charges tab.

3. Click Change charge details on the Task Bar. 
The Change Charge screen opens at the Charge Details tab. 
Change the following fields on this tab:

 Registration number — It must be unique across all charges.

 Date created

 Type of charge

 Charge was created

 Charge is created

 Details of other conduct

 Liability description

 Max prospective liability

 Property description

 For a floating charge, is the creation of subsequent charges restricted?

4. Click the Chargee Details tab.
You can change the following fields on the Chargee Details tab:

 Financial benefit

 Chargee name.

a. Click , beside the Chargee name field.

The Find a Contact screen lists companies and persons.
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b. To add a new contact, click New Contact… 

c. Find the contact by searching or sorting.

d. Scroll down the selection list and double-click a company or person.

e. The selected corporation’s or person’s name is displayed in the Chargee 
Name field.

5. Click the Variation Details tab.
Change any of the following fields on the Variation Details tab:

 Previous registration number

 Date of change

 Description of change.

6. Click the Discharge Details tab.
Change any of the following fields on the Discharge Details tab:

 Discharge date

 Discharge details.

7. Click OK.

Related topics
Adding charges
Deleting charges
Corporations detailed report
Register of charges report

Deleting charges

Delete Charge details using the Charges tab.

To delete a charge

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the Charges tab.

3. Click Delete charge on the Task Bar.

4. A Delete charge confirmation message opens:
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You can set the charge to be discharged or released by entering the discharge 
date. This is done by selecting the task “Change charge details” and selecting the 
“Discharge details” tab.
Are you sure you want to permanently delete this charge from the database?

5. Click Yes to delete the selected charge from the Charges list.

Related topics
Adding charges
Changing charge details
Corporations detailed report
Register of charges report
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People
The People module is used for maintaining and viewing the following information: 

 Details of addresses, occupation, birth details (see “Viewing people details” on 
page 127), and notifying changes of name or address (see “Notifying ASIC of 
changes to names or addresses” on page 139).

 Positions held (see “Positions held” on page 134), as appointed using the 
Appoint and cease officers wizard (see “Appointing company officers” on 
page 63), and cessation of positions (see “Ceasing all positions held” on 
page 135).

 Shares held (see “Shares held” on page 136).

 Name history (see “Name history” on page 137).

 Address history (see “Address history” on page 147).

When you click People on the Task Bar, it expands to display the following options for 
setting up and maintaining people: 

 Notify change of name or address (see “Notifying ASIC of changes to names or 
addresses” on page 139).

 Cease all positions (see “Ceasing all positions held” on page 135).

 Open person details (see “Viewing people details” on page 127).

(You can also open a person’s details by double-clicking a person’s entry in the 
People selection list, or by clicking the entry and pressing [Enter].)

 Delete a person (see “Deleting people” on page 133).

The People selection list appears on the main display panel. See “Display panel” on 
page 10.

The People screen lists all people that have been added from MYOB AE/AO (see 
“Adding people” on page 128). To include all people from AE/AO in the list, select  
Include all People from AE / Include all People from AO.

Related topics
Using Corporate Compliance
Adding people
Changing people details
Changing postal address file settings for people
Deleting people
Notifying ASIC of changes to names or addresses
Ceasing all positions held

Working with people

This section contains the following topics:
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 “Selecting people” (see page 127)

 “Viewing people details” (see page 127)

 “Adding people” (see page 128)

 “Changing people details” (see page 130)

 “Changing addresses” (see page 131)

 “Changing postal address file settings for people” (see page 132)

 “Deleting former addresses” (see page 133)

 “Deleting people” (see page 133)

 “Ceasing all positions held” (see page 135)

 “Adding former names” (see page 138)

 “Notifying ASIC of changes to names or addresses” (see page 139)

 “Changing former names” (see page 146)

 “Deleting former names of people” (see page 147).

Selecting people

To select a person

1. Click People on the Task Bar.
The People selection list opens.

2. If necessary, locate the person by searching or sorting.

3. Select the person’s entry and press [Enter] or double-click the entry.
The person’s Details screen opens.

Related topics
People
Changing people details
Changing postal address file settings for people
Adding people
Deleting people
Viewing people details

Viewing people details

Use the person’s Details tab in the People module to view their birth, occupation and 
address details.
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To view a person’s details

1. Select and open the person.
See “Selecting people” on page 127.
The person’s Details tab displays the following data:

 Birth details

 Occupation

 Addresses

 Postal address file setting

 Shared by (other people or corporations who share the same address in 
MYOB AE/AO)

 Additional Notes.

2. Click Change details on the Task Bar if you want to change the selected person’s 
Birth details, Occupation or Additional notes.
See “Changing people details” on page 130. 

3. Click Change postal address file setting on the Task Bar if you want to change 
the setting for the postal address file (PAF). 
See “Changing postal address file settings for people” on page 132.

4. To change a person’s Name or Address, enter the details from MYOB AE/AO, 
then notify ASIC of the change.
See “Notifying ASIC of changes to names or addresses” on page 139.

5. Click Close. 
You will return to the People selection list.

Related topics
People
Changing people details
Changing postal address file settings for people
Adding people
Deleting people

Adding people

People are added to AE/AO-integrated Corporate Compliance using File > New on the 
MYOB AE/AO main menu. For example:

File > New > Client… 
File > New > Contact… 
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These selections open the appropriate MYOB AE/AO wizards (Add New Client and 
Add New Contact).

Once the person has been added, use their Corporate Compliance tab to add them 
to Corporate Compliance.

To add people via MYOB AE/AO

1. Open MYOB AE/AO and log in.

2. From the MYOB AE/AO main menu, select one of:

 File > New > Client… 

 File > New > Contact… 
The appropriate wizard opens, ready for you to add the new person.

3. Press F1 to open the help topic for this wizard.

4. Complete the steps until the person has been added.

5. Click Finish.
This person’s appropriate page type opens. For example, the person’s Client 
page or Contact page.

6. Click the Corporate Compliance tab to reveal its contents.
The page contains a link to Corporate Compliance.

7. Click the link Click here to add this contact to Corporate Compliance.
Corporate Compliance opens at the main People selection list, with the new 
contact’s name highlighted.
Press [Enter] to open their individual Person page, which contains the following 
tabs:

 Details

 Positions held

 Shares & Units Held

 Name History

 Address History.

8. Click a tab to reveal its contents, then press F1 to open that tab’s help page.

9. Follow the help instructions.

10. When finished, click Close to save your changes and close the page.
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Related topics
Adding people
Using Corporate Compliance
People
Viewing people details
Changing people details
Deleting people

Changing people details

MYOB AE/AO-integrated Corporate Compliance allows you to add/amend only the 
person’s birth details (City, State and Country only), and their occupation. You can 
also add notes. Other changes to the Details, such as addresses, must be made using 
MYOB AE/AO.

After you have changed a person’s name or residential address in MYOB AE/AO, and 
returned to Corporate Compliance, you are prompted to notify ASIC (see “Notifying 
ASIC of changes to names or addresses” on page 139). You can generate the form 
after running this wizard, or at a later time. If you choose a later time, the Notify ASIC 
of changes to Names or Addresses form will include the latest information entered 
using the wizard.

To change a person’s details

1. Select and open the person.
See “Selecting people” on page 127.

2. Click Change details on the Task Bar.

3. Make any changes required to the person’s birth details (City, State and Country 
only).

4. Add or change their occupation.

5. Add notes, if necessary.

6. Click Close when finished.

7. To make other changes (e.g., address details):

a. Open the person’s contact page in MYOB AE/AO at the Addresses tab.

b. Press F1 to open the appropriate help page.

c. Follow the directions in the help topic to make your changes.
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Changing addresses

Changes to addresses in MYOB AE/AO-integrated Corporate Compliance are made 
using MYOB AE/AO.

To add or change people’s addresses

1. Open the contact’s Contact or Client page in MYOB AE/AO.

2. Click the Addresses tab, then press F1 to open the appropriate help topic.

3. Add or change addresses as required, and click Save.

4. Click the Corporate Compliance tab in MYOB AE/AO.

5. Click Open Person to open Corporate Compliance.
The contact’s address changes will display any relevant ASIC form names on the 
Name and address changes from AE / Name and address changes from AO 
screen.

6. Select the first form and click Generate form on the Task Bar.
Or, if the change was only a database correction, click Delete task on the Task 
Bar.
See “Working with ASIC forms” on page 170 for more details.

Related topics
Adding people
Using Corporate Compliance
People
Viewing people details
Address sharing
Deleting people
ASIC Forms

Address sharing 

All changes to addresses in MYOB AE/AO-integrated Corporate Compliance are made 
using MYOB AE/AO.

To share a person’s address via MYOB AE/AO

1. Open the contact’s Contact or Client page in MYOB AE/AO.

2. Click the Addresses tab, then press F1 to open the MYOB AE/AO help. 
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In the help, navigate to Client or Contact page > Addresses tab and select the 
procedure you require from the list.

3. Complete the steps as per the help, and click Save, Close.

4. Click the contact’s Corporate Compliance tab, then click Open Person to return 
to the contact’s Corporate Compliance Person page.

Related topics
Adding people
Using Corporate Compliance
People
Viewing people details
Changing people details
Changing postal address file settings for people
Deleting people

Changing postal address file settings for people

The Change Postal Address File Setting screen allows you to exempt a selected 
person from the Postal Address File (PAF) check by ASIC. 

The PAF setting applies to residential addresses only, not to postal addresses.

To exempt an address from the PAF check

1. Select and open the person.
See “Selecting people” on page 127.
The Details tab opens.

2. Click Change postal address file setting on the Task Bar or right-click the 
Addresses screen and select Change postal address file setting from the menu.
The Change Postal Address File Setting screen opens

3. Select Residential address does not meet Postal Address File rules, and click 
OK.
The line, “Residential address does not meet Postal Address File rules”, is added 
below the relevant address.

Tip: You can reverse this setting using the same steps above and then 
deselecting Residential address does not meet Postal Address File.
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Related topics
People
Viewing people details

Deleting former addresses

You can delete a person’s former addresses using the Address history screen.

To delete a former address

1. Select and open the person.
See “Selecting people” on page 127.
The Details tab opens.

2. Click the Address history tab.
The Address history screen opens.

3. Select the address you want to delete.

4. Click Delete former address on the Task Bar, or right-click the address and select 
Delete former address from the menu.
A message box asks if you are sure you want to delete this address from the 
history.

5. Click OK.
The former address is deleted from the Address history screen.

Related topics
Address history
Notifying ASIC of changes to names or addresses
People

Deleting people

You can delete people from the People selection list. 

Note: If the person is a current or former officer, member or auditor for one or more 
companies, that person’s record cannot be deleted.

To delete people

1. Select and open the person.
See “Selecting people” on page 127.



People

MYOB AO Corporate Compliance | Version 3.0 User Guide | 134

2. Right-click the record in the selection list and select Delete person from the 
menu.
A message box asks if you are sure you want to delete this person.

3. To delete the record, click Yes. 
If the person:

 is a current or former officer, member or auditor of any company, a 
message will tell you that you could not delete this person, with a reason 
for not being able to delete the record. 

Click OK to close the message.

The person is not deleted.

or,

 is not a current or former officer, member or auditor of any company, the 
person and their addresses is deleted.

Related topics
Using Corporate Compliance
People
Adding people
Viewing people details
Changing people details

Positions held

You can view the following for the selected person from the Positions Held screen:

 Name of the company

 Position held

 Date appointed

 Date ceased.

You can also cease all positions held by the selected person from this screen (see 
“Ceasing all positions held” on page 135).

To view positions held

1. Select and open the person.
See “Selecting people” on page 127.
The Details tab opens.

2. Click the Positions held tab.
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The Positions held screen opens. 

3. To view all formerly and currently held positions by the selected person, select 
 Include former positions held.

4. To return to the People selection list, click Close.

Related topics
People
Ceasing all positions held
Officers

Ceasing all positions held

The Cease all positions wizard is used to cease all positions held by the selected 
person.

To cease all positions held

1. Select and open the person.
See “Selecting people” on page 127.

2. Click Cease all positions on the Task Bar.

3. Enter the Date of ceasing or select the date from the drop-down calendar. 

4. Enter the Date of notice or select the date from the drop-down calendar. 

5. Select the Reason for ceasing (optional) from the drop-down list.

6. Click Next.
The ASIC documents window opens.

7. Select the ASIC documents you need to produce:

 ASIC Form 484 – change to officeholders 

The Signing officers screen lists companies affected by the change, and the 
signing officer. An ASIC form will be produced for each company listed.

To change the signing officer or the date signed, click Edit details. 

The Edit signing officer screen opens. 

Make your changes.

Click Next.

 ASIC Form 270 – notification by officeholder of resignation or retirement 

Click Next. Go to the next step.
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 Minutes of directors’ meeting 

The Meeting details screen opens.

Enter the Date and Time of Meeting and the time the Meeting Closed.

Choose an option for where the meeting was Held.

Select a Chairperson from the drop-down list.

Select the Officers present.

Click Next.

 Officer’s notice of resignation 

Click Next. Go to the next step.

 If you do not select to produce any ASIC documents:

Click Next. 

The Finish screen opens. 

Click Finish.

 If you did select to produce ASIC documents, select the forms you need to 
preview.

8. Click Finish.

9. If you selected forms to preview, they will display on the Print preview screen 
(see “Previewing forms and documents” on page 40).
If you did not select forms to preview, the ASIC Forms Validation screen will 
display.

10. Lodge the form (see “Forms lodgement” on page 182).

Related topics
People
Positions held
Officers

Shares held

The Shares Held screen displays all shares that are currently, and were previously, 
held by the selected person. The list displays:

 Company

 Share class

 Number held

 Certificate number
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 Beneficially owned

 Jointly held

 Date.

The Shares Held screen also has an  Include former holdings checkbox for viewing 
both current and former shareholdings.

For people who are members of corporations that are limited by guarantee, only the 
following details display:

 Company name and code

 Date when the person became a member.

The share columns are blank.

To return to the People selection list, click Close.

Related topics
People
Capital
Members

Name history

The Name History screen displays the following data relating to the selected person’s 
former names:

 Former name

 Date changed.

A former name is added to the Name history screen when a person’s name is changed 
and ASIC is notified of the change (see “Notifying ASIC of changes to names or 
addresses” on page 139). You can also add former names independently of this 
process.

To view former names

1. Select and open the person.
See “Selecting people” on page 127.
The Details tab opens.

2. Click the Name history tab.
The Name history screen opens. 

3. From this screen you can:

 Add former names (see “Adding former names” on page 138)
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 Change former names (see “Changing former names” on page 146)

 Delete former names (see “Deleting former names of people” on page 147).

4. To return to the People selection list, click Close.

Related topics
People
Adding former names
Changing former names
Deleting former names of people
Notifying ASIC of changes to names or addresses

Adding former names

When a person’s name is changedin MYOB AE/AO, ASIC is notified of the change (see 
“Notifying ASIC of changes to names or addresses” on page 139), and the person’s 
former name is entered into the Name history screen.

You can also add a person’s former name using the Name history screen. And you can 
change or delete former names.

To add former names

1. Select and open the person.
See “Selecting people” on page 127.
The Details tab opens.

2. Click the Name History tab.
The Name History screen opens.

3. Click Add former name on the Task Bar, or right-click the Name history tab and 
select Add former name from the menu.
The Add name for <person’s name> screen opens.

4. Enter the Former given names.

5. Enter the Former surname.

6. Enter the Date of change or select the date from the drop-down calendar.

7. Click OK.
The former name is added to the Name history screen.
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Related topics
People
Name history
Changing former names
Deleting former names of people
Notifying ASIC of changes to names or addresses

Notifying ASIC of changes to names or addresses

The Notify change of name or address wizard is used to inform ASIC of changes made 
to the selected person’s name or addressusing MYOB AE/AO.

When the wizard finishes, a record of the person’s former name or address will 
display on the Name History or Address History screens (see “Name history” on 
page 137, and “Address history” on page 147).

To notify of changes to a person’s name and address using People

1. Select and open the person.
See “Selecting people” on page 127.
The Details tab opens.

2. Select Notify change of name and address on the Task Bar. 
The Notify change of name or address for <person’s name> wizard opens.

Note: Most of the wizard screens have Back, Next and Cancel buttons. 
The following assumes that you will continue through the steps, but 
you can also revise earlier screens (using Back), or Cancel the 
process.

3. Select  Notify change of name and/or  Notify change of address.

4. Click Next.
The Change of Person’s name screen will display the New name, Former name 
and a blank Date of name change. 

5. Enter the Date of name change or select the date from the drop-down calendar, 
and click Next.
The Change of Person’s address screen will display the New address, Former 
address and a blank Date of address change. 

6. Select Address does not meet the Postal Address File rules, if you know the 
address is correct and do not want to run the ASIC check process.

7. Click Next.
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Note: If this address is that of an Officer, and it is shared, the Officers 
affected screen will list all officers (including this person) who share 
that address. All those listed will be required to notify ASIC.

The Selection Documents screen lists all the documents required. Documents 
that are not relevant to this situation may also be listed, but are unavailable 
(greyed out).

8. Click Next after selecting the appropriate document checkboxes.
The Notify ASIC for affected companies screen will list all companies affected by 
this change, each with a checkbox which allows you to create an ASIC form. 

9. Select the checkbox to create the form for each company and click Next.
The Signing officers screen lists each company affected, with columns for the 
Company, Signing officer and Date signed, and a checkbox under In response to 
company statement.

10. Click Change details.
The Change signing details screen opens.

11. If necessary, enter a different Date signed or select one from the drop-down 
calendar.

12. Select the Signing officer from the drop-down

13. If relevant, indicate if this form is being generated in response to a company 
statement (as required for Form 484C).

14. Click OK.

15. Review the Signing officers screen and click Next to open the Finish screen.

16. Review the Finish screen and click Finish if satisfied.
The Forms Completion Report screen lists the required report to be sent to 
ASIC. 

17. Click the first form listed in Preview items (under the Forms Completion Report) 
to open it in the main window.

18. Use the tools at the top to Save, Print, Page Left, Page Right, Find text in the 
document, or Zoom in/out.

or,
Click Select to open a Print selection screen to select all or part of the list of 
documents for printing.
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or,
Click Print All.
or, 
Click Save with… to open the Document Manager options screen.
Make your selections and click OK to open MYOB Document Manager.
See the Document Manager help for further details.

19. Complete and lodge the formwith ASIC (see “ASIC forms in progress” on 
page 174 and “Forms lodgement” on page 182).

20. Click Close when finished.

Note: If an address is shared with other people or corporations, a series of shared 
address screens will open. Go to “If an address is shared” on page 145 for 
instructions.

To notify of changes to a person’s name using People

1. Select and open the person.
See “Selecting people” on page 127.
The Details tab opens.

2. Select Notify change of name and address on the Task Bar. 
The Notify change of name or address for <person’s name> wizard opens.

Note: Most of the wizard screens have Back, Next and Cancel buttons. 
The following assumes that you will continue through the steps, but 
you can also revise earlier screens (using Back), or Cancel the 
process.

3. Click Next.
The Change of Person’s name screen will display the New name, Former name 
and a blank Date of name change. 

4. Enter the Date of name change or select the date from the drop-down calendar, 
and click Next.
The Change of Person’s name screen will display the New name, Former name 
and a blank Date of name change field. 

5. Enter or select the Date of name change. 

6. Click Next.
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The Selection Documents screen lists all the documents required. Documents 
that are not relevant to this situation may also be listed, but are unavailable 
(greyed out).

7. Click Next after selecting the appropriate document checkboxes.
The Notify ASIC for affected companies screen will list all companies affected by 
this change, plus a checkbox which allows you to create an ASIC form. 

8. Select  Create ASIC form or document? to create the form for each company, 
and click F.
The Signing officers screen lists each company affected, with columns for the 
Company, Signing officer and Date signed, and a checkbox under In response to 
company statement.

9. Click Change details.
The Change signing details screen opens.

10. If necessary, enter a different Date signed or select one from the drop-down 
calendar.

11. Select the Signing officer from the drop-down

12. If relevant, indicate if this form is being generated In response to a company 
statement (as required for Form 484C).

13. Click OK.
The Change signing details screen opens.

14. Review the Signing officers screen and click Next to open the Finish screen.

15. Review the Finish screen and click Finish if satisfied.
The Forms Completion Report screen lists the required report to be sent to 
ASIC. 

16. Click the first form listed in Preview items (under the Forms Completion Report) 
to open it in the main window.

17. Use the tools at the top to Save, Print, Page Left, Page Right, Find text in the 
document, or Zoom in/out.

or,
Click Select to open a Print selection screen to select all or part of the list of 
documents for printing.
or,
Click Print All.
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or, 
Click Save with… to open the Document Manager options screen.
Make your selections and click OK to open MYOB Document Manager.
See the Document Manager help for further details.

18. Complete and lodge the form with ASIC (see “ASIC forms in progress” on 
page 174 and “Forms lodgement” on page 182).

19. Click Close when finished.

Note: If an address is shared with other people or corporations, a series of shared 
address screens will open. Go to “If an address is shared” on page 145 for 
instructions.

To notify of changes to a person’s address using People

1. Select and open the person.
See “Selecting people” on page 127.
The Details tab opens.

2. Select Notify change of name and address on the Task Bar. 
The Notify change of name or address for <person’s name> wizard opens.

Note: Most of the wizard screens have Back, Next and Cancel buttons. 
The following assumes that you will continue through the steps, but 
you can also revise earlier screens (using Back), or Cancel the 
process.

3. Click Next.
The Change of Person’s address screen will display the New address, Former 
address and a blank Date of name change. 

4. Enter the Date of address change or select the date from the drop-down 
calendar.

5. Click Next.
The Selection Documents screen lists all the documents required. Documents 
that are not relevant to this situation may also be listed, but are unavailable 
(greyed out).

6. Click Next after selecting the appropriate document checkboxes.
The Notify ASIC for affected companies screen will list all companies affected by 
this change, plus a checkbox which allows you to create an ASIC form. 
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7. Select  Create ASIC form or document? to create the form for each company, 
and click Next.
The Signing officers screen lists each company affected, with columns for the 
Company, Signing officer and Date signed, and a checkbox under In response to 
company statement.

8. Click Change details.
The Change signing details screen opens.

9. If necessary, enter a different Date signed or select one from the drop-down 
calendar.

10. Select the Signing officer from the drop-down

11. If relevant, indicate that this form is being generated In response to a company 
statement (as required for Form 484C).

12. Click OK.
The Change signing details screen closes.

13. Review the Signing officers screen and click Next to open the Finish screen.

14. Review the Finish screen and click Finish if satisfied.
The Forms Completion Report screen lists the required reportto be sent to ASIC. 

15. Click the first form listed in Preview items (under the Forms Completion Report) 
to open it in the main window.

16. Use the tools at the top to Save, Print, Page Left, Page Right, Find text in the 
document, or Zoom in/out.

or,
Click Select to open a Print selection screen to select all or part of the list of 
documents
or,
Click Print All.
or, 
Click Select to open a Print selection screen to select all or part of the list of 
documents for printing.

17. Complete and lodge the form(s) with ASIC (see “ASIC forms in progress” on 
page 174 and “Forms lodgement” on page 182).

18. Click Close when finished.
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Note: If an address is shared with other people or corporations, a series of shared 
address screens will open. Go to “If an address is shared” on page 145 for 
instructions.

If an address is shared

If the address is shared by other corporations, officers and/or membersin MYOB AE/
AO, up to three screens will display listing the shared addresses affected by the 
change of address.

To change these shared addresses and generate ASIC forms for each of them, proceed 
to the next Step.

To not proceed with the changes to these shared addresses, click Cancel and un-share 
the address for each recordin MYOB AE/AO. Then restart this wizard.

1. Click Next.
The Select the documents you wish to produce screen opens.

2. Select the documents you need. 

3. Click Next.
The Enter signing officers and date screen displays with all companies that are 
affected by the change.

4. Select each company effected by the change.

5. Click Change details on the Task Bar.
The Change signing officer screen opens.

6. Select the Signing officer from the drop-down list.

7. Enter the Date signed or select the date from the drop-down calendar.
If relevant, indicate if this form is being generated In response to a company 
statement (as required for Form 484C).

8. Click OK.

9. Click Next.
The Finish screen opens.

10. Select the documents you need to preview (e.g., Form 484 Notification of 
change of name or address).

11. Click Finish.
If you selected to preview documents in the previous screen, they open from 
the Print preview screen (see “Previewing forms and documents” on page 40).



People

MYOB AO Corporate Compliance | Version 3.0 User Guide | 146

If you did not select to preview documents, the ASIC Form Validation screen 
opens.

12. Complete and lodge the forms with ASIC (see “ASIC forms in progress” on 
page 174 and “Forms lodgement” on page 182).

Related topics
Address history
People

Changing former names

You can change a person’s former names from the Name history screen. Former 
names can also be added (see “Adding former names” on page 138) or deleted from 
this screen (see “Deleting former names of people” on page 147). 

If you need to inform ASIC of the person’s change of name, change the namein MYOB 
AE/AO, then notify ASIC of the change (see “Notifying ASIC of changes to names or 
addresses” on page 139).

To change former names

1. Select and open the person.
See “Selecting people” on page 127.
The Details tab opens.

2. Click the Name history tab.
The Name history screen opens.

3. Select the name you want to change.

4. Click Change former name on the Task Bar, or right-click the name and select 
Change former name from the menu.
The Change former name for <person’s name> screen opens.

5. Change the Former given names, Former surname or Date of change, as 
required.

6. Click OK.
The former name is changed on the Name history screen.

Related topics
People
Name history
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Adding former names
Deleting former names of people
Notifying ASIC of changes to names or addresses

Deleting former names of people

You can delete a person’s former names from the Name history screen. Former 
names can also be added or changed using this screen (see“Adding former names” 
on page 138 or “Changing former names” on page 146). 

To delete former names

1. Select and open the person.
See “Selecting people” on page 127.
The Details tab opens.

2. Click the Name History tab.
The Name History screen opens.

3. Select the name you want to delete.

4. Click Delete former name on the Task Bar, or right-click the name and select 
Delete former name from the menu.
A message box asks if you are sure you want to delete this name from the 
history.

5. Click OK.
The former name is deleted from the Name history screen.

Related topics
People
Name history
Adding former names
Changing former names
Notifying ASIC of changes to names or addresses

Address history

The Address history screen opens the following about the selected person’s former 
addresses:

 Former address

 Date ceased.
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A former address is added to the Address history screen when an ASIC form 484 is 
generated (see “Notifying ASIC of changes to names or addresses” on page 139.)

You can also delete former addresses from the Address history screen (see “Deleting 
former addresses” on page 133).

To view former addresses

1. Select and open the person.
See “Selecting people” on page 127.
The Details tab opens.

2. Click the Address History tab.
The Address history screen is an historical list, sorted by Date ceased. You can 
also sort by the other columns.

Tip: From here you can delete former addresses (see “Deleting former 
addresses” on page 133).

3. To return to the People selection list, click Close.

Related topics
Deleting former addresses
Notifying ASIC of changes to names or addresses
People
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Company statements
The Company Statements module opens all company statements (ASIC Form 480) 
that your practice has received from ASIC (see “Receiving forms from ASIC” on 
page 185). 

Company statements have the following columns:

 Corporation

 Code (from MYOB AE/AO)

 Review Date (annual date for the review of the corporation’s details)

 Payment Due Date (due date for payment of the annual invoice, which is within 
two months of the review date)

 ASIC Forms in Progress (if there are any forms that have been drafted and 
awaiting lodgement, as listed in the In Progress list in the ASIC Forms module)

 Status (as set on the Change Status screen)

 Date Received (date that the company statement and invoice was downloaded 
from ASIC).

The Company Statements list has options to filter the list of statements displayed. 
You can select to view the list by:

 Date received

and/or

 Company statement status.

From the Company Statements screen you can also:

 Process your company statements (see “To process company statements 
received” on page 150), so that you can pay the annual review fee and make any 
corrections to company data on time.

 View company statements (see “Viewing company statements” on page 153)

 View ASIC invoices received (see “Viewing ASIC invoices received” on page 164) 

 View ASIC invoice forms (see “Viewing ASIC invoiced forms” on page 164)

 View current company details (see “Viewing corporation details” on page 20).

In summary, a company statement is processed as per the table below (see “To view 
company statements in Corporate Compliance” on page 153):

Task Status Due date See below

1 Receive company 
statement 

(Two months before 
review date)

Step 1.
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To process company statements received

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed (see “Receiving forms 
from ASIC” on page 185).

2. View the company statement you want to see (see “Viewing company 
statements” on page 153). 
The Print preview screen opens.

3. Click  (Print Report).
The Windows Print dialog opens.

4. Click OK to print.

5. Click Close to redisplay the Company statements screen.

6. View the company details, as entered in Corporate Compliance.
See “Viewing corporation details” on page 20.

7. Repeat Step 3. to Step 5.

8. Compare the company statement with the company’s current details (in the 
corporation detailed report) as they appear in Corporate Compliance.
Select one of the following:

a. If you find differences between the company statement and the company’s 
data in Corporate Compliance:

2 Compare data in 
company statement 
with data in Corporate 
Compliance
If necessary, advise ASIC 
of changes

Within 28 days of issue 
of company statement

Step 2. to Step 10.

3 Make solvency 
resolution or lodge 
Form 485 Company 
Solvency form with ASIC

Within two months of 
review date

4 Pay annual review fee Within two months of 
review date

Step 11. to 
Step 12.

Task Status Due date See below
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Enter the changes in an ASIC form using one of the workflow wizards (see 
“Workflow wizards” on page 168). Ensure that you mark the form as being 
in response to a company statement when you complete the wizard.

Print the form from the ASIC Forms module. (Click View form and print it 
from the Print preview screen.)

Send the following documents to the company:

— ASIC form: request that the signed form be returned within 28 days of 
the company statement’s date of issue

— company statement invoice: request that payment be sent to you and 
that a solvency resolution be made within two months of the review date.

If the company is not able to make a resolution in relation to its solvency, or 
it fails to do so on time, it must lodge ASIC Form 485 (not yet supported in 
Corporate Compliance).

b. If you do not find differences between the company statement and the 
company’s data:

Send the following documents to the company:

— printed company statement: request that the data be confirmed or 
changed within about 14 days of the date of issue of the company 
statement. (If corrections need to be made to the company’s data, see 
Step 10.a.) 

— company statement invoice: request that payment be sent to you and 
that a solvency resolution be made within two months of the review date.

If the company is not able to make a resolution in relation to its solvency, or 
it fails to do so on time, it must lodge ASIC Form 485 (not yet supported in 
Corporate Compliance).

9. Change the status of the company statement to Statement sent to client.
See “Changing the status of company statements” on page 156.

10. Select one of the following:

a. If the client advises that the ASIC data is not correct:

Change the status of the company statement to Changes to be notified.

Enter the changes into a form using a workflow wizard.

Send the form to the client for signing, and advise them that the changes 
must be lodged with ASIC within 28 days of the company statement issue 
date.

When you receive the signed form, lodge it with ASIC.

Change the status of the form to Changes form lodged.
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b. If the client confirm that the company statement is correct, proceed to the 
next step.

11. When you receive the annual review fee from the client, forward the payment 
to ASIC within two months of the review date.

Note: Payment of the annual review fee indicates that the company has 
made a solvency resolution within two months of the review date. 
If the company is not able to make resolution in relation to its 
solvency, or it fails to do so on time, it must lodge ASIC Form 485.

12. Change the status of the company statement to Invoice paid.
See “Changing the status of company statements” on page 156.
Processing of the company statement is now complete.

Related topics
Changing the status of company statements
Viewing ASIC invoices received

Working with company statements

See the following for detailed instructions about using the Company Statements 
module:

 “Viewing company statements” (see page 153)

 “Viewing and creating client letters” (see page 154)

 “Viewing solvency resolutions” (see page 155)

 “Changing the status of company statements” (see page 156)

 “Matching unknown company statements” (see page 158)

 “Archiving company statements” (see page 158)

 “Comparing statements with current details” (see page 160) 

 “Notifying company solvency” (see page 161)

 “Printing company statement lists” (see page 162)

 “Saving a company statement to MYOB Document Manager” on page 163.

Related topics
Working with ASIC invoices
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Viewing company statements

You must have Adobe Reader installed on your system to open company statements 
from ASIC.

You can download the latest Reader from Adobe.com for free.

To view company statements in Corporate Compliance

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed on the Company 
Statements tab.

2. Double-click the company statement in the list or select it and click View 
statement on the Task Bar.
The company statement received from ASIC displays on the Print preview 
screen (see “Previewing forms and documents” on page 40).

To view company statements in MYOB AE

1. Click Corporate on the MYOB AE/AO toolbar
or
Select Corporate > Company Statements on the MYOB AE/AO toolbar.
The Company statements page opens.

2. Select the agent from the Show corporations for agent: drop-down.

3. Select to show corporations with either:

 company statements in progress, or

 company statements due from a specified date but not yet received from 
ASIC.

4. The corporations that match the criteria you enter are shown on the page.

5. Click the Corporation name in the list to open the details in Corporate 
Compliance.

6. Click the Client code in the list to open the Corporate Compliance tab on the 
Client page in MYOB AE/AO.

Related topics
Viewing and creating client letters
Viewing solvency resolutions
Changing the status of company statements
Matching unknown company statements
Archiving company statements

http://www.adobe.com
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Comparing statements with current details
Notifying company solvency
Printing company statement lists
Saving a company statement to MYOB Document Manager

Viewing and creating client letters

You may want to include covering letters with company statements sent to your 
clients. The letter will include details of the invoice and any changes that may be 
required.

To view and create the client letter

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed on the Company 
Statements tab.

2. Select the required statement in the list.

3. Click View client letter on the Task Bar.
If you have already created a client letter for this Statement, the client letter 
displays.
If you have not created a client letter for this Statement, the Client letter 
window opens.

4. Select the required format for the client letter:

 No changes to the company statement are required

This template is used when data received is correct and the client is 
required to check the statement and pay the invoice.

or

 Changes to be notified to ASIC

This template is used when the agent has identified that the Company 
Statement is incorrect and a Form 484 to notify the changes must also be 
lodged.

5. Enter the name of the agent who is to sign the client letter in the Signed By field.

6. Enter the Date or use the drop-down calendar.

7. Click OK to display the Client Letter.

8. To edit the letter, click Edit, make your changes, click Save then Close.

9. To print, click Print.
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Related topics
Viewing company statements
Viewing solvency resolutions
Changing the status of company statements
Matching unknown company statements
Archiving company statements
Comparing statements with current details
Notifying company solvency
Printing company statement lists
Saving a company statement to MYOB Document Manager

Viewing solvency resolutions

When a corporation pays their review fee by the end of the two month period after 
the company’s review date, there are reasonable grounds to believe that the 
company will be able to pay its debts, as and when they become due and payable.

If the directors have met and resolved that the company is solvent, the minutes of the 
resolution are produced. 

If the directors have met and resolved that the company is not solvent, or if the 
directors have not met and made any resolution as to the solvency of the company, 
the company must lodge Form 485 — Statement in relation to Company Solvency as 
part of this review process.

To view/create a solvency resolution

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed on the Company 
Statements tab.

2. Click the required Company Statement in the list.

3. Click View Solvency Resolution on the Task Bar.

 If you have not previously created a Solvency Resolution for this Statement, 
a window will list all current officers of the corporation.

Select the officers who are to sign the Statement of Solvency and click OK to 
display the Statement of Solvency.

 If you have previously created a Solvency Resolution for this Statement, the 
Solvency Resolution will display automatically.

4. Click Print.
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Related topics
Viewing company statements
Viewing and creating client letters
Changing the status of company statements
Matching unknown company statements
Archiving company statements
Comparing statements with current details
Notifying company solvency
Printing company statement lists
Saving a company statement to MYOB Document Manager

Changing the status of company statements

Use the Company Statements > Change status screen to track the progress of each 
corporation’s annual review by applying statuses to each Company Statement, as 
explained below:

Step Status Processing Stage Action

1 Statement sent 
to client

You have sent the 
company statement to 
the client for review 
and payment of the 
annual review fee.

Await confirmation of 
data in company 
statement and 
payment of annual 
review fee.

2
(optional)

Changes to be 
notified

You have received 
advice from the client 
that the data in the 
company statement 
has been reviewed and 
needs to be corrected.

Enter changes in a form 
to advise ASIC of the 
changes, using a 
workflow wizard. Send 
to client for signing. 
The form must be 
lodged with ASIC within 
28 days of the company 
statement issue date.

3
(optional)

Changes form 
lodged

You have received the 
signed form from the 
client and lodged the 
form with ASIC.

If payment of the 
annual review fee has 
not been received, 
remind the client that it 
must be paid within 
two months of the 
review date.
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Tip: After applying a status to each company statement, prioritise (or sort) each 
document by clicking the Status column heading. 

To change the status of a company statement

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed on the Company 
Statements tab.

2. Click the required Company Statement in the list.

3. Click View solvency resolution on the Task Bar.

4. Click Change status on the Task Bar.
The Change status screen opens.

5. Select a status from the drop-down list.

6. Enter a date for the status change and click OK.

Related topics
Viewing company statements
Viewing and creating client letters
Viewing solvency resolutions
Matching unknown company statements
Archiving company statements
Comparing statements with current details
Notifying company solvency
Printing company statement lists
Saving a company statement to MYOB Document Manager

4 Invoice paid You have received 
payment for the annual 
review fee.

Forward payment for 
the annual review fee 
(due within two 
months of the review 
date).

Step Status Processing Stage Action
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Matching unknown company statements

When a Company Statement is received from ASIC with an ACN that does not match 
the ACN of any company in your Corporate Compliance database, it will display as 
Unknown company in the Company Statements list.

If you have only recently added this company to your Corporate Compliance 
database, use Company Statements > Match unknown companies to link the 
statement received to the correct company.

To link an “unknown company” to the correct company

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed on the Company 
Statements tab.

2. Click the required Company Statement in the list.

3. Click Match unknown companies on the Task Bar.
Corporate Compliance will search for a match, then a message will list the total 
number of company statements matched and unmatched.

4. Click OK to close the message.

Related topics
Viewing company statements
Viewing and creating client letters
Viewing solvency resolutions
Changing the status of company statements
Archiving company statements
Comparing statements with current details
Notifying company solvency
Printing company statement lists
Saving a company statement to MYOB Document Manager

Archiving company statements

Use the Company Statements module to archive company statements from the list. 
You can optionally archive a selected company statement, or archive a group of 
company statements, based on the status and the review date.

Company Statements must have either the Invoice paid or Statement received back 
from client status to be archived.

Archived company statements can still be viewed from the Documents tab of the 
corporation.
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To archive a single company statement

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed on the Company 
Statements tab.

2. Click the required Company Statement in the list.

3. Click Archive company statement on the Task Bar.

4. Click Yes when you see the confirmation message.

To archive multiple company statements

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed on the Company 
Statements tab.

2. Click the required Company Statement in the list.

3. Click Archive multiple statements on the Task Bar.
The Archive multiple statements screen opens.

4. Select the appropriate status of the Company Statements that you want to 
archive from: 

 Invoice paid 

 Statement received back from client 

 Invoice paid or Statement received back from client 

 Migrated from CSS.

5. Enter the review date of the company statements to be archived. 
Only company statements with a review date on or before this date will be 
archived.

6. Click OK.

7. Click Yes when you see the confirmation message.
A message will tell you how many Company Statements have been archived.

8. Click OK.

Related topics
Viewing company statements
Viewing and creating client letters
Viewing solvency resolutions
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Changing the status of company statements
Matching unknown company statements
Comparing statements with current details
Notifying company solvency
Printing company statement lists
Saving a company statement to MYOB Document Manager

Comparing statements with current details

You can compare selected statements against the current company details and 
produce a report that indicates the differences.

To compare statements with current details

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed on the Company 
Statements tab.

2. Click the required Company Statement in the list.

3. Click Compare statements to current details on the Task Bar.
The Compare statements to current details screen opens.

4. Select one or more options to determine the data comparison rules for the 
comparison report.

5. Click OK.
A Company Statement Comparison Report for each selected statement displays 
on the Print Preview screen.

6. Click Close.
To exit the report and return to the Company Statements selection list.

Related topics
Viewing company statements
Viewing and creating client letters
Viewing solvency resolutions
Changing the status of company statements
Matching unknown company statements
Archiving company statements
Notifying company solvency
Printing company statement lists
Saving a company statement to MYOB Document Manager
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Notifying company solvency

The Notify company solvency wizard leads you through the steps required to notify 
ASIC.

To notify company solvency

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed on the Company 
Statements tab.

2. Click the required Company Statement in the list.

3. Click Notify company solvency on the Task Bar.
The Notify company solvency wizard appears. The first window is for entering 
Company solvency details.

4. Select one of the following solvency resolutions.

 Negative solvency resolution passed.

Enter the Date of resolution (dd/mm/yyyy) or select the date from the 
drop-down calender.

 Solvency resolution not passed. 

5. Click Next.
The Signing details screen opens.

6. Enter the Date signed (dd/mm/yyyy) or select the date from the drop-down 
calendar. 
The date can be left blank.

7. Select the Signing officer from the drop-down list.

8. Click Next.
The Finish screen opens with Form 485 selected.

9. Click Finish.
The Forms Completion Report opens in the Print preview screen.

10. To view and/or print the report, double-click it in the Preview Items list.

11. Click Close to close the report and return to the main window.

Related topics
Viewing company statements
Viewing and creating client letters
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Viewing solvency resolutions
Changing the status of company statements
Matching unknown company statements
Archiving company statements
Comparing statements with current details
Printing company statement lists
Saving a company statement to MYOB Document Manager

Printing company statement lists

The Print Company Statement List option allows you to print a summary of all 
available company statements for a company. Filter options allow you to show/hide 
statements by status, received date, payment due date and review dates.

To print a company statement list

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed on the Company 
Statements tab.

2. Click the required Company Statement in the list.

3. Click Print company statement list on the Task Bar.
The Print company statement list screen opens.

4. Select one or more of the following options to filter the selection list.
 Show only statements received — enter the dates (dd/mm/yyyy) or select 

the dates from the drop-down calendar.
 Show only statements with review dates — enter the dates (dd/mm/yyyy) or 

select the dates from the drop-down calendar.
 Show only statements with payment due dates — enter the dates (dd/mm/

yyyy) or select the dates from the drop-down calendar.
 Show only statements with status of — select from the drop-down list of 

available company statement statuses.

5. Sort the list if necessary.

6. Click Print company statement list on the Task Bar.
A Company Statement List displays on the Print Preview screen.
This report includes all the fields as displayed on the company statement 
selection list, plus the following additional information:

 Client letter — Yes, if the company statement has an associated client 
letter. If not, No.
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 Solvency resolution — Yes, if the company statement has an associated 
solvency resolution document. If not, No.

7. Click Close to exit the report and return to the Company Statements selection 
list.

Related topics
Viewing company statements
Viewing and creating client letters
Viewing solvency resolutions
Changing the status of company statements
Matching unknown company statements
Archiving company statements
Comparing statements with current details
Notifying company solvency
Saving a company statement to MYOB Document Manager

Saving a company statement to MYOB Document Manager

For sites with MYOB Document Manager, a Company Statement can now be sent 
directly to MYOB Document Manager. 

To save a company statement to Document Manager

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed on the Company 
Statements tab.

2. Select the required company statement in the list.

3. Select Save with contact on the Task Bar.
The Document Manager Create Document Wizard opens.

4. Enter all the details for the document.

5. Click Finish.
The document is sent to Document Manager.

Related topics
Viewing company statements
Viewing and creating client letters
Viewing solvency resolutions
Changing the status of company statements
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Matching unknown company statements
Archiving company statements
Comparing statements with current details
Notifying company solvency

Working with ASIC invoices

From the ASIC Invoices tab, you can:

 View the ASIC invoiced forms (see “Viewing ASIC invoiced forms” on page 164)

 View ASIC invoices received (see “Viewing ASIC invoices received” on page 164).

Related topics
Viewing ASIC invoices received
Viewing ASIC invoiced forms
Working with company statements

Viewing ASIC invoiced forms

ASIC invoiced forms are displayed on the ASIC Invoices tab when you open the 
Company Statements module.

To view ASIC invoiced forms

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed on the Company 
Statements tab.

2. Click the ASIC Invoices tab to display the invoices.

Related topics
Viewing ASIC invoices received
Viewing ASIC invoiced forms
Working with ASIC invoices
Working with company statements

Viewing ASIC invoices received

The ASIC invoices received screen displays all ASIC invoices that the system has 
received from ASIC (e.g., for late payment). See “Receiving forms from ASIC” on 
page 185.
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To view ASIC invoices received

1. Click Company Statements on the Task Bar.
All company statements received from ASIC are listed on the Company 
Statements tab.

2. Click the ASIC Invoices tab to display the invoices.

3. Click the required invoice in the list, then either:

 Click View invoice on the Task Bar to display it (see “Previewing forms and 
documents” on page 40), or

 Click View invoiced form on the Task Bar to display the form to which the 
invoice relates.

Related topics
Viewing ASIC invoices received
Viewing ASIC invoiced forms
Working with ASIC invoices
Working with company statements
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ASIC Forms
All ASIC forms (other than forms generated from the Agents module) pass through 
the following screens after they have been generated by a workflow wizard (see 
“Workflow wizards” on page 168):

Corporate Compliance includes both electronically lodged and paper ASIC forms:

Electronically lodged forms

Action Screen

Prior to lodgement 1. ASIC Forms: In progress (see “ASIC forms in 
progress” on page 174).

2. Lodgement: Forms Lodgement (see “Forms 
lodgement” on page 182).

After lodgement 3. Lodgement: Lodgement history (see “Lodgement 
history” on page 186).

Form Title

205 — see “Changing corporation names” on 
page 49.

Notification of resolution (change 
company name)

361 — see “Ceasing acting as a registered 
agent” on page 205.

Registered agent ceasing to act for 
a company 

362 — see “Appointing and ceasing agents” 
on page 32.

Appointment or cessation of a 
registered agent by a company

370 — see “Ceasing company officers” on 
page 66.

Resignation or retirement of 
officeholder 

410 — see “Reserving corporation names” 
on page 45.

Application for reservation of 
name

484A — see “Notifying ASIC of corporate 
changes of address” on page 54.

Change to company address

484A — see “Notifying ASIC of changes to 
names or addresses” on page 139.

Change to name of company 
officeholder or member

484A — see “Holding companies” on 
page 118.

Change to ultimate holding 
company

484B — see “Officers” on page 63. Appoint company officeholder

484B — see “Ceasing company officers” on 
page 66.

Cease company officeholder

484C — see “Notifying ASIC of share issues” 
on page 78.

Issue shares
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Paper only lodged forms

484C — see “Transferring and transmitting 
shares” on page 80.

Transfer shares

484C — see “Cancelling classes of shares” on 
page 85.

Cancel shares

484C — see “Changing amounts paid to 
shares” on page 76.

Change to amounts paid for 
shares

484C — see “Changing beneficial owners” on 
page 87.

Change to beneficial ownership of 
shares

489 — see “Notifying ASIC of corporate 
changes of address” on page 54.

Change of registered office or 
office hours of a registered body

490 — see “Officers” on page 63. Change to officeholders of a 
registered body

492 — see “Amending previously lodged 
forms” on page 173.

Amendment to previously lodged 
document

6010 — see “Applying for deregistration” on 
page 37.

Voluntary deregistration of a 
company

902 — see “Amending previously lodged 
forms” on page 173.

Information supplementary to a 
form previously lodged 

RA17 — see “Requesting agent reports from 
ASIC” on page 201.

Request for data amendment 
report

RA61 — see “Requesting agent reports from 
ASIC” on page 201.

Request review date report

RA71 — see “Requesting company data from 
ASIC” on page 26.

Request for company data

Form Title

201 — see “Applying for registration” on 
page 33.

Application for registration as an 
Australian company

207Z — see “Notifying ASIC of share issues” 
on page 78.

Certification of compliance with 
stamp duty law

208 — see “Notifying ASIC of share issues” 
on page 78.

Notification of details of shares 
issued other than for cash

Form Title
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Documents received from ASIC electronically

Related topics
Workflow wizards
Lodgement

Workflow wizards

Corporate Compliance contains a number of workflow wizards which guide you 
through the process of:

 Entering data and generating ASIC forms (see “ASIC Forms” on page 166) and 
associated documents (see “Tools” on page 221).

 Requesting corporate data from ASIC (see “Requesting company data from 
ASIC” on page 26).

Form Title

480 — see “Company statements” on 
page 149.

Annual statement (company 
statement and invoice)

INV — see “Company statements” on 
page 149.

Lodgement fee invoice

RA18 — see “Agents’ ASIC form histories” on 
page 204.

Data amendment report

RA62 — see “Agents’ ASIC form histories” on 
page 204.

Review date report

RA64 — see “Requesting agent reports from 
ASIC” on page 201.

Debtor’s ledger report

RA66 — see “Requesting agent reports from 
ASIC” on page 201.

Documents lodged report

RA69 — see “Requesting agent reports from 
ASIC” on page 201.

Debtor’s ledger report

RA72 — see “Reports” on page 207. Data download

RC05 — see “Viewing ASIC invoices 
received” on page 164.

Late fee invoice

TRANS — see “Viewing transmission 
reports” on page 188.

Transmission report

VALID — see “Viewing validation reports” on 
page 188.

Validation report
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After forms are generated, they display in other Corporate Compliance screens in the 
following sequence:

1. All forms that have been generated display on the In progress screen (see “ASIC 
forms in progress” on page 174) in the ASIC Forms module (see “ASIC Forms” on 
page 166). 
Each form is allocated one of three statuses: Generated Invalid, Generated 
Unsigned or Generated Valid. 
See below for the methods used to process forms with each status.

2. Forms that have the status of Generated Valid (on the ASIC Forms screen) are 
also listed on the Forms lodgement screen of the Lodgement module, and are 
ready to be lodged with ASIC.

3. After lodgement, forms are listed on the Lodgement history screen (Lodgement 
module). They are also listed on the ASIC forms screen (Corporations module) 
and the ASIC forms history screen (Agents module).

To generate and process forms

1. Generate a form using the appropriate workflow wizard.
Move through the wizard by clicking Next. If you need to go back to change to 
data on previous screens, click Back. At the end of the wizard, click Finish.
The system will then produce the forms that you requested, and display them 
on the Print preview screen.

2. Click Validation Report.
To view the validation report (ASIC Form Status report) on the Print preview 
screen, and process the form according to which of the following applies:

 Signing details are required (Status: Generated Unsigned)

Click Close. 

Change the signing details.

Lodge the form.

 Validation errors are present (Status: Generated Invalid)

Click Close. 

Correct the errors in Corporate Compliance.

Complete the form.

Lodge the form.

 No validation errors are present (Status: Generated Valid)

Click Close.

Lodge the form.
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Related topics
ASIC Forms
ASIC forms in progress
Lodgement
Forms lodgement
Previewing forms and documents
ASIC Forms

Working with ASIC forms

This section includes information about:

 “ASIC forms history” (see page 170)

 “Printing ASIC forms history” (see page 172)

 “Amending previously lodged forms” (see page 173)

 “ASIC forms in progress” (see page 174)

 “ASIC forms validation” (see page 176)

 “Changing signing details” (see page 176)

 “Updating forms” (see page 177)

 “Forms completed but not signed” (see page 178)

 “Viewing forms” (see page 179)

 “Deleting forms” (see page 179)

 “Completing forms” (see page 180).

See also:

 “Batching forms” (see page 190)

 “Viewing and printing forms in batches” (see page 190)

 “Viewing and printing lodgement lists” (see page 192)

 “Workflow wizards” on page 168.

ASIC forms history

The ASIC Forms tab in the Corporation module displays all ASIC forms that have been 
produced after completing a workflow wizard (see “Workflow wizards” on page 168). 
These forms also display in batches on the Lodgement History screen (see 
“Lodgement history” on page 186).

For example, if the Appoint or cease officers wizard has been used to appoint an 
officer to a corporation, an ASIC form 362 will open on the ASIC Forms screen. The 



ASIC Forms

MYOB AO Corporate Compliance | Version 3.0 User Guide | 171

associated documents that are generated by completing a wizard (minutes, etc.) 
display on the corporation’s Documents screen (see “Tools” on page 221).

The forms in this screen are assigned the following statuses:

Status Description

Accepted The form has been lodged, the validation report has 
been received and ASIC has accepted the form. The 
batch it was sent in can also be viewed from the 
Lodgement history screen in the Lodgement module.
See “Lodgement history” on page 186.

Accepted — awaiting 
data

The form has been lodged and the transmission report 
has been received from ASIC. The batch it was sent in 
can also be viewed from the Lodgement history screen 
in the Lodgement module.
See “Lodgement history” on page 186.

Generated Invalid The form has been generated, but it contains an error. 
It can also be viewed from the In Progress screen in the 
ASIC Forms module. 
See “ASIC forms in progress” on page 174.

Generated Unsigned The form has been generated, but it has not yet been 
signed. It can also be viewed from the In Progress 
screen in the ASIC Forms module.
See “ASIC forms in progress” on page 174.

Generated Valid The form has been generated and it is ready to be 
lodged from the Lodgement module (see “Forms 
lodgement” on page 182). It can also be viewed from 
the In Progress screen in the ASIC Forms module. 
See “ASIC forms in progress” on page 174.

Lodged The form has been lodged with ASIC. If it was lodged 
electronically, the batch it was sent in can also be 
viewed from the Lodgement history screen in the 
Lodgement module.
See “Lodgement history” on page 186.

Lodgement Rejected The form has been lodged, the validation report has 
been received but ASIC has rejected the form. The 
batch it was sent in can also be viewed from the 
Lodgement history screen in the Lodgement module 
(see “Lodgement history” on page 186). You can then 
update the form and resend it (see “Updating forms” on 
page 177).
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To view a corporation’s generated forms

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The Details screen displays.

2. Click the ASIC Forms tab.
The ASIC Forms screen opens.

3. Select a document from the list and click one of the following options on the 
Task bar:

 View form (see “To view a form for an individual corporation” on page 179)

 Delete form (see “Deleting ASIC forms” on page 191)

 Print forms list (see “Printing ASIC forms history” on page 172)

 Amendment to previously lodged form (see “Amending previously lodged 
forms” on page 173).

4. To return to the Corporations selection list, click Close.

Related topics
Corporations
Amending previously lodged forms
ASIC Forms
Lodgement
Corporations
Updating forms

Printing ASIC forms history

To print ASIC forms history

1. Select and open the corporation.

Migrated The form has been migrated from CSS.

Received form The form has been received from ASIC.
See “Receiving forms from ASIC” on page 185.

Rejected, re-
generated

Having been previously rejected by ASIC, the form has 
been updated and lodged again.

Status Description



ASIC Forms

MYOB AO Corporate Compliance | Version 3.0 User Guide | 173

See “Selecting a corporation” on page 21.
The Details screen displays.

2. Click the ASIC Forms tab.
The ASIC Forms screen opens. 

3. Select the form and click Print forms list on the Task Bar.
The form displays on the Print preview screen (see “Previewing forms and 
documents” on page 40).

4. Click Print .

5. Click OK.

Amending previously lodged forms

The Amendment to previously lodged form wizard is used to:

 Submit corrections to a previously lodged form (ASIC form 492)

 Respond to requisitions from ASIC (ASIC form 902).

To amend a previously lodged form

1. Obtain the form’s Document Trace Number by viewing the footer of the form 
(see “To view a form for an individual corporation” on page 179) or by viewing 
the form’s validation report (in the Lodgement module).

2. Select and open the corporation.
See “Selecting a corporation” on page 21.

3. The Details screen displays.

4. Click the ASIC Forms tab.
The ASIC Forms screen opens.

5. Select the form in the list, then click Amendment to previously lodged form. 
The details of the original form display.

6. Enter the ASIC Document Trace Number, obtained at Step 1., above.

7. Select Yes or No to indicate whether the form is a response to a request from 
ASIC.

8. Click Next.
If you selected No, a Form 492 will be generated.
If you selected Yes, a Form 902 will be generated.
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9. Enter the Supplementary information.

10. Select the Signing officer from the drop-down.

11. Enter the Date signed.

12. Click Next.

13. Click Finish.
If you selected to preview documents on the previous screen, they display on 
the Print preview screen (see “Previewing forms and documents” on page 40).
If you did not select to preview documents, the ASIC Form Validation screen 
opens (see “ASIC forms validation” on page 176).

14. Complete and lodge the form with ASIC (see “ASIC forms in progress” on 
page 174 and “Forms lodgement” on page 182).

Related topics
Corporations
Amending previously lodged forms
ASIC Forms
Lodgement

ASIC forms in progress

The In Progress screen in the ASIC forms module lists all forms that have been 
generated by workflow wizards (see “Workflow wizards” on page 168) but not yet 
sent to ASIC.

Each form is assigned one of the following statuses:

Status Description

Generated Invalid These forms contain invalid data or do not include 
the signing details. 
Click Complete form on the Task Bar, then Yes to 
view the Status report. 
Correct the data for the form (in Corporate 
Complianceor MYOB AE/AO).
If signing details are also required, change the 
signing details.
Repeat this process until the status of the form 
changes to Generated Valid.
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To view all forms not yet sent to ASIC in Corporate Compliance

1. Click ASIC Forms on the Task Bar.
You can then access the following functions:

 Change signing details (see “Changing signing details” on page 176)

 Complete form (see “Completing forms” on page 180)

 View form (see “Viewing forms” on page 179)

 Delete form (see “Deleting forms” on page 179).

You can also Update forms (see “Updating forms” on page 177).

2. Click the Completed not signed tab (see “Forms completed but not signed” on 
page 178) to view forms that have been completed (validated) but require 
signing details added (see “Changing signing details” on page 176) before they 
can be lodged.

Note: When forms have been completed (validated) and signed, they 
have the status of Generated Valid and are ready to be lodged.

To view a list of ASIC forms in progress in MYOB AE/AO

1. Select Corporate > ASIC forms in progress on the MYOB AE/AO toolbar.
The ASIC forms in progress page opens.

2. Select an agent or All agents from the Show corporations for agent: drop-down.

Generated Unsigned These forms require signing details to be entered.
Click Change signing details on the Task Bar to 
enter the Signing officer and Date signed. 
The status of the form changes to Generated 
Valid.

Generated Valid These forms (which also display in the Lodgement 
module) are complete and ready to be sent to 
ASIC. 
They also display in the Forms Lodgement screen 
in the Lodgement module.

Lodgement Rejected These forms have been lodged but rejected by 
ASIC. 
Update the form then re-lodge it. 
See “Updating forms” on page 177 for details.

Status Description
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3. Select to show forms that are:

 in progress, or

 completed and ready to lodge

 completed but not signed

 generated in an invalid state.
The forms that match the criteria you enter are shown on the page.

4. Click the Corporation name in the list to open the details in Corporate 
Compliance.

5. Click the Client code in the list to open the Corporate Compliance tab on the 
Client page in MYOB AE/AO.

Related topics
ASIC Forms
Changing signing details
Forms completed but not signed
Forms lodgement
Workflow wizards

ASIC forms validation

The ASIC Forms Validation screen opens when you click Finish at the end of a wizard 
but have not selected to preview any documents.

This screen lists the number of forms you have produced in the wizard:

 Forms completed 

 Forms missing signing details

 Forms that could not be completed due to validation errors.

From this screen, click Yes to view the ASIC status report, which displays on the Print 
preview screen (see “Previewing forms and documents” on page 40).

Each form listed here can also be viewed from the ASIC Forms module (see “ASIC 
forms in progress” on page 174).

Changing signing details

The Change signing details screen is used to select the signing officer and enter the 
date signed for forms in this list. You must enter this information to lodge a form.
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If the status of a form is Generated Unsigned you need to enter the signing details for 
the form. You can also change the signing details for any form before lodgement, 
regardless of its status.

To change the signing details of a form

1. Click ASIC Forms on the Task Bar.
The ASIC Forms screens opens at the In progress tab.
(You can also access this function from the Completed not signed screen.)

2. Select the form in the list.

3. Click Change signing details on the Task Bar.
The Change signing officer screen opens.

4. Select a Signing officer from the list.

5. Enter the Date signed (dd/mm/yyyy) or select a date from the calendar.

6. Click OK.
The form is validated by the system.

7. One of the following messages will display:

 The selected form is now completed.

The form’s status is changed to Generated Valid. The form is removed from 
display on the Forms lodgement screen.

You can now lodge your form.

 The form could not be completed due to ASIC validation errors.

The form’s status is changed to Generated Invalid. 

Click Yes to view the validation report. 

Correct the errors and repeat the process.

Related topics
ASIC Forms
ASIC forms in progress
Forms completed but not signed

Updating forms

You can update most data in ASIC forms, regardless of their status. You may need to 
do this because:

 Your client has returned a signed form with corrections.
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 ASIC has rejected a form that you lodged previously, as displayed on the 
Lodgement history screen.

Some data (e.g., Date of change) cannot be updated, so you should delete the form 
and its associated documents and regenerate the form.

To update generated forms

1. Update the data as required in the Corporations or People modules.

2. Complete the form (see “Completing forms” on page 180).
The updated data will be included in the form.
If the form is given the status of Generated Valid, it can be lodged from the 
Forms lodgement screen.

Related topics
ASIC Forms

Forms completed but not signed

The Completed not signed screen (in the ASIC Forms module) displays forms from the 
In progress screen (see “ASIC forms in progress” on page 174) with the status of 
Generated Unsigned. This means that the forms in this screen have been generated 
but do not include the signing details.

To view completed but not signed forms

1. Click ASIC Forms on the Task Bar.
The ASIC Forms screens opens at the In progress tab.

2. Click the Completed not signed tab.

3. From here, you can:

 Change signing details (see “Changing signing details” on page 176)

 Complete form (see “Completing forms” on page 180)

 View form (see “Viewing forms” on page 179)

 Delete form (see “Deleting forms” on page 179).

Related topics
ASIC Forms
Changing signing details
Forms lodgement
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Viewing forms

You can select to view all ASIC forms in progress (using the ASIC Forms module) and 
individual forms for selected companies (using the Corporations module). You can 
also view a list of ASIC forms in progress from MYOB AE/AO.

To view an ASIC form

1. Click ASIC Forms on the Task Bar.
The ASIC Forms screens opens at the In progress tab.

2. Select the form in the list.

3. Click View form on the Task Bar.
The form displays on the Print preview screen (see “Previewing forms and 
documents” on page 40).

To view a form for an individual corporation

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The Details tab opens. 

2. Click the ASIC Forms tab.
The ASIC forms screen opens.

3. Select the form.

4. Click View form on the Task Bar.
The form displays on the Print preview screen. See “Previewing forms and 
documents” on page 40.

Related topics
Updating forms
Deleting forms
Completing forms

Deleting forms

This option removes the selected form from Corporate Compliance so that it cannot 
be lodged with ASIC.

To delete an ASIC form

1. Click ASIC Forms on the Task Bar.
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The ASIC Forms screens opens at the In progress tab.

2. Select the form in the list.

3. Click Delete form on the Task Bar.
A confirmation message box tells you if there are other documents related to 
the form (e.g., meeting minutes).

4. Select the checkbox to delete any related documents, and remove them 
manually from the Documents screen (see “Tools” on page 221).

5. Click Yes to delete the form or No to retain it.

Related topics
Updating forms
Viewing forms
Completing forms

Completing forms

Use this function to validate your form if it has the status of Generated Invalid.

You can also use this function if your form has the status of Generated Valid, but only 
if you have made changes to the data since generating the form.

To complete a form

1. Click ASIC Forms on the Task Bar.
The ASIC Forms screens opens at the In progress tab.

2. Select the form in the list.

3. Click Complete form on the Task Bar.
The system validates the form according to ASIC form requirements.

4. One of the following messages will display:

 The selected form is now completed.

The form is Generated Valid. It also displays on the Forms lodgement 
screen (see “Forms lodgement” on page 182).

You can now lodge the form (see “Forms lodgement” on page 182).

 The selected form is missing signing details.

The form is Generated Unsigned. Enter the signing details (see “Changing 
signing details” on page 176) then recommence this process.

 The form could not be completed due to ASIC validation errors.
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The form is Generated Invalid. Click Yes to view the validation report on the 
Print preview screen. Enter the correct data into Corporate Compliance, 
then recommence this process.

Related topics
Updating forms
Deleting forms
Viewing forms
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Lodgement
The Lodgement module is used for viewing and maintaining the following document 
lodgement details:

 Forms Lodgement (see “Forms lodgement” on page 182)

 Lodgement History (see “Lodgement history” on page 186)

 Sessions Logs (see “Session logs” on page 189)

 ASIC Forms Received (see “ASIC forms received” on page 196).

You can access this module by clicking Lodgement on the Task Bar. The Lodgement 
screen opens at the Forms Lodgement tab. 

Related topics
Forms lodgement
Lodgement history
Session logs
ASIC forms received
Sending and receiving forms
Workflow wizards
ASIC Forms

Forms lodgement

The Forms Lodgement tab in the Lodgement module displays all the paper and 
electronic ASIC forms that are ready to be lodged with ASIC. The forms on this screen 
have the status of Generated Valid on the In Progress screen (see “ASIC forms in 
progress” on page 174).

ASIC forms in this table can be sent electronically if the signing officer has signed the 
form within the last six months. See “Sending and receiving forms” on page 183.

All other forms must be lodged on paper regardless of the date signed. 

From Forms Lodgement you can select multiple electronic forms to send to ASIC. 
Corporate Compliance then batches them (see “Batching forms” on page 190), or you 
can print paper forms for lodgement by mail.

When you send batches of electronic forms to ASIC, each batch displays on the 
Lodgement history screen. See “Lodgement history” on page 186.

To view forms that are ready to be lodged

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. From here you can access the following functions on the Task Bar: 
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 Send/Receive (see “Sending and receiving forms” on page 183)

 View forms (see “Viewing forms” on page 179)

 Print forms list (see “Printing forms lists” on page 194)

 Print forms selected for lodgement (see “Printing forms selected for 
lodgement” on page 185)

 Delete forms “Printing forms lists” on page 194.

3. From here you can also click other tabs to view:

 Lodgement history (see “Lodgement history” on page 186)

 Session logs (see “Session logs” on page 189)

 ASIC forms received (see “ASIC forms received” on page 196).

Note: If a form does not display on this screen, it has either:

Been lodged, and it can be viewed on the Lodgement history screen (see 
“Lodgement history” on page 186) or the ASIC Forms module (see “ASIC 
forms in progress” on page 174)

Not yet complete and it can be seen in the ASIC forms module (see “ASIC 
Forms” on page 166)

Been deleted (see “Printing forms lists” on page 194).

Related topics
Sending and receiving forms
Printing forms selected for lodgement
Receiving forms from ASIC
Lodgement
ASIC Forms
Lodgement history
Session logs
ASIC forms received
Workflow wizards

Sending and receiving forms

There are two main types of forms:

 Paper

If the Electronic Lodgement column on the Forms Lodgement screen states No, 
then the selected form can only be lodged in paper form.

To print the form, click View form, then click  Print.
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 Electronic

If the Electronic Lodgement column on the Forms Lodgement screen states Yes, 
the selected form can be lodged electronically.
From this screen you can click Send/Receive to:

 send and receive electronic forms (as described on the screen)

 only receive electronic forms (see “Receiving forms from ASIC” on 
page 185).

To send and receive electronic documents from ASIC

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Select  Lodge? for each form you want to send to ASIC (optional).

3. Click Send/Receive on the Task Bar, or click the Send/Receive button.

4. The following Send/Receive process occurs:

a. The system batches the selected forms for lodgement (see “Batching 
forms” on page 190). 

b. The Transmitting/receiving files from ASIC screen displays while the 
batched forms are sent.

c. The Connecting to ASIC to retrieve reports screen displays while the system 
checks if any ASIC forms are waiting to be received.

d. If any ASIC documents are awaiting retrieval, they are downloaded.

e. Corporate Compliance disconnects from ASIC.

5. You can then review:

 the batch of forms that you have just sent (see “Lodgement history” on 
page 186).

 any forms that you have received (see “ASIC forms received” on page 196).

 the session logs (see “Session logs” on page 189).

Related topics
Printing forms selected for lodgement
Receiving forms from ASIC
Lodgement
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Printing forms selected for lodgement

This function lists a summary of all forms that have been selected for lodgement on 
the Forms Lodgement screen.

To print forms selected for lodgement

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click Print forms for lodgement on the Task Bar.
The report of the forms selected for lodgement displays on the Print preview 
screen (see “Previewing forms and documents” on page 40).

Related topics
Sending and receiving forms
Receiving forms from ASIC
Lodgement

Receiving forms from ASIC

You can connect to ASIC to receive any forms awaiting collection without having to 
also send forms.

The following process assumes that you have not selected any forms for sending to 
ASIC. If you have selected forms to send, follow the instructions in “Sending and 
receiving forms” on page 183.

To receive forms from ASIC

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click Send/receive on the Task Bar, or click the Send/Receive button.

a. A message box asks whether you want to connect only to receive 
documents from ASIC. 

To continue, click Yes.

To cancel, click No.

b. The Connecting to ASIC to retrieve reports screen displays while the system 
checks if any ASIC forms are waiting to be received.

c. If any ASIC forms are awaiting retrieval, they are downloaded.

d. Corporate Compliance disconnects from ASIC.
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3. After this process, review:

 The forms received (see “ASIC forms received” on page 196).

 The session logs (see “Session logs” on page 189).

Related topics
Lodgement
Receiving forms from ASIC
ASIC forms received

Lodgement history

The Lodgement History tab on the Lodgement module lists all batches (groups of 
forms) that have been transmitted to ASIC from the Forms Lodgement screen (see 
“Forms lodgement” on page 182).

These forms are also listed on the ASIC Forms screen (in the Corporations module) 
(see “Working with ASIC forms” on page 170), and on the ASIC Forms History screen 
(in the Agents module) (see“Agents’ ASIC form histories” on page 204).

This screen displays batches of forms in a table with the following columns:

 Batch Number 

A number generated automatically when the forms are sent to ASIC.

 Batched Date 

When the forms were batched for lodgement on the Forms Lodgement screen.

 Lodgement Date 

When the batch was sent to ASIC.

 Agent 

Agent for whom the batch is created.

 Number of Forms 

Total forms included in the batch.

 ASIC Transmission Number 

The number ASIC has assigned to the batch transmitted to them.

 Status 

The Status of the batch, as:

 Not transmitted: not sent.

 Transmitted – acknowledged: sent, and ASIC transmission report received.
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 Processed – (n) accepted, (n) rejected: sent, ASIC validation report 
received, and one or more forms in batch accepted/rejected.

 Transmitted, unacknowledged: sent, but ASIC transmission report not 
received.

To view batches of forms sent to ASIC

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click the Lodgement History tab.
The list of batches of forms lodged previously with ASIC displays.

3. From this screen you can access the following functions from the Task Bar:

 Delete batch (see “To delete a batch of ASIC forms” on page 192)

 View transmission report (see “Viewing transmission reports” on page 188)

 View validation report (see “Viewing validation reports” on page 188)

 Print lodgement list (see “Viewing and printing lodgement lists” on 
page 192)

 Print forms in batch (see “Viewing and printing forms in batches” on 
page 190).

Note: If a batch of forms is given the status of Processed (n) accepted, (n) 
rejected because one or more forms have been rejected, view the 
errors listed in the validation report (see “Viewing validation 
reports” on page 188), update the form (see “Updating forms” on 
page 177), then resend it.

Related topics
Viewing transmission reports
Viewing validation reports
Lodgement
Lodgement history
Session logs
ASIC forms received
ASIC Forms
Sending and receiving forms
Updating forms
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Viewing transmission reports

A transmission report is a report received from ASIC (see “Sending and receiving 
forms” on page 183) which details whether the transmission of the batch of forms 
succeeded or failed.

You can only view a transmission report if the batch has the status of Transmitted — 
Acknowledged.

To view transmission reports

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click Lodgement History.

3. Select a batch from the list with the status of Transmitted — Acknowledged.

4. Click View transmission report on the Task Bar. 
The report will display on the Print preview screen (see “Previewing forms and 
documents” on page 40).
If the batch has the status of Not transmitted, a message will state that a 
transmission report is not available. Click OK.

Related topics
Viewing validation reports
Lodgement
Lodgement history

Viewing validation reports

A validation report is a report received from ASIC (see “Sending and receiving forms” 
on page 183) which details whether the forms in the batch met ASIC’s validation 
requirements. If an electronic form fails ASIC’s validation it cannot be processed.

You can only view a validation report if the batch has the status of Transmitted — 
Acknowledged.

To view validation reports

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click the Lodgement History tab.

3. Select a batch from the list with the status of Transmitted — Acknowledged.
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4. Click View transmission report on the Task Bar. 
The report will display on the Print preview screen (see “Previewing forms and 
documents” on page 40).
If the batch has the status of Not transmitted or Transmitted, not processed a 
message will say that a validation report is not available. Click OK.

Related topics
Viewing transmission reports
Lodgement
Lodgement history

Session logs

A session log of the electronic lodgement process is generated when any form is sent 
to or received from ASIC. The session log contains the details of the electronic 
communication session with ASIC.

The Session logs list in the Lodgement module lists the last 20 session logs that have 
been generated by Corporate Compliance (unless any logs have been deleted).

To view a session log

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click the Session Logs tab.
The log of lodgement sessions displays.

3. From here you can access the following functions on the Task Bar:

 View session log (see “Viewing session logs” on page 194)

 Delete session log (see “Deleting session logs” on page 195).

Related topics
Batching forms
Viewing and printing forms in batches
Deleting ASIC forms
Viewing and printing lodgement lists
Viewing ASIC invoices
Printing forms lists
Viewing session logs
Deleting session logs
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Forms lodgement

Batching forms

You can select multiple electronic forms as a batch to send to ASIC, by selecting 
 Lodge? on the Forms Lodgement screen (see “Forms lodgement” on page 182).

When you click Send/receive (see “Sending and receiving forms” on page 183), 
Corporate Compliance divides the forms into separate batches, based on the 
following form types:

 370, 484, 489, 490, 492, 902 (separate batches are created for each agent’s 
forms)

 361, 362, RA17, RA61, RA71

The batches of forms are then sent to ASIC.

See:

 “Viewing and printing forms in batches” (see page 190)

 “Viewing and printing lodgement lists” (see page 192)

 “Viewing ASIC invoices” (see page 193).

Related topics
Deleting ASIC forms
Printing forms lists
Viewing session logs
Deleting session logs
Forms lodgement

Viewing and printing forms in batches

ASIC sends invoices to your practice as part of its annual review process for each 
corporation represented by your practice (see “Company statements” on page 149). 

If ASIC has outstanding invoices for your clients, you receive them when you send 
batches of forms for processing (see “Sending and receiving forms” on page 183). 

To view and print ASIC forms in batches

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click the Lodgement History tab to display its contents.

3. Select a batch in the list.
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4. Click Print forms in a batch on the Task Bar.
The forms contained in the selected batch will display on the Print preview 
screen (see “Previewing forms and documents” on page 40) with the following 
information for each form:

 Form number

 Company code (from MYOB AE/AO)

 Company name

 Trace number

 Status.

Related topics
Batching forms
Deleting ASIC forms
Viewing and printing lodgement lists
Viewing ASIC invoices
Printing forms lists
Viewing session logs
Deleting session logs
Forms lodgement

Deleting ASIC forms

If you delete a form, the data that was changed when the form was created will not 
be restored. If this data needs to be restored to its former status, you must do so 
manually. This is done using the Corporations module.

You can also delete batches of ASIC forms using the Lodgement module.

To delete individual ASIC forms

1. Select and open the corporation.
See “Selecting a corporation” on page 21.
The corporation opens at the Details tab. 

2. Click the ASIC Forms tab.
The ASIC Forms screen opens. 

3. Select the form and click Delete form on the Task Bar.
A message box opens.

4. Click Yes.
The form is removed from the history list.
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To delete a batch of ASIC forms

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click Lodgement History.

3. Select a batch from the list.

4. Click Delete batch on the Task Bar.
The following confirmation message will display. 
Are you sure you want to delete Batch number xxx? 

5. Click Yes to permanently delete the batch from the system.
or 
Click No to retain the batch.

Related topics
Batching forms
Viewing and printing forms in batches
Viewing and printing lodgement lists
Viewing ASIC invoices
Printing forms lists
Viewing session logs
Deleting session logs
Forms lodgement

Viewing and printing lodgement lists

ASIC sends invoices to your practice as part of its annual review process for each 
corporation you represent (see “Company statements” on page 149). 

You can view and print lists of invoices.

To view and print a lodgement list

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click the Lodgement History tab.

3. Click Print lodgement list on the Task Bar.
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The batches of forms, as listed on the Lodgement history screen will display on 
the Print preview screen, ready for you to print as a list (see “Previewing forms 
and documents” on page 40).

Related topics
Batching forms
Viewing and printing forms in batches
Deleting ASIC forms
Viewing ASIC invoices
Printing forms lists
Viewing session logs
Deleting session logs
Forms lodgement

Viewing ASIC invoices

If invoices are payable for any forms within a batch, ASIC will send the invoices to your 
practice after the batch is validated. If invoices are payable for this batch, your 
practice will receive them when you next send batches of forms for processing (see 
“Sending and receiving forms” on page 183).

You can only view invoices that you have received if the batch has the status of 
Transmitted — Acknowledged on the Lodgement history screen.

To view ASIC invoices

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click the Lodgement History tab.

3. Select a batch from the list with the status of Transmitted — Acknowledged.

4. Click View invoices on the Task Bar.
If invoices have been received, they will display on the Print preview screen (see 
“Previewing forms and documents” on page 40).
If invoices have not been received, a message will tell you that none are 
available.

Related topics
Batching forms
Viewing and printing forms in batches
Deleting ASIC forms
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Viewing and printing lodgement lists
Printing forms lists
Viewing session logs
Deleting session logs
Forms lodgement

Printing forms lists

This function prints all forms listed on the Forms Lodgement screen.

To print a list of forms

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click Print forms list on the Task Bar.
The list of forms displays on the Print preview screen (see “Previewing forms 
and documents” on page 40).

Related topics
Batching forms
Viewing and printing forms in batches
Deleting ASIC forms
Viewing and printing lodgement lists
Viewing ASIC invoices
Viewing session logs
Deleting session logs
Forms lodgement

Viewing session logs

A session log is generated when a batch of forms is sent to ASIC (see “Sending and 
receiving forms” on page 183) and it contains the details of the communication 
session with ASIC.

To view the session log

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click the Session Log tab.

3. Select a session log from the list.
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4. Click View session log on the Task Bar.
The session log displays on the Print preview screen (see “Previewing forms and 
documents” on page 40).

Related topics
Batching forms
Viewing and printing forms in batches
Deleting ASIC forms
Viewing and printing lodgement lists
Viewing ASIC invoices
Printing forms lists
Deleting session logs
Forms lodgement

Deleting session logs

A session log is generated when a batch of forms is sent to ASIC (see “Sending and 
receiving forms” on page 183) and it contains the details of the communication 
session with ASIC.

To delete a session log

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click the Session Log tab.

3. Select a session log from the list.

4. Click Delete session log on the Task Bar.
A confirmation message displays.

5. To permanently remove the session log from the system, click Yes.
To retain the session log in the system, click No.

Related topics
Batching forms
Viewing and printing forms in batches
Deleting ASIC forms
Viewing and printing lodgement lists
Viewing ASIC invoices
Printing forms lists
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Viewing session logs
Forms lodgement

ASIC forms received

The ASIC Forms Received screen in the Lodgement module lists the following 
documents that have been received from ASIC:

 RC05 Late Fee Invoice

RC05 Change Notifications can be viewed from the Corporations > ASIC Forms 
tab

 RA18 agent amendment status report (request form: RA17 — see “Requesting 
agent reports from ASIC” on page 201)

This form can also be viewed from the Agents module.

 RA62 agent review date report (request form: RA61 — see “Requesting agent 
reports from ASIC” on page 201)

 RA64 debtor’s ledger report (request form: RA63 — see “Requesting agent 
reports from ASIC” on page 201)

This form can also be viewed from the Agents module.

 RA66 Documents lodged report (request form: RA65 — see “Requesting agent 
reports from ASIC” on page 201)

This form can also be viewed from the Agents module.

 RA68 debtor’s ledger report (request from RA67)

 RA72 corporations detailed report (request form: RA71).

This form can be viewed from the Corporations > ASIC Forms tab.

Note: Company statements are accessible from the Company Statements module. 
 
Other documents received such as Validation reports and Transmission 
reports are accessible from the Lodgement history screen.

See “Viewing forms received from ASIC” on page 197.

Related topics
Viewing forms received from ASIC
Lodgement
ASIC Forms
Forms lodgement
Lodgement history
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Session logs
Sending and receiving forms
Viewing reports received from ASIC

Viewing forms received from ASIC

To view forms received from ASIC

1. Click Lodgement on the Task Bar.
The Lodgement screen opens at the Forms Lodgement tab.

2. Click the ASIC Forms Received tab.

3. Select a form from the list.

4. Click View form on the Task Bar.
The form displays on the Print preview screen.

Related topics
Lodgement
ASIC Forms
Forms lodgement
Lodgement history
Session logs
Sending and receiving forms
Viewing reports received from ASIC



MYOB AO Corporate Compliance | Version 3.0 User Guide | 198

Agents
The Agents module is used to: 

 Maintain agent data

 Cease an agent’s appointment (see “Ceasing acting as a registered agent” on 
page 205). 

 Request (see “Requesting agent reports from ASIC” on page 201) and view (see 
“Agents’ ASIC form histories” on page 204) agent data from ASIC.

To access the Agents module

1. Click Agents on the Task Bar.
The Agents selection list opens.
All agents in your practice who have been entered in Corporate Compliance are 
listed.

2. Right-click a listed agent to select an option:

 Request ASIC reports

 Cease to act as registered agent

 Open agent details

 Add agents

 Delete agents.

Related topics
Viewing agent details
Adding Agents
Changing agent details
Deleting agents
Ceasing acting as a registered agent
Requesting agent reports from ASIC

Working with agents

This section includes information about:

 “Viewing agent details” (see page 199)

 “Adding Agents” (see page 199)

 “Deleting agents” (see page 200)

 “Changing agent details” (see page 201)

 “Requesting agent reports from ASIC” (see page 201)
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 “Viewing reports received from ASIC” (see page 202).

Viewing agent details

The Agents Details tab is used for viewing the following agent data:

 ASIC agent number‡

 Agent’s practice details

 EDGE login details‡.

‡ This information is provided by ASIC when an agent registers to access the EDGE 
system.

To view an agent’s details

1. Select and open the agent.
See “To access the Agents module” on page 198.
The agent’s page opens at the Details tab.

2. Click the ASIC Forms History tab to view all forms lodged by the agent (see 
“Agents’ ASIC form histories” on page 204).

3. Click Close to return to the Agents selection list.

Related topics
Agents
Agents’ ASIC form histories
Adding Agents
Changing agent details
Deleting agents

Adding Agents

The Add Agent screen is used to enter details of new ASIC agents in your practice.

To add an agent

1. Select and open the agent.
See “To access the Agents module” on page 198.
The agent’s page opens at the Details tab.

2. Click Add agent on the Task Bar.
The Add new agent screen opens.
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3. Enter the following agent data:

a. Agent details, including name, surname, practice details.

b. EDGE login details,‡ including ASIC agent number,‡ DIS User ID, Password 
and Address, AUSTPAC NUI details.‡

‡ This information is provided by ASIC when an agent registers to access 
EDGE.

4. Click OK to add the agent to the Agents selection list.

Related topics
Agents
Viewing agent details
Deleting agents
Changing agent details

Deleting agents

You can delete an agent, but only if they have not been appointed to act as an ASIC 
agent (see “Appointing and ceasing agents” on page 32). 

To delete an agent

1. Select and open the agent.
See “To access the Agents module” on page 198.
The agent’s page opens at the Details tab.

2. Click the agent you want to delete.

3. Then either click Delete agent on the Task Bar, or right-click the agent and select 
Delete agent from the menu.
You will see one of two messages:

 You cannot delete this agent, as it is a current agent for one or more 
corporations. 

This agent is currently appointed to a corporation and cannot be deleted. 
The agent can only be deleted after their appointment has been ceased.

Click OK. 

The Agent selection list reopens and the agent is retained.

 Are you sure you want to delete this agent? 

This agent is not currently appointed to a corporation and may be deleted.
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4. To delete the agent, click Yes. To retain the agent, click No.

Related topics
Agents
Viewing agent details
Adding Agents
Changing agent details

Changing agent details

You can change details of any of your practice’s ASIC agents using the Agents module.

To change an agent’s details

1. Select and open the agent.
See “To access the Agents module” on page 198.
The agent’s screen opens at the Details tab.

2. Click Change agent details on the Task Bar.
The Change agent details screen opens.

3. Change the data as necessary.

4. Click OK.
The agent’s detail are updated.

Related topics
Agents
Adding Agents
Viewing agent details
Deleting agents

Requesting agent reports from ASIC

Use the Agents module to request any of the following agent reports from ASIC:

 RA17 — Amendment Status Report

 RA61 — Review Date Report

 RA63 or RA67 — Request for Ledger’s Debtor Report

 RA65 — Request for Documents Lodged Report.
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Use the Agents > ASIC Forms History tab to read the agent reports received (see 
“Agents’ ASIC form histories” on page 204).

You can also download data regarding specific corporations.

To request an ASIC agent report

1. Select and open the agent.
See “To access the Agents module” on page 198.
The agent’s screen opens at the Details tab.

2. Click the agent for whom the report is required.

3. Click Request ASIC Reports on the Task Bar, or right-click the agent in the list 
and select Request ASIC Reports from the menu.
The Request reports from ASIC wizard opens.

4. Click Next.
A list of available ASIC reports displays.

5. Select the ASIC report(s) required.

6. If necessary, change the request date. Click Next.

7. Click Yes to transmit your report request now, or
Click No to transmit your report request later.

8. Click Finish. 
Your report will be received.

9. Check the report.

Related topics
Agents
Agents’ ASIC form histories
Viewing reports received from ASIC

Viewing reports received from ASIC

The ASIC Forms History tab in the Lodgement module lists ASIC reports that have 
been:

 Requested by the agent (see “Requesting agent reports from ASIC” on 
page 201), e.g., RA17.

and
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 Received from ASIC in response to the agent’s request (see “Receiving forms 
from ASIC” on page 185), e.g., RA18.

If a request form (i.e., RA17, RA61, RA63, RA67 or RA65) has the status of Accepted 
— Completed, an agent report (i.e., RA18, RA62, RA64, RA68 or RA66) has been 
received and you can view the received report.

To view an agent report received from ASIC

1. Select and open the agent.
See “To access the Agents module” on page 198.
The agent’s screen opens at the Details tab.

2. Click the ASIC Forms History tab.

3. Select a form with the status of Accepted — Completed.

4. Click View form on the Task Bar.
The requested report displays on the Print preview screen.

Related topics
Agents
Agents’ ASIC form histories
ASIC forms received (Lodgement Module)
Agents’ ASIC form histories

Request form 
(sent by the agent to ASIC)
See “Requesting agent reports from 
ASIC” on page 201

Received report 
(sent by ASIC to the agent)
See “Agents’ ASIC form histories” on 
page 204

RA17
Request for Data Amendment Report

RA18
Data Amendment Report

RA61
Request Review Date Report

RA62
Review Date Report

RA63 or RA67
Request Debtor’s Ledger Report

RA64 or RA68
Debtor’s Ledger Report

RA65
Request for Documents Lodged Report

RA66
Documents Lodged Report
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Agents’ ASIC form histories

The ASIC Forms History tab lists the ASIC reports requested by the selected agent. 
See “Requesting agent reports from ASIC” on page 201.

This list contains:

 ASIC Form (report request) and description:

RA17 — Amendment Status Report
RA61 — Review Date Report

 Date when report request was lodged.

 Date when report request was completed.

 Status of the report request:

Incomplete
Completed not lodged
Completed awaiting report
Completed report

To view an agent’s ASIC forms history

1. Select and open the agent.
See “To access the Agents module” on page 198.
The agent’s screen opens at the Details tab.

2. Click the ASIC Forms History tab.
From this tab you can:

 View a form: To view a form, select it in the display panel and click View 
form on the Task Bar. The form will display on the Print preview screen.

 View reports received (see “Viewing reports received from ASIC” on 
page 202).

 Delete a form: You can delete a form if it is not in a batch to be lodged. To 
delete a form, select it in the display panel and click Delete form on the 
Task Bar.

3. Click Close to return to the Agents selection list.

Related topics
Agents
Viewing reports received from ASIC
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Ceasing acting as a registered agent

From the Agents module you can unilaterally cease a registered agent’s appointment.

Note: If the appointment is being ceased by the corporation, however, use the 
Appoint or cease wizard in the Corporations module. See “Appointing and 
ceasing agents” on page 32.

To cease acting as an agent

1. Click Agents on the Task Bar.
The Agents selection list opens.

2. Click the agent in the list.

3. Click Cease to act as registered agent on the Task Bar, or right-click the agent 
and select Cease to act as registered agent from the menu.
The Cease to act as registered agent wizard opens.

4. Click Add.
The Select a company screen opens.

5. Select a company and click OK.
The company is added to the list.

6. Repeat Step 4. to Step 5. for each additional company.
When you have added all companies required, go to Step 7.

7. Click Next.
The Select the documents you wish to produce screen opens.

8. Select the documents that you wish to produce (Form 361).

9. Enter the Date signed (dd/mm/yyyy) or select a date from the drop-down 
calendar.

10. Click Next.
The Finish window opens. 

11. Click Finish.
If you selected to preview documents at the previous screen, they display on 
the Print preview screen. If not, the ASIC Form Validation screen opens.

12. Lodge the form with ASIC (see “Forms lodgement” on page 182).
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Related topics
Agents
Viewing agent details
Adding Agents
Deleting agents
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Reports
The following reports are available under Reports on the main menu:

 Corporations Detailed Report: This report contains data from the Corporation 
Details, Addresses, Officers and Capital screens. See “Corporations detailed 
report” on page 208.

 ASIC Data Received: This report contains data received from ASIC (in the RA72) 
that was requested previously. See “Corporations ASIC data received report” on 
page 209.

You can also view this data from ASIC Forms Received in the Lodgement 
module.

 Company Statement Status Report: See “Company statement status report” on 
page 210.

 Summary Report: See “Summary report” on page 211.

 Register of Charges Report: see “Register of charges report” on page 213.

 Corporations Register of Officeholders: See “Corporations register of 
officeholders report” on page 214.

 Corporations Register of Members: See “Corporations register of members 
report” on page 214.

 Corporations Registered Office Report: See “Corporations registered office 
report” on page 215.

 Person Detailed Report: You can also view this data from the People Details, 
Positions held and Shares held screens. See “Person detailed report” on 
page 216.

 Shared Address Report: See “Shared address report” on page 217.

Reports display on the Print preview screen (see “Previewing forms and documents” 
on page 40).

Related topics
Corporations detailed report
Corporations ASIC data received report
Company statement status report
Summary report
Register of charges report
Corporations register of officeholders report
Corporations register of members report
Corporations registered office report
Person detailed report
Shared address report
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Working with reports

The Corporate Compliance reports are all accessed from the main menu, and all can 
be previewed on the Print preview screen.

See the following for details of each report:

 “Corporations detailed report” (see page 208)

 “Corporations ASIC data received report” (see page 209)

 “Company statement status report” (see page 210)

 “Summary report” (see page 211)

 “Register of charges report” (see page 213)

 “Corporations register of officeholders report” (see page 214)

 “Corporations register of members report” (see page 214)

 “Corporations registered office report” (see page 215)

 “Person detailed report” (see page 216)

 “Shared address report” (see page 217).

Related topics
Reports
Previewing forms and documents
Corporations detailed report
Corporations ASIC data received report
Company statement status report
Summary report
Register of charges report
Corporations register of officeholders report
Corporations register of members report
Corporations registered office report
Person detailed report
Shared address report

Corporations detailed report

This report contains data from the Corporation Details, Addresses, Officers and 
Capital screens.

To print/preview the Corporations Detailed report

1. Select Reports > Corporations > Detailed Report from the main menu.
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The Find a Corporation window opens.

2. Search for and select the required corporation and click OK.
The Corporation Detailed Report opens. 
It provides details of Name, Code, ACN, ABN, Corporate Key, Type of Company, 
Class of Company, Date of incorporation, Place of incorporation, Annual review 
date, Business address, Registered address, Postal Address, Ultimate holding 
company, Parent Company, Auditors, Officers, and Shares Held.

Related topics
Corporations ASIC data received report
Company statement status report
Summary report
Register of charges report
Corporations register of officeholders report
Corporations register of members report
Corporations registered office report
Person detailed report
Shared address report

Corporations ASIC data received report

After ASIC receives a report you have sent, you can check to see that the file was 
received intact.

To access the corporations ASIC data received report

1. Select Reports > Corporations > ASIC data received.
The report will open.

 If your last request was for a Data Download, the report will display the text 
generated by the system from the data received.

 If your last request was for a Company Statement, the report will display a 
PDF of the file as it was received.

The above report can also be accessed from the Corporations module ASIC 
Forms tab and from the Lodgement module ASIC Forms Received tab.

Related topics
Corporations detailed report
Company statement status report
Summary report
Register of charges report
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Corporations register of officeholders report
Corporations register of members report
Corporations registered office report
Person detailed report
Shared address report

Company statement status report

This report enables you to review the status of the current company statement 
received for companies which you manage as a partner or agent of the practice, 
within a specific review period.

You can identify the companies that have not received a statement by the expected 
due date and the companies for which you should receive a statement in the 
immediate future.

To print/review the Company Statement Status report

1. Select Reports > Corporations > Company Statement Status report from the 
main menu.
The Company Statement Status Report window opens.

2. Enter the Company statements received or due from dates (dd/mm/yyyy), or 
select the dates from the drop-down calendar to specify the review period to be 
reported. 
Both dates are mandatory, and you can enter any date range in the past or 
future. You can select a maximum reporting period of 12 months.

3. Under Select Corporations, select one of the following search options:

 All Corporations: This default option displays all corporations in the system.

 Corporations for Agent: Select an agent from the drop-down list. Agents 
are listed in surname order. Each agent’s name is presented in the format of 
given name, surname. For example, Smith, Jane. If this option is selected, 
only corporations for the selected agent will be included in the report.

 Corporations for Partner: Select a partner from the drop-down list. 
Partners are listed in surname order. Each partner’s name is presented in 
the format of surname, given names. For example, Dane, Roger. If this 
option is selected, only corporations for the selected partner will be 
included in the report.

4. Deselect Only show corporations that are managed by the practice, if 
necessary.

5. Under Select Status of Statement, select one of the following search options:

 All statement statuses: This default option displays all statement statuses.
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 Corporations that have not received a statement by the annual review 
date: Only companies with a review date within the specified review date 
period that have not received a statement will be included in the report.

 Corporations that have a statement with status: Select the following 
statuses, as required:

Statement received is selected by default. You can deselect this option, if 
necessary.

Changes to be notified 

Changes from lodged 

Invoice paid 

Statement received back from client.

6. In the Sort by drop-down list, select to sort the report by Corporation Name, 
Corporation Code, ACN, Review Date or Statement Status. 

7. Click OK.
The Company Statement Status report, with all companies that match the 
selected report criteria, displays in the order selected.

Related topics
Reports
Corporations detailed report
Corporations ASIC data received report
Summary report
Register of charges report
Corporations register of officeholders report
Corporations register of members report
Corporations registered office report
Person detailed report
Shared address report

Summary report

The Summary Report is used for tracking the annual review dates for the corporations 
in your practice. The following information is displayed for each corporation:

 Code

 Name

 ACN

 Review date, as entered on the Corporation Details screen (see “Viewing 
corporation details” on page 20).
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To display the Summary Report

1. Select Reports > Corporations > Summary Report from the main menu.
The Corporation summary report selection screen opens.

2. Select one of the following search options:

 All: Displays all corporations in the system.

 Company name, company code, ACN: Displays selected companies. Enter 
the details exactly as they appear in the system, or enter the initial 
characters followed by a wildcard (*). For example, enter A* to view all 
companies starting with A.

 Review date: Displays all companies with review dates within the date 
range entered.

3. Select an option to sort the companies (by corporation name, code, ACN, review 
date).

4. Click OK.
The report displays on the Print preview screen (see “Previewing forms and 
documents” on page 40).

To print preview the Summary Report

1. Select Reports > Corporations > Summary Report from the main menu.
The Corporation summary report selection screen opens.

2. Select one of the following search options:

 All: Displays all corporations in the system.

 Company name, company code, ACN: Displays select companies. Enter the 
details exactly as they appear in the system, or enter the initial characters 
followed by a wildcard (*). For example, enter A* to view all companies 
starting with A.

 Review date: Displays all companies with review dates within the date 
range entered.

3. Select a sort by option to sort the companies (by corporation name, code, ACN, 
review date).

4. Click OK.
The report displays on the Print preview screen.

Related topics
Corporations detailed report
Corporations ASIC data received report
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Company statement status report
Register of charges report
Corporations register of officeholders report
Corporations register of members report
Corporations registered office report
Person detailed report
Shared address report
Previewing forms and documents

Register of charges report

To print or view a Corporation’s Register of Charges report

1. Select Reports > Corporations > Register of Charges from the main menu.
The Register of Charges screen opens.

2. If necessary, find the corporation by searching or sorting.

3. When found, double-click the company name to display it in the Corporation 
field on the Register of Charges screen.

4. Select either  Detailed report or  Summary report.

5. Select  Include former charges, if required.

6. Click OK.

7. If the selected corporation has no charges, the following error message is 
displayed.

This corporation has no charges.

Click Cancel to exit.

8. If the selected corporation does have charges, the Register of Charges report is 
displayed.
The charges are presented in charge date order; with the most recent charge 
first. In the Detailed report, each charge is presented on a separate page.

Related topics
Corporations detailed report
Corporations ASIC data received report
Company statement status report
Summary report
Corporations register of officeholders report



Reports

MYOB AO Corporate Compliance | Version 3.0 User Guide | 214

Corporations register of members report
Corporations registered office report
Person detailed report
Shared address report

Corporations register of officeholders report

To print/preview a Corporations Register of Officeholders report

1. Select Reports > Corporations > Register of Officeholders from the main menu.
The Register of officers report screen opens.

2. If necessary, find the corporation by searching or sorting.
When found, double-click the company name to display it in the Corporation 
field on the Register of officers report screen.

3. Enter the Show officers as at date or use the drop-down calendar. 

4. Select  Include former officers if you want to include ceased officers in the 
report.

5. Click OK.
The selected Register of officeholders report opens.

Related topics
Reports
Corporations detailed report
Corporations ASIC data received report
Company statement status report
Summary report
Register of charges report
Corporations register of members report
Corporations registered office report
Person detailed report
Shared address report

Corporations register of members report

To print/preview a Corporations Register of Members report

1. Click Reports > Corporations > Register of Members from the main menu.
The Find a corporation window opens.
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2. If necessary, find the corporation by searching or sorting.

3. Select the required corporation and click OK.
The Register of Members report opens. Each shareholding group appears on a 
separate page. Share transactions are grouped by Primary and Joint 
Shareholders, Class and Beneficially Held.
If a person holds shares as sole owner plus shares held jointly with another 
person, these are considered to be two different holdings. 
Shareholders are displayed in alphabetical order. The shares for each member 
are listed in ascending transaction date order, with the oldest transaction first.

Related topics
Corporations detailed report
Corporations ASIC data received report
Company statement status report
Summary report
Register of charges report
Register of charges report
Corporations register of officeholders report
Corporations registered office report
Person detailed report
Shared address report

Corporations registered office report

To view/print a Registered Office report

1. Select Reports > Corporations > Registered office report from the main menu.
The Registered office report screen opens.

2. If necessary, find the corporation by searching or sorting.
When found, double-click the company name to display it in the Corporation 
field on the Registered Office Report screen.

3. Select  Print corporation name only if you want to include only the names of 
the corporations that share the registered address of the selected corporation.

4. Select to sort by  Company Name, or  Company Code, or  ACN. 

5. Click OK.

 If the selected corporation has no addresses, you will receive an error 
message.



Reports

MYOB AO Corporate Compliance | Version 3.0 User Guide | 216

 If the selected corporation has a registered address, the Registered Office 
Report opens.

The Registered Office Report displays the registered address of the selected 
corporation and a list of all corporations that share this address as their current 
registered address.

Related topics
Reports
Corporations detailed report
Corporations ASIC data received report
Company statement status report
Summary report
Register of charges report
Corporations register of officeholders report
Corporations register of members report
Person detailed report
Shared address report

Person detailed report

The Person Detailed report lists current positions that a person holds, including the 
company, position and date of appointment. 

It also lists all share transactions if the number held is greater than zero and the 
selected person is the primary holder. 

If the transaction is an allotment, the date acquired is the date of issue. If the 
transaction is a transfer, the date acquired is the date of transfer.

To print/preview the Person Detailed report

1. Select Reports > People > Detailed Report from the main menu.
The Find a Person screen opens.

2. If necessary, find the person by searching or sorting.
When found, double-click the name to display it in the Find a Person screen.

3. Click OK.
The Person Detailed report displays the name, code, date of birth, place of 
birth, home address, postal address, positions held and shares held.

4. Click Close to exit the report and return to the main window.
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Related topics
Reports
Corporations detailed report
Corporations ASIC data received report
Company statement status report
Summary report
Register of charges report
Corporations register of officeholders report
Corporations register of members report
Corporations registered office report
Shared address report

Shared address report

To view/print the Shared Address report

1. Select Reports > Shared address report from the main menu.
The Shared address report screen opens.

2. Find the corporation or person by searching or sorting.

3. Select an Address from the drop-down:

 if Corporation is selected, Registered address, Business address and Postal 
address are listed.

 If Person is selected, Residential address and Postal address are listed.

4. Select to sort by either  Name or  Code. 

5. Click OK.

 If the selected person or corporation has no addresses, an error message 
will open. 

Click Cancel to exit.

 If the selected person or corporation does have address information, the 
shared address report is displayed.

The list of contacts that share the address are listed in the order selected.

6. Click Close to exit the report.

Related topics
Reports
Corporations detailed report
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Corporations ASIC data received report
Company statement status report
Summary report
Register of charges report
Corporations register of officeholders report
Corporations register of members report
Corporations registered office report
Person detailed report
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Integration with MYOB Document Manager
For sites with MYOB Document Manager, you can save the set of documents 
generated by a Corporate Compliance change task directly to MYOB Document 
Manager. This can be saved as one PDF file for a set of documents, or as individual 
files for each document.

This feature is accessed from the Corporate Compliance Print Preview window. Refer 
to “Previewing forms and documents” on page 40.

You can choose to:

 Create only one document in Document Manager for each contact, which 
consolidates all the items selected for that contact.

 Create a separate document in Document Manager for each selected item.

To create one document in Document Manager for all documents listed

1. From the Corporate Compliance Print Preview window, click on Share it.
The Select documents to be saved to Document Manager window opens.

2. In the Document Manager options section, select the option Create one 
document for each contact in the selected list.

3. In the Document description below this option, enter in the document 
description will be used in Document Manager for this consolidated documents 
set.

4. In the Select documents to be saved section, select the documents to be sent to 
Document Manager.

5. Click OK.
The Create Document Wizard opens.

Note: This screen opens once for each contact.

6. Enter in the all details for the document and then click Finish.
The document is sent to Document Manager.

To create a separate document in Document Manager for each document listed

1. From the Corporate Compliance Print Preview window, click on Share it.
The Select documents to be saved to Document Manager window opens.

2. In the Document Manager options section, select the option Create a separate 
document for each selected item.

3. In the Select documents to be saved section, select the documents to be sent to 
Document Manager.
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4. Click OK.
The Document Manager Share It window opens listing the selected documents.

5. Click OK. 
The Create Document Wizard opens.

Note: The Contact and Title are disabled in this screen. The contact and 
title are taken from the Select documents to be saved to Document 
Manager window.

6. Enter in the all details for the document and then click Finish.
The document is sent to Document Manager.

Tip: You can also send Company Statements directly to MYOB 
Document Manager. Refer to “Saving a company statement to 
MYOB Document Manager” on page 163.

Related topics
Reports
Corporations detailed report
Corporations ASIC data received report
Company statement status report
Summary report
Register of charges report
Corporations register of officeholders report
Corporations register of members report
Corporations registered office report
Person detailed report
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Tools
The Tools menu on the menu bar has the following options:

 “Document templates” (see page 221)

 “Master share classes” (see page 223)

 “System defaults” (see page 226).

Document templates

Corporate Compliance provides a set of templates that allow you to modify the 
details of some documents (e.g., minutes of meetings, consent to act as an officer, 
notification of resignation, share certificates, applications for shares, and share 
transfer forms).

The document templates are:

 Appoint or cease officers — minutes of the directors’ meeting

 Officer’s consent to act

 Officer’s notice of resignation

 Change registered office — minutes of the directors’ meeting

 Change corporation name — minutes of the directors’ meeting

 Change corporation name — minutes of the members’ meeting

 Issue of Shares — minutes of the directors’ meeting

 Application for allotment of shares

 Share certificate

 Transfer of shares — minutes of the directors’ meeting

 Share transfer form

 Request for share transmission

 Transmission of shares form

 Cancellation of Shares — minutes of the directors’ meeting

 Cancellation of Shares — minutes of the members’ meeting

 Letter for company statement — no changes to be notified to ASIC

 Letter for company statement — changes to be notified to ASIC

 Directors’ statement of solvency

 Unit Certificate

 Issue of units – Trustees meeting minutes

 Application for allotment of units

 Transfer units – trustees meeting to approve the transfer
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 Units transfer form

 Cancel Units - trustees meeting to propose the cancellation

 Cancel Units – members meeting to approve the cancellation

 Dividend statement

 Dividend payment recommendation – directors meeting minute

 Dividend payment acceptance – members meeting minute

 Dividend payment declaration – directors meeting minute.

There is also a list of tags that you can use within each document. This list will vary 
depending on the template selected.

Related topics
Editing document templates
Tools

Editing document templates

You can change any of the document templates to suit your needs. 

The Template Editor generally follows Microsoft Word conventions for formatting 
options (e.g., font families, styles and sizes; paragraph alignment and styles; tab 
spacing and alignment; and margins). The page size is set to standard A4.

Tags

Pre-defined Tags are used to add Merge Text strings which are filled automatically by 
appropriate text in reports. These are used in the same way that Microsoft Word uses 
“data fields” to create a mail merge.

For example, in the Appoint or cease officers — directors’ meeting minutes 
template:

The Merge Text string <<Meeting_MultiLine_Address>> will be filled by the address 
of the Board of Directors meeting held to resolve appointing or ceasing officers. This 
address is selected while appointing or ceasing company officers in the Corporations 
module (see Step 17. in “To appoint an officer” on page 64).

Special code pairs

Three special pairs of codes are used in templates:

(( and )) — all text and Merge Text which appears after (( and before )) will be 
repeated if more than one entry meets the criteria. For example, when more 
than one officer is appointed at the meeting. 
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[[ and ]] — if no data is available to fill Merge Text after [[ and before ]], the 
entire line(s) will be hidden. For example, if the corporation has an ABN but no 
ACN, only the line(s) for ABN will appear in the report.
<< and >> — used to denote a Merge Text string.

Refer to the document templates to see where the special codes are used.

To update a document template

1. Select Tools > Document Templates from the main menu.
The Template Editor window opens.

2. Select the template that you want to edit from the Templates drop-down list.
The text of the document template opens in the word processing section of the 
window.

3. Change the required text, formatting and margins using the toolbar and menus, 
and following Microsoft Word conventions.

4. Insert Merge Text strings.

a. Click the precise point in the text where you want the merged text to 
appear.

b. Select the Merge Text string from the Tags drop-down list.

Note: The list of document tags varies with each document template.

5. Add and adjust Special code pairs as required (see Special code pairs).

6. Click File > Save to save the template.

Related topics
Document templates

Master share classes

The Master Share Classes screen is used for setting up and maintaining the share 
classes that can be allotted in the corporation’s Capital module (see “Capital” on 
page 74).

Related topics
Managing master share classes
Capital
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Managing master share classes

To manage master share classes

1. Select Tools > Master Share Classes from the main menu.
The Master Share Classes screen opens.
Select the Share class you want to change, then click the appropriate buttons to:

 Add additional classes

 Change existing classes

 Delete classes (if the share class is not used in any share allotments).

2. Click Close when finished.

Related topics
Capital
Master share classes

Adding partners

Use the Partners screen (Tools > Partners) to associate partners in your practice with 
each corporation.

To add a partner

1. Select Tools > Partners from the main menu.
The Partners window opens.

2. Click Add.
The Add Partner window opens.

3. Enter the following partner data:

 Code — not mandatory. The code can be auto-generated. It can have a 
maximum of 10 alphanumeric characters and must be unique across all 
partners.

 Given names 

 Surname.

4. Click OK.
The partner is added to the list of partners.

5. Click Close.
To exit the Partners window and return to the main window.
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Related topics
Changing partner details
Deleting partners
Changing corporation details
Summary report

Changing partner details

Use the Partners screen (Tools > Partners) to edit partner name or code details.

To change a partner’s details

1. Select Tools > Partners from the main menu.
The Partners window lists all partners.

2. Select a partner and click Change, or double-click the partner.
The Edit Partner window opens.

3. Change the details as required.

4. Click OK.
The selected partner’s details in the selection list are updated.

5. Click Close.
The Partners window closes.

Related topics
Adding partners
Deleting partners
Changing corporation details
Summary report

Deleting partners

Use the Partners screen (Tools > Partners) to delete a partner and their details.

To delete a partner

1. Select Tools > Partners from the main menu.
The Partners window lists the partners.

2. Select the partner you want to delete.

3. Click Delete.
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If the partner is linked to a corporation the following message displays:

Partner is associated with one or more corporations. Deleting this partner 
will mean these corporations will no longer be associated with a partner. 

Are you sure you want to delete this partner?

If the partner is not linked to a corporation the following message displays:

Are you sure you want to delete this partner?

4. To delete the partner, click Yes. To retain the partner, click No.

5. Click Close.
To exit the Partners window and return to the main window.

Related topics
Adding partners
Changing partner details
Changing corporation details
Summary report

System defaults

The System Defaults screen lets you nominate the address type to be used as the 
default reporting address for all corporations which are shareholders. This is a global 
setting. You can nominate either the current business address or registered address.

This setting is to cater for CRS users who have used the corporation shareholder’s 
registered address as the address that has been reported to ASIC for a contact which 
is a corporation.

When Corporate Compliance is installed, the default setting is the Business Address, 
but you can change to using the Registered Address, if required.

The following Corporate Compliance documentation will be affected by the change in 
the default address setting for corporate shareholders:

 ASIC forms

Form 484A
Form 484C

 Reports

Corporation Detailed Report
Register of Members.
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Note: For CRS users. When converting to Corporate Compliance, you must update 
the default address type for shareholder from Business to Registered.

Related topics
Changing system default settings

Changing system default settings

To change the default shareholder reporting address

1. Select Tools > System Defaults from the main menu.
The System Defaults screen opens.

2. Click either:

 Business Address
or

 Registered Address.

3. Click OK.
If you change the Business Address to Registered Address, the following 
message opens:

All ASIC forms and reports will now use the Business address for all 
corporate shareholders. Are you sure?

If you change the Registered Address to Business Address the following message 
opens:

All ASIC forms and reports will now use the Registered address for all 
corporate shareholders. Are you sure?

4. To proceed with your selection, click Yes. To keep the current setting, click No.

Related topics
System defaults
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Integration with MYOB Accountants Enterprise/
Accountants Office

Integrating Corporate Compliance with the MYOB Accountants Enterprise (MYOB AE) 
or Accountants Office (MYOB AO) suite allows you to seamlessly share database 
information about your clients and contacts.

All contacts in the Corporate Compliance database are linked to a contact in the 
MYOB AE/AO database. The contact data that is shared from MYOB AE/AO is read 
only in Corporate Compliance. All updates to that shared data are performed in the 
contact (and\or client) screens in MYOB AE/AO.

Related topics
How Corporate Compliance works with MYOB AE/AO
Opening MYOB AE/AO-integrated Corporate Compliance
Corporate Compliance client/contact tab
Configuring Corporate Compliance for MYOB AE/AO
Corporate Compliance homepages/pages

How Corporate Compliance works with MYOB AE/AO

Corporate Compliance integrates with MYOB AE/AO, so that one set of contacts is 
maintained, and the data that is common to these 2 applications is maintained once. 
Corporations and people used with the Corporate Compliance application are first 
added to MYOB AE/AO, and then brought across to Corporate Compliance. The core 
contact data is maintained only in MYOB AE/AO. This ensures that shared data is 
entered only once, and entered in the central location, which then makes it accessible 
to all the MYOB integrated applications, including Tax and Statutory Reporter.

For a contact that is an organisation, the data taken from MYOB AE/AO is:

 Client code

 Name

 Business address

 Registered address

 Postal address

 ABN

 ACN.

For a contact that is a person, the data taken from MYOB AE/AO is:

 Client code

 Name 

 Home address
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 Postal address

 Date of birth.

Note: A corporation's name can be changed in Corporate Compliance, as the 
registered name may be longer that the field length allowed for in MYOB AE/
AO, whereas people's names can only be changed in MYOB AE/AO. 

Related topics
Changing integrated data
About messages
About changes from AE/AO
Importing contacts from MYOB AE/AO
How Corporate Compliance works with MYOB AE/AO
Opening MYOB AE/AO-integrated Corporate Compliance
Corporate Compliance client/contact tab
Configuring Corporate Compliance for MYOB AE/AO
Corporate Compliance homepages/pages

Changing integrated data

In MYOB AE/AO:

1. Open the client or contact.

2. Amend the name, address or key client attribute value. 

These details are updated to Corporate Compliance when:

 you next open Corporate Compliance 

OR

 if Corporate Compliance is already open, when you next open that person or 
corporation in Corporate Compliance

OR

 if Corporate Compliance is already open when you select Tools > Update from 
AE or Tools > Update from AO.

Related topics
About messages
About changes from AE/AO
Importing contacts from MYOB AE/AO
How Corporate Compliance works with MYOB AE/AO
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Opening MYOB AE/AO-integrated Corporate Compliance
Corporate Compliance client/contact tab
Configuring Corporate Compliance for MYOB AE/AO
Corporate Compliance homepages/pages

About messages

When a data change occurs in MYOB AE/AO that may require an ASIC form to be 
generated, the message:

There are changes to AE. Click here to view.
There are changes to AO. Click here to view.

is displayed in the task panel (in the Messages module) of Corporate Compliance to 
inform you. The changes in MYOB AE/AO that may require an ASIC form to be lodged 
include:

 change of name or home address of an officeholder

 change of business address or registered address of a corporation.

Corporate Compliance checks for these changes when:

 you next open Corporate Compliance 

OR

 if Corporate Compliance is already open, when you next open that person or 
corporation in Corporate Compliance

OR

 if Corporate Compliance is already open when you select the menu Tools > 
Update from AE / Update from AO.

Click on the message There are changes to AE/AO. Click here to view. The Changes 
from AE/Changes from AO screen opens.

Related topics
Changing integrated data
About changes from AE/AO
Importing contacts from MYOB AE/AO
How Corporate Compliance works with MYOB AE/AO
Opening MYOB AE/AO-integrated Corporate Compliance
Corporate Compliance client/contact tab
Configuring Corporate Compliance for MYOB AE/AO
Corporate Compliance homepages/pages
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About changes from AE/AO

When the name or address for any person or corporation is changed in MYOB AE/AO, 
Corporate Compliance checks if notification to ASIC is required. The changes in MYOB 
AE/AO that may require an ASIC form to be lodged include:

 change of name or home address of an officeholder

 change of business address or registered address of a corporation.

If the change from MYOB AE/AO may require notification to ASIC, then Corporate 
Compliance generates a task to inform you of the change.

You can access these tasks by

 clicking Changes from AE or Changes from AO in the task panel

OR

 by clicking on the message There are changes to AE. Click here to view. or 
There are changes to AO. Click here to view. in the Messages module.

Corporate Compliance checks for these changes when:

 you next open Corporate Compliance 

OR

 if Corporate Compliance is already open, when you next open that person or 
corporation in Corporate Compliance

OR

 if Corporate Compliance is already open when you select the menu Tools > 
Update from AE or Tools > Update from AO.

From the Changes from AE/Changes from AO module, you can:

 Notify ASIC of the change by generating a form.

 Not notify ASIC of the change by deleting the task.

To notify ASIC of the change of name or address

To generate an ASIC form to notify the change of name or address:

1. Select the person or corporation in the Changes from AE/Changes from AO list.

2. Select the menu Generate form.
If the change relates to a person, the Notify change of name or address wizard 
opens.
If the change relates to a corporation the Notify change of address wizard 
opens.
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Note: If a change is made in MYOB AE/AO to an address that is shared by 
another person or corporation, then separate tasks will be 
generated in the Changes from AE/Changes from AO module for 
each other person or corporation that shares the address.  
When you then generate an ASIC form from one of the shared 
change of address tasks, all other people or corporations affected 
by the change will be included in the form. The task that you used 
as the basis for the form, and all related tasks will then be deleted 
from the Changes from AE/Changes from AO module.

To remove the task from the change list

If the name or address change entered in MYOB AE/AO is a database correction only, 
and no change notification to ASIC is required. To delete the task:

1. Select the person or corporation in the Changes from AE/Changes from AO list.

2. Select the menu Delete task.

Related topics
Changing integrated data
About messages
Importing contacts from MYOB AE/AO
How Corporate Compliance works with MYOB AE/AO
Opening MYOB AE/AO-integrated Corporate Compliance
Corporate Compliance client/contact tab
Configuring Corporate Compliance for MYOB AE/AO
Corporate Compliance homepages/pages

Importing contacts from MYOB AE/AO

To import contacts into your Corporate Compliance database from MYOB AE/AO

1. Select the Corporate Compliance menu Tools > Import contacts from AE or 
Tools > Import contacts from AO.
The Import contacts from AE/Import contacts from AO window opens. This lists 
all the contacts in the MYOB AE/AO database that are not already in the 
Corporate Compliance database.

2. Tick the checkbox next to each contact to be brought across to the Corporate 
Compliance database.

3. Click OK.
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A confirmation message is displayed "This process may take some time. Do you 
want to continue?".

4. Click Yes to continue with the import.
When the import is completed, the number of successfully imported contacts 
displays.

5. Click OK.

Related topics
Changing integrated data
About messages
About changes from AE/AO
How Corporate Compliance works with MYOB AE/AO
Opening MYOB AE/AO-integrated Corporate Compliance
Corporate Compliance client/contact tab
Configuring Corporate Compliance for MYOB AE/AO
Corporate Compliance homepages/pages

Opening MYOB AE/AO-integrated Corporate Compliance 

You can open Corporate Compliance from MYOB AE/AO in a number of different 
ways.

To open Corporate Compliance from the toolbar

1. Select Corporate Compliance from the drop-down menu on the Corporate 
toolbar button.
Corporate Compliance opens.

To open Corporate Compliance from the menu

1. Select Maintenance > Maintenance Map (AO) > Corporate Compliance > 
Corporate Compliance from the MYOB AE/AO main menu.
Corporate Compliance opens.

To open Corporate Compliance from an MYOB AE/AO client, contact or supplier (AE) 
page

1. Find and open a client, or contact or supplier (AE) in MYOB AE/AO.
The client/contact/supplier’s page will open at the Main tab.

2. Click the Corporate Compliance tab to display its contents. 
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The contents of this page will vary, as shown in the examples in “Corporate 
Compliance client/contact tab” on page 234.

3. If the client/contact/supplier is an existing Corporate Compliance client:

a. Click Open Corporation (if the client/contact/supplier is a company). 

OR

b. Click Open Person (if the client/contact/supplier is a person).

Corporate Compliance will open, displaying this client/contact/supplier’s 
page at the Details tab. (If a person, you will see his/her People page; if a 
company, you will see the company’s Corporations page.)

To open Corporate Compliance from the CC Homepage (AE) / page (AO) in MYOB 
AE/AO

1. Click a hyperlinked name or code on the homepage/page.
In AE, Corporate Compliance will open at the selected company’s Corporations 
page, or the selected person’s People page.

Related topics
Changing integrated data
About messages
Importing contacts from MYOB AE/AO
How Corporate Compliance works with MYOB AE/AO
Corporate Compliance client/contact tab
Configuring Corporate Compliance for MYOB AE/AO
Corporate Compliance homepages/pages

Corporate Compliance client/contact tab

For a MYOB AE/AO install that includes the integrated Corporate Compliance, the 
Client and Contact pages include a tab for Corporate Compliance.

The contents of this Corporate Compliance tab will vary, depending on whether:

 the contact is a person or a company

 the company is or is not a managed company in Corporate Compliance.

If the contact is a managed company in Corporate Compliance

For an organisation that is a managed company in Corporate Compliance, the 
Corporate Compliance tab for the client in MYOB AE/AO has 4 sections:

 Corporation Summary section
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 Officeholders section

 Members section

 ASIC Forms section.

To open this corporation in Corporate Compliance, click Open Corporation.

If the contact is a not managed company in Corporate Compliance

For an organisation that is not a managed company in Corporate Compliance, the 
Corporate Compliance tab for the client in MYOB AE/AO has 2 sections:

 Corporation Summary section

 Shareholder or member of section.

To open this corporation in Corporate Compliance, click Open Corporation.

If the contact is a person who is in Corporate Compliance

For a person that is present in the Corporate Compliance database, the Corporate 
Compliance tab for the client in MYOB AE/AO has 3 sections:

 Person Summary section

 Officeholder of section

 Shareholder or member of section.

To open this person in Corporate Compliance, click on the Open Person.

If the contact is not in Corporate Compliance

For a contact or client that is not present in the Corporate Compliance database, a 
message is displayed, "This contact has not been added to Corporate Compliance." 

Click Open Corporate Compliance on this screen to open Corporate Compliance and 
(manually) add this contact to Corporate Compliance.

Related topics
Changing integrated data
About messages
Importing contacts from MYOB AE/AO
How Corporate Compliance works with MYOB AE/AO
Configuring Corporate Compliance for MYOB AE/AO
Corporate Compliance homepages/pages
Opening MYOB AE/AO-integrated Corporate Compliance
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Configuring Corporate Compliance for MYOB AE/AO

The Corporate Compliance Settings screen is used to set the location of the 
Corporate Compliance database that is integrated with this MYOB AE/AO database, 
and to set the mappings for the data types. The data types that require mappings are 
address types and contact relationship types. This is accessed from the MYOB AE/AO 
menu

Maintenance > Maintenance Map (AO) > Corporate Compliance > Settings.

This screen has 2 tabs, Database Connection and Data Mapping.

Use the Database Connection tab to:

 View the name and location of your MYOB AE/AO database. 

 View and edit your Corporate Compliance Server name and instance. 

Use the Data Mapping tab to:

 View and set (AE) the address type mappings between MYOB AE/AO and 
Corporate Compliance.

 View and set (AE) the contact relationship type mappings between MYOB AE/
AO and Corporate Compliance.

Related topics
Setting your database connection
Mapping address and relationship types
Corporate Compliance client/contact tab
Configuring Corporate Compliance for MYOB AE/AO
Corporate Compliance homepages/pages
Opening MYOB AE/AO-integrated Corporate Compliance

Setting your database connection

The Database Connection tab shows the names and addresses of your MYOB AE/AO 
and Corporate Compliance databases.

To set your database connection

1. Select Maintenance > Maintenance Map (AO) > Corporate Compliance > 
Settings from the MYOB AE/AO main menu.

2. The Corporate Compliance screen opens at the Database Connection tab.
Use the Database Connection tab to:

 View the name and location of your MYOB AE/AO database.

 View, edit and select your Corporate Compliance Server name and instance.
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To set the location of the Corporate Compliance database that is integrated with 
this MYOB AE/AO database

1. Select the SQL Server name and instance where the Corporate Compliance 
database is located.

2. Select the Corporate Compliance database from the drop-down list of database 
available for the above selected SQL instance.

3. Click Update connection details.

Related topics
Configuring Corporate Compliance for MYOB AE/AO
Mapping address and relationship types
Corporate Compliance client/contact tab
Configuring Corporate Compliance for MYOB AE/AO
Corporate Compliance homepages/pages
Opening MYOB AE/AO-integrated Corporate Compliance

Mapping address and relationship types

The Data Mappings tab shows the mappings for address types and relationship types.

Corporate Compliance uses the 4 address types of:

 Business address

 Home address

 Postal address

 Registered address.

Corporate Compliance integrates officeholder relationships with MYOB AE/AO. The 3 
available Corporate Compliance officeholder relationship types are:

 Company Director

 Company Secretary

 Trustee.

To set the address type mappings (AE)

MYOB AE allows you to set any description for your address types. Corporate 
Compliance needs to know which of these address types in MYOB AE are used for the 
4 address types maintained within Corporate Compliance. 

1. Select Maintenance > Corporate Compliance > Settings from the MYOB AE main 
menu.
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2. Click on the Data Mapping tab.

3. In the Address Type Mapping section:
For each Corporate Compliance address type (first column) select the 
corresponding address type from the drop-down list in MYOB AE address type 
(second column).

To set the contact relationship type mappings (AE)

MYOB AE allows you to set any description for your Association Types. Corporate 
Compliance needs to know which of these association types (contact relationship 
types) in MYOB AE are used for the 3 officeholder roles maintained within Corporate 
Compliance. 

1. Select Maintenance > Corporate Compliance > Settings from the MYOB AE main 
menu.

2. Click on the Data Mapping tab.

3. In the Relationship Type Mapping section:
For each Corporate Compliance relationship type (first column) select the 
corresponding address type from the drop-down list in MYOB AE association 
type (second column).

Note: The position of Alternate Director within Corporate Compliance is treated 
within MYOB AE the same as the position of Company Director. The contact 
relationship created in MYOB AE for an Alternate Director will display the 
same mapped relationship type as is set for the position of Company Director.

Related topics
Configuring Corporate Compliance for MYOB AE/AO
Setting your database connection
Corporate Compliance homepages/pages
Corporate Compliance client/contact tab
Opening MYOB AE/AO-integrated Corporate Compliance

Contact associations in MYOB updated from Corporate Compliance

The Associated tab is available in MYOB AE/AO for Contacts, Clients, and Suppliers 
(AE). This shows the other contacts that have a relationship with this 
client\contact\supplier.

When an officer is added to a corporation in Corporate Compliance, the 
corresponding contact association is added in MYOB AE/AO.
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When an officeholder record in Corporate Compliance is changed, ceased or deleted, 
the corresponding contact association in MYOB AE/AO is updated.

Any changes to the contact association that are entered from the MYOB AE/AO 
Client's > Associated tab are not updated to Corporate Compliance.

Related topics
Corporate Compliance homepages/pages
Configuring Corporate Compliance for MYOB AE/AO
Setting your database connection
Corporate Compliance homepages/pages
Corporate Compliance client/contact tab
Opening MYOB AE/AO-integrated Corporate Compliance

Corporate Compliance homepages/pages

There are 3 homepages (AE) / pages (AO) available for Corporate Compliance. These 
are:

 ASIC forms in progress homepage/page

 Company Statements homepage/page

 Name and address changes homepage/page.

Each of these is easily accessed from the drop-down menu on the Corporate toolbar 
button.

ASIC forms in progress homepage/page

The Corporate Compliance ASIC forms in progress homepage lists the ASIC forms you 
have created in Corporate Compliance, but not yet lodged.

Company Statements homepage/page

The Corporate Compliance Company Statements homepage has 2 views.

 Company Statements received from ASIC

 Company Statements due but not yet received.

This view lists the corporations that have not received a company statement, 
calculated based on the corporation's Annual Review Date. 

Name and address changes from MYOB AE/AO homepage/page

When the name or address for any person or corporation is changed in MYOB AE/AO, 
Corporate Compliance checks if notification to ASIC is required. The changes in MYOB 
AE/AO that may require an ASIC form to be lodged include:

 change of name or home address of an officeholder
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 change of business address or registered address of a corporation.

If the change from MYOB AE/AO may require notification to ASIC, then Corporate 
Compliance generates a task to inform you of the change.

The Corporate Compliance Name and address changes from MYOB AE/AO 
homepage/page lists the contacts that have been changed, and shows the changed 
data.

For example, for a change to a person's home address, the change task listed shows 
the new address and the former address. This assists you in determining if an ASIC 
change to details form is required, or if the change is a database correction only.

To setup a Corporate Compliance homepage (AE)

1. Click on the Home icon in the MYOB AE top toolbar.

2. In the My Homepage task group, select the homepage view that this Corporate 
Compliance homepage is to be added into.

3. Under My Homepage tasks on the Task Bar, click Customise homepage.
The Toolbox opens, listing all the available homepages.

4. Select Corporate Compliance from the applications list.

5. Drag the required Corporate Compliance homepage from the Toolbox to your 
homepage area.

6. With the Toolbox still open, re-position and re-align the table and its columns to 
suit your screen size.

7. With the Toolbox still open, click the name of the view you selected at Step 2.. 
(e.g., View2). The Rename View window opens.

8. Overtype the existing view name with a relevant name and click OK. 

9. Close the Toolbox.

10. In the My Homepage tasks group, select Save homepage. 

Changing the name of the homepage view

You can change the name a homepage view at any time to be more relevant to the 
homepage added, eg to change to be Company Statements. 

1. Open the Homepage Toolbox.

2. Click a view on the Task Bar.
The Rename View window opens.

3. Enter in the required name.
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4. Click OK.

Related topics
Importing contacts from MYOB AE/AO
Configuring Corporate Compliance for MYOB AE/AO
Setting your database connection
(AE) Corporate Compliance homepages/pages
Corporate Compliance client/contact tab
Opening MYOB AE/AO-integrated Corporate Compliance
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Corporate Compliance Utilities
The Corporate Compliance Utilities allow you to configure various database and path 
options for your Corporate Compliance system.

You can configure the following Corporate Compliance settings:

 Database references

 Electronic lodgement path.

The Utilities also give you access to:

 Tools

 Error Logs

 Diagnostics list

 Detailed System information.

Related topics
Electronic lodgement path
Database references
Update database
Event logs
Clear event logs
Export event log
Running system diagnostics
Viewing diagnostics logs
Viewing detailed system information

Database references

Access Corporate Compliance Utilities > Settings > Database references.

Note: This setting is only available from the Corporate Compliance server.

This window displays:

 The server where Corporate Compliance is installed.

 Corporate Compliance database version.

 Corporate Compliance database name.

 Corporate Compliance database description.

 Integration mode.

 Segmentation mode.

 Timeout setting (in seconds).
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The only settings that can be changed are the database description and timeout. The 
Timeout setting is the period that the system will take to attempt to complete any 
task in Corporate Compliance before timing out. The recommended setting is 900 
seconds (15 minutes).

To change database references

1. Click Start > Programs > MYOB Accountants Office > Corporate Compliance 
Utilities > Utilities.

2. Click Settings on the Task Bar.

3. Click Change.
The Change database details window displays the name of your Corporate 
Compliance server.

4. Enter the Timeout in seconds. 
The recommended timeout is 15 minutes (900 seconds). The minimum is 30 
seconds. The maximum is 30 minutes (1800 seconds).

5. Click OK.

Note: This feature is available only from the server.

Related topics
Database location
Electronic lodgement path

Database location

This screen shows the Corporate Compliance server and database that this client 
workstation is currently connected to.

Note: This setting is only available from a Corporate Compliance Client.

If you have two or more Corporate Compliance server installations you can determine 
which Corporate Compliance database you are connected to by selecting Help > 
About Corporate Compliance from Corporate Compliance application.

To change the database that this client workstation is connected to

1. Close Corporate Compliance on this client workstation.

2. Click Start > Programs > MYOB Accountants Office > Corporate Compliance 
Utilities > Utilities.



Corporate Compliance Utilities

MYOB AO Corporate Compliance | Version 3.0 User Guide | 244

3. Click Database Location.

4. Click Change.
The Select Corporate Compliance Database Location dialog appears.

5. Select the required Corporate Compliance database server from the drop-down 
list of available servers, or, enter the required server name.

6. Click OK.
A confirmation message is displayed.

7. Click Yes.
The Database location screen is displayed with the selected server showing.
When Corporate Compliance next opens you will be connected to the selected 
database server.

Related topics
Database references
Database location
Electronic lodgement path

Accountants Enterprise/Office integration

Access Corporate Compliance Utilities > Settings > Accountants Enterprise 
integration or Accountants Office integration.

Note: This setting is available from the Corporate Compliance server.

This window displays the server location and database name of the Accountants 
Enterprise database that Corporate Compliance is integrating to.

Related topics
Corporate Compliance Utilities

Electronic lodgement path

Access Corporate Compliance Utilities > Settings > Electronic lodgement path.

This window displays the location where files sent to and from ASIC during an 
electronic lodgement session will be placed.
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Note: This is a temporary copy of the files. The files are kept permanently in your 
Corporate Compliance database.

To change the electronic lodgement path

1. Click Start > Programs > MYOB Accountants Office > Corporate Compliance 
Utilities > Utilities.

2. Click Settings on the Task Bar.

3. Click Electronic lodgement path.

4. Click Change.
The Change electronic lodgement settings window opens.

5. Enter the location or click the button at the end of the field to browse to the 
location.

6. Click OK.

Note: Files will not be moved from the previous location. 
 
The folders created in the new location are: Archive, docqueue, Inbound, 
inqueue, Outbound, outqueue.

Related topics
Corporate Compliance Utilities

Update database

Access Corporate Compliance Utilities > Tools > Update database.

Note: This setting is only available from the Corporate Compliance server.

Use this tool when the Corporate Compliance database is an older version than the 
installed Corporate Compliance application. For example, after a database restore.

To update your database

1. Click Start > Programs > MYOB Accountants Office > Corporate Compliance 
Utilities > Utilities.

2. Click Tools on the Task Bar.
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3. Click Update database on the Task Bar.

4. Click Update.
The database will be updated to the current installed version of Corporate 
Compliance.

Related topics
Corporate Compliance Utilities
Reset database access

Reset database access

Access Corporate Compliance Utilities > Tools > Reset database access.

Note: This setting is only available from the Corporate Compliance server.

Use this tool only when advised by MYOB Client Services.

This would only be required when user permissions have been lost and a user 
permissions denied error message is given when you try to open Corporate 
Compliance.

1. Click Start > Programs > MYOB Accountants Office > Corporate Compliance 
Utilities > Utilities.

2. Click Tools on the Task Bar.

3. Click Reset database access on the Task Bar.

4. Click Reset.
The Corporate Compliance user logins in the database are reset.

Related topics
Corporate Compliance Utilities
Update database

Select database

Accountants Enterprise only

Access Corporate Compliance Utilities > Tools > Select database.

Note: This setting is only available from the Corporate Compliance server.
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When the Corporate Compliance Utilities window is opened, the first available 
Corporate Compliance database is opened by default.

If you have more than one Corporate Compliance database, this screen allows you to 
change the Corporate Compliance database that the Utilities are being run against. 
For example, you may need to update another database to the current version of 
Corporate Compliance.

To select another database

1. Click Start > Programs > MYOB Accountants Office > Corporate Compliance 
Utilities > Utilities.

2. Click Tools on the Task Bar.

3. Click Select database on the Task Bar.

4. Click Click here to select another Corporate Compliance database to run the 
Utilities for.
The Select Corporate Compliance database window opens.

5. Select the required Corporate Compliance database from the drop-down list of 
available databases.

6. Click OK. 
The Update Corporate Compliance database is displayed with the selected 
Corporate Compliance database showing at the top of the screen.

Related topics
Corporate Compliance Utilities
Select database
Update database

Create database

Accountants Enterprise only

Access Corporate Compliance Utilities > Tools > Create database.

Note: This setting is only available from the Corporate Compliance server.

Use this tool only when advised by MYOB Client Services.

This window lists the databases already created for this Corporate Compliance install.
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To create an additional Corporate Compliance database

1. Click Start > Programs > MYOB Accountants Enterprise > Corporate Compliance 
Utilities > Utilities.

2. Click Tools on the Task Bar.

3. Click Create database on the Task Bar.
The Create Corporate Compliance Database dialog opens.

4. Enter in the database name.
This is the SQL database name. The database name defaults to the Corporate 
Compliance naming structure, with next available Corporate Compliance 
database number. For example, CorporateCompliance2.

5. Enter in the database description.
This is the description used to distinguish the databases when selecting from a 
list of Corporate Compliance database. For example, you may want to use your 
practice name or business name as the database description.

6. Click OK.
The Create database window opens with the newly added database listed.
You now need to update this new database to the current version of Corporate 
Compliance.

7. Select Tools > Update database.

8. Click Update.

Related topics
Corporate Compliance Utilities
Create database
Update database

Event logs

Access Corporate Compliance Utilities > Event Logs.

Viewing event logs

The Event Logs show a list of the warning messages and error messages generated by 
the Corporate Compliance system. 

The list defaults to showing all messages from the last 24 hours. To view previous 
messages, un-tick the Show logs for last 24 hours only option at the bottom of the 
list.
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To view messages for only Corporate Compliance, select Corporate Compliance from 
the Application drop-down options. To show all messages again click X beside the 
drop-down list under the Application column header.

To view messages for just one type of severity (for example, only view errors), click 
the drop-down list under the Severity column header. The options are Error, Warning 
and Info. Select the required severity level. To show all messages again, click X beside 
the drop-down list under the Severity column header.

To view messages for just one workstation, click the drop-down list under the 
Machine column header and select the workstation required. To show all messages 
for all workstations again click X beside the drop-down list under the Machine column 
header.

To view messages for just one user, click the drop-down list under the User column 
header and select the required user. To show all messages for all users again, click X 
beside the drop-down list under the User column header.

Related topics
Clear event logs
Export event log

Clear event logs

To clear the event log

1. Click Start > Programs > MYOB Accountants Office > Corporate Compliance 
Utilities > Utilities.

2. Click Event Logs on the Task Bar.

3. Click Clear log on the Task Bar.
A confirmation message displays.

4. Click Yes.

Related topics
Event logs
Export event log
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Export event log

To export event logs

1. Click Start > Programs > MYOB Accountants Office > Corporate Compliance 
Utilities > Utilities.

2. Click Event Logs on the Task Bar.

3. Click Export log on the Task Bar.
The Save As window opens.

4. Select the location for the export file to be saved.

5. Enter a File name for the export file.

6. Click Save.

Related topics
Event logs
Clear event logs

System information

Access Corporate Compliance Utilities > System Information.

This screen allows you to run a series of system diagnostics over the server or 
workstation.

Related topics
Running system diagnostics
Viewing diagnostics logs
Viewing detailed system information

Running system diagnostics

1. Click Start > Programs > MYOB Accountants Office > Corporate Compliance 
Utilities > Utilities.

2. Click System Information on the Task Bar.

3. Click Diagnostics list on the Task Bar. 

4. Click Run Diagnostics.
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The system reads the various settings and configuration files of your server or 
workstation and produces a diagnostic log. 
To view the diagnostic log select the View diagnostics log task. The top of the 
screen shows the full path and file name of the text file created. 
Click the Detailed information task to view the breakdown of the various 
system components analysed. Click on the required tab to view the details of 
that system area. 
The components analysed are:

 System 

 Operating System

 Internet Explorer

 Adobe Reader

 Network Configuration

 .Net Framework

 Logical Disk Drives

 Printers 

 Modem 

 MDAC

 Install Details

 MSDE / SQL Server 

 .config Files

 Error logs 

 Application Files

 Crystal Reports

 KdTele Modem Control

 Logical Memory Configuration

 System Catalog.

Related topics
Corporate Compliance Utilities
Viewing diagnostics logs
Viewing detailed system information

Viewing diagnostics logs

Before you can view the diagnostic logs, you need to run the system diagnostics.
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To view diagnostic logs

1. Click Start > Programs > MYOB Accountants Office > Corporate Compliance 
Utilities > Utilities.

2. Click View diagnostics log on the Task Bar.
The Diagnostic log file displays. The top of the screen shows the full path and file 
name of the text file created.

3. To print the log file, click Print.

Related topics
Corporate Compliance Utilities
Running system diagnostics
Viewing detailed system information

Viewing detailed system information

Before you can view the detailed system information, you need to run the system 
diagnostics.

To view detailed system information

1. Click Start > Programs > MYOB Accountants Office > Corporate Compliance 
Utilities > Utilities.

2. Click Detailed Information on the Task Bar.
A group of tabs displays the results of the diagnostic tests specific to each area 
after you have clicked Run Diagnostics. 

3. Click on the required tab to see the diagnostic details of that area.

Related topics
Corporate Compliance Utilities
Running system diagnostics
Viewing diagnostics logs

Security

Accountants Enterprise only

Setting user security access for Corporate Compliance is optional. When you install 
Corporate Compliance the user security is turned off by default.
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The security system is flexible - you can choose to use the Windows authentication 
(user logon provided by Windows), or set up unique logon names and passwords that 
must be entered by users when accessing Corporate Compliance, Corporate 
Compliance Utilities and Corporate Compliance Backup.

You can select one of three security levels:

 Level 1 - No security

 Level 2 - Security: automated logon using windows user logon

 Level 3: - Security: logon name and password required.

Changing the security level will not affect the list of users or change any user logon 
details.

Related topics
Security by-pass
User access security checking on opening Corporate Compliance
User access

User access security checking on opening Corporate Compliance

Accountants Enterprise only

When you open the Corporate Compliance application or the Corporate Compliance 
Utilities, the system will check the security settings for the selected database.

If security is not enabled, Corporate Compliance will open and no checks will be made 
against the user list for this database.

If security is enabled and the administrator has nominated the windows logon to be 
used, the windows logon will be verified against the list of users that have access to 
this database.

If security is enabled and the administrator has nominated that you need to enter a 
unique logon name and password to gain access to the application, the user logon 
window displays.

In the case where you have lost the password for all users and cannot access 
Corporate Compliance, contact MYOB Client Services for a Security by-pass key.

Related topics
Security
Security by-pass
User access
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Security by-pass

Accountants Enterprise only

If security access is enabled, and you have lost the password for all users and cannot 
access Corporate Compliance, contact MYOB Client Services for a Security by-pass 
key.

1. Click Start > Programs > MYOB Accountants Office > Corporate Compliance 
Utilities > Utilities.

2. Click Security By-Pass on the Task Bar.

3. Click Bypass.
The By-Pass Security window opens.

4. Contact MYOB Client Services.

 You will be asked to provide the Key to Quote.

 You will be given an Unlock Key to enter.

5. Click OK.
If the unlock key is valid, the security option is turned off.

6. Close and re open the Corporate Compliance Utilities.
You can now change the user security settings.

Related topics
Security
User access security checking on opening Corporate Compliance
User access

User access

Accountants Enterprise only

You can restrict access to Corporate Compliance, Corporate Compliance Utilities 
and/or Corporate Compliance Backup separately.

Users can be assigned either of two roles — Administrator or User.

An Administrator is automatically granted unlimited access to Corporate 
Compliance, Corporate Compliance Utilities, Corporate Compliance Backup and 
security.

A User can be prevented from accessing Corporate Compliance, Corporate 
Compliance Utilities or Corporate Compliance Backup. A User cannot access 
security. Users can change passwords at any logon session.
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The Administrator nominated by the user can change password details for any users.

MYOB Support can assist if users have forgotten their logon names and passwords.

A limited audit trail is provided. Information logged when a user action occurs 
includes identification of the machine, and user ID.

Users will not lose the user security information entered for a database when moving 
a database from one server to another.

Related topics
Adding users
Changing passwords
Changing user access details
Deleting users

Adding users

Accountants Enterprise only

To add new users in Utilities

1. Click Security on the Task Bar.
The server security settings will be displayed.

2. Under Security, select one of the following security levels.

 Level 1 — No security — users can be added but will not be used.

This option allows unlimited access to the Corporate Compliance database.

The Add, Change Password, Change Details and Delete buttons are 
disabled. The Users list is also disabled.

 Level 2 — Security — automatic logon using windows logon name.

This option allows limited access to the Corporate Compliance database 
and a user logon is not required. Upon opening Corporate Compliance, 
Corporate Compliance Utilities and Corporate Compliance Backup, the 
system will check the windows user logon against the list of users that can 
access the database.

The Add, Change Details and Delete buttons are enabled. The Users list is 
also enabled.

The Change Password button is disabled. 

 Level 3 — Security — user logon and password entry required.

This option allows limited access to the Corporate Compliance database. 
User logon is required upon opening Corporate Compliance, Corporate 
Compliance Utilities and Corporate Compliance Backup.
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The Add, Change Password, Change Details and Delete buttons are 
enabled. The Users list is also enabled. 

3. Click Apply.

4. Click Add.
The Add User window opens.

5. Enter Logon name.
The Logon name can have between 2 and 60 combinations of the following 
characters:

a to z, A to Z, 0 to 9, space, ! # $ & ’ ( ) * + , - . / : ; < = > ? @ %   \ { | }

The Logon name must be unique — it cannot be the same logon name as any 
other user in the database. Logon names are not case sensitive.

6. Enter Password (a maximum of 15 alphanumeric characters), if you have 
selected the Level 3 security option that requires a user logon.

Note: Passwords are case sensitive and must have at least 6 alphanumeric 
characters.

7. Enter the password again in Confirm Password.

8. Select the Access level.
When the access level User is selected,  Allow user to access Corporate 
Compliance Backup is enabled, and selected by default.
If the selected database has no administrator, the default option selected is 
Administrator. If there is an administrator, the default option selected is User.

9. Click OK.
The new user is added to the Users list.

Related topics
Changing passwords
Changing user access details
Deleting users

Changing passwords

Accountants Enterprise only

To change a password

1. Click Security on the Task Bar.
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The server security settings will be displayed.

2. Under Security, select Security — user logon and password entry required.
This option allows limited access to the Corporate Compliance database. A user 
logon is required when opening Corporate Compliance, Utilities and Backup.

3. Click Apply.

4. Click Change Password.
The Change Password window opens.

5. Enter the new Password (a maximum of 15 alphanumeric characters).

6. Re-enter the new password in Confirm Password.

7. Click OK.

Related topics
Adding users
Changing user access details
Deleting users

Changing user access details

Accountants Enterprise only

To change user access details

1. Click Security on the Task Bar.

The server security settings will be displayed.

2. Click the required user name in the Users list.

3. Click Change Details.
The Change Details window opens.

4. Change the Logon name and Access level as required.

5. Click OK.

Related topics
Adding users
Changing passwords
Deleting users
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Deleting users

Accountants Enterprise only

To delete users

1. Click Security on the Task Bar.
The server security settings will be displayed.

2. Click the required user name in the Users list.

3. Click Delete.
A Security message will prompt you to confirm deletion.

4. Click Yes to delete the user.
The user is deleted from the Users list.

Note: If the selected user is an Administrator, the system checks if there is another 
administrator. If there is none, this user cannot be deleted.

Related topics
Adding users
Changing passwords
Changing user access details
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Backup and restore
The Corporate Compliance Backup and Restore utility lets you automate the process 
of backing up your database files. 

The main features allow you to:

 Schedule backups to run at any time of the day.

 Check if a recent backup has been run when Corporate Compliance opens.

 Take an immediate backup at any time.

 Perform backups while users are in the system.

 Specify the number of backups stored at any one time.

 View the history of files backed up.

 Restore backups.

The Backup and Restore utility is available from both Server and Client installations. 
You cannot, however, perform a restore from Client installations.

To open the Corporate Compliance backup and restore utility:

 Click Start > Programs > MYOB Accountants Office > Corporate Compliance 
Utilities > Backup.

The Corporate Compliance Utilities window opens displaying the Backup and 
Restore screen.

Related topics
Backup files list
Schedule a Corporate Compliance backup
Take a backup
Restore from a backup file
Deleting backup files
Backup settings
Change backup settings
Add backup file to the list

Backup files list

The currently available backup files are displayed on the Backup and Restore screen.

To open the backup files list

1. Open the Corporate Compliance Utilities Backup and Restore screen.
See “Backup and restore” on page 259.

2. Click Backup and Restore on the Task Bar.
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The Corporate Compliance database backups list is displayed.

The Corporate Compliance backup system will only keep backup files for the number 
of weeks specified on the Settings screen. To keep a backup file permanently, or for 
longer than the specified period, set the backup file to Retain. Backup files set as 
Retain will not be deleted by the Corporate Compliance backup service. You can 
delete these files manually when they are no longer required.

From this list you can:

 Change the backup file description.

 Change the backup file retention type.

 Restore a backup file.

 Delete a backup file.

 Take an immediate backup of the Corporate Compliance database.

Related topics
Change backup file details
Schedule a Corporate Compliance backup
Take a backup
Restore from a backup file
Deleting backup files
Backup settings
Change backup settings
Add backup file to the list

Change backup file details

To change the backup file details

1. Open the Corporate Compliance Utilities Backup and Restore screen.
See “Backup and restore” on page 259.

2. Click Backup and Restore on the Task Bar
The Corporate Compliance database backups list is displayed.
The details for a row that can be changed are: 

 Description

 Retention type.

3. Select the required backup file (highlight the row).

4. To change the description, click onto the Description field, and enter in the 
details.
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5. To change the retention type, click on the down arrow against the Type field. 
Select the type as either Retain or Not retain.

Related topics
Backup files list
Schedule a Corporate Compliance backup
Restore from a backup file
Deleting backup files
Backup settings
Change backup settings
Add backup file to the list

Take a backup

To take an immediate backup of Corporate Compliance data

1. Open the Corporate Compliance Utilities Backup and Restore screen.
See “Backup and restore” on page 259.

2. Click Backup and Restore on the Task Bar.
The Corporate Compliance database backups list is displayed.

3. Click Backup Now.
The Backup Now dialog opens.

4. Select the Retention Type: 

 Not Retain (this is the default setting)

or

 Retain.

5. Enter the backup file name.
The name of the backup file defaults to 
CorporateCompliance_yyyymmdd_hhmm.bak. This can be changed if required.

6. Enter the backup file description.
The Description of the backup file defaults to CorporateCompliance backup for 
dd-mm-yyyy. This can be changed if required.

7. Click OK.
A confirmation message displays.

8. Click OK.
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To return to the backup files list.

Related topics
Backup files list
Schedule a Corporate Compliance backup
Restore from a backup file
Deleting backup files
Backup settings
Change backup settings
Add backup file to the list

Restore from a backup file

To restore your Corporate Compliance database from a backup file

1. Open the Corporate Compliance Utilities Backup and Restore screen.
See “Backup and restore” on page 259.

2. Click Backup and Restore on the Task Bar.
The Corporate Compliance database backups list is displayed.

3. Select the backup file to be restored.

4. Click Restore.
A message displays asking you to ensure all users have exited from the 
Corporate Compliance application.

5. Click OK.
A message displays informing you that you are about to overwrite the current 
database with the backup.

6. Click Yes.
The restore is performed and a confirmation message is displayed.

7. Click OK.
To return to the backup files list.
If the backup file that was restored is not the same as the currently installed 
version of Corporate Compliance, then you will also need to update this 
database to the latest version. Refer to “Update database” on page 245.

Note: You cannot run Restore from a client installation. The restore must be 
performed from the Corporate Compliance server.
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Related topics
Backup files list
Schedule a Corporate Compliance backup
Take a backup
Deleting backup files
Backup settings
Change backup settings
Add backup file to the list

Deleting backup files

To delete a backup file

1. Open the Corporate Compliance Utilities Backup and Restore screen.
See “Backup and restore” on page 259.

2. Click Backup and Restore on the Task Bar.
The Corporate Compliance database backups list is displayed.

3. Select the required backup file from the list.

4. Click Delete.
A confirmation message is displayed.

5. Click Yes.
The backup file is removed from the backup files list.

Related topics
Backup files list
Schedule a Corporate Compliance backup
Take a backup
Restore from a backup file
Backup settings
Change backup settings
Add backup file to the list

Delete all out of date backup files

Corporate Compliance backups that are marked as Not Retain are deleted by the 
system when they are older than the number of weeks specified by your practice. The 
check for out–of–date backup files is performed when a Corporate Compliance 
backup is taken, and when a Corporate Compliance backup file is deleted.
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 You can also clear out old backup files manually at any time.

To delete out of date backup files

1. Open the Corporate Compliance Utilities Backup and Restore screen.
See “Backup and restore” on page 259.

2. Click Backup and Restore on the Task Bar.
The Corporate Compliance database backups list is displayed.

3. Click Delete out of date backup files.
The system deletes any backup files marked as Not Retain, that are older than 
the number of weeks the databases are kept for as specified in the backup 
settings.

Related topics
Backup files list
Schedule a Corporate Compliance backup
Take a backup
Restore from a backup file
Backup settings
Change backup settings
Add backup file to the list

Add backup file to the list

If you need to bring across a Corporate Compliance backup file from another server, 
for example if you are moving Corporate Compliance to a new server, then you can 
add that backup file to your backup files list so that it can be restored onto this server.

To add a backup file to the Corporate Compliance database backups list

1. Open the Corporate Compliance Utilities Backup and Restore screen.
See “Backup and restore” on page 259.

2. Click Backup and Restore on the Task Bar.
The Corporate Compliance database backups list is displayed.

3. Click Add backup file.
The Add backup file window opens.

4. Click the ellipsis next to the Select backup file field to browse to the required 
Corporate Compliances backup file.
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5. Select the Retention Type.

6. Enter the backup file description.

7. Click OK.
The system returns to the backup files list with the newly added backup file 
included in the list.

Related topics
Backup files list
Schedule a Corporate Compliance backup
Take a backup
Restore from a backup file
Backup settings
Change backup settings
Add backup file to the list
Change Corporate Compliance database being referenced in backup & restore list

Change Corporate Compliance database being referenced in backup & restore list

Accountants Enterprise only

The Corporate Compliance database field at the top of the backup list shows both the 
database name and database description.

This is a drop-down list that allows you to select the Corporate Compliance database 
that you are performing the backup or restore for.

You must ensure that the correct database is displayed at the top of this screen prior 
to performing a Backup Now or Restore.

The backup files list shows backups from all your databases.

The backup files can usually be identified by the database name, which is by default 
always the first part of the backup file name.

Related topics
Backup files list
Schedule a Corporate Compliance backup
Restore from a backup file
Deleting backup files
Backup settings
Change backup settings
Add backup file to the list
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Backup settings

The file locations used by the Corporate Compliance backup system are maintained 
using the Corporate Compliance Backup Utility, on the Settings tab.

This screen shows:

 Backup Files Location

This is the location where all backup files are stored. The location should be a 
shared drive, that all the Corporate Compliance client installs can access.

 Backup files retention period

The Corporate Compliance backup system will only keep backup files for the 
number of weeks specified here. To keep a backup file permanently, or longer 
than the specified retention period, you need to set the backup file to Retain. 
Backup files set as Retain will not be deleted by the Corporate Compliance 
backup system. You can manually delete these files when they are no longer 
required.
We also recommend that special backups, such as immediately prior to, and 
after software upgrades are marked as such, and set as Retain. 
The description should be updated to indicate when the backup file was taken. 
For example, “CC 2.3 data backup prior to install CC 3.0” or “CC 3.0 data backup 
after install CC 3.0”. These special backups should be kept until superseded by 
backups for the next software upgrade.

 Check for backup on opening of Corporate Compliance

You can setup the system to check for a recent backup of Corporate Compliance 
each time it is opened. 
The number of days to check for a recent backup can be set as 1 to 9 days. The 
recommended check is for every 2 days.

Related topics
Backup files list
Schedule a Corporate Compliance backup
Take a backup
Restore from a backup file
Deleting backup files
Change backup settings
Add backup file to the list

Change backup settings

The Corporate Compliance backup settings can only be changed from the Corporate 
Compliance server.
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To change backup settings

1. Open the Corporate Compliance Utilities Backup and Restore screen.
See “Backup and restore” on page 259.

2. Click Settings on the Task Bar.

3. Click Change.
The Change backup file settings dialog is displayed and you can change:

 Backup Files Location

To change the backup files location enter in the required path, or click on 
the ellipsis next to this field to browse to the required location.

The location should be a shared drive, that all the Corporate Compliance 
client installs can access.

 Backup Files Retention

Specify the number of weeks to keep the backup files. You can enter from 2 
to 52 weeks.

We recommend that you keep backup files for at least 4 weeks.

 Check for recent backup on opening of Corporate Compliance

Tick Perform backup on opening Corporate Compliance, if the backup has 
not been taken in the last n days to specify that you want Corporate 
Compliance to check that a recent backup exists when the Corporate 
Compliance application is opened. We recommend that this option is 
selected.

The number of days to check for a recent backup can be set as 1 to 9 days. 
The recommended check is for every 2 days.

4. Click OK.
To return to the Settings window.

Related topics
Backup files list
Schedule a Corporate Compliance backup
Take a backup
Restore from a backup file
Deleting backup files
Change backup settings
Add backup file to the list
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Schedule a Corporate Compliance backup

The Corporate Compliance backups can be scheduled to be made on a regular basis 
using the Windows Task Scheduler.

Note: Scheduled backups must be done from the Corporate Compliance server.

To set up a schedule for the Corporate Compliance backups add a task to the 
Windows Task Scheduler that will execute the Corporate Compliance backup routine, 
BackupCCDatabases.exe. 

This file is located in the Utilities sub–folder of the Corporate Compliance Server 
install. For example C:\Program Files\MYOB\Corporate Compliance\Utilities

The following steps walk you through an example of setting up a task in Windows 7: 

1. Open Task Scheduler in Windows and select Create Basic Task.
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2. Enter a Name and Description for the task. Click Next.

3. Select when you when the backup to run. Click Next.
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4. Select the start date and time for your backup. Click Next.

5. Select Start a program. Click Next.

o

6. Click Browse and find the backup utility, example: C:\Program 
Files\MYOB\Corporate Compliance\Utilities\CCDatabasesBackup.exe.
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7. Click Next.

8. Click Finish to save the task.

Information on the Corporate Compliance backup program:

 The backup application will only backup Corporate Compliance databases within 
the Corporate Compliance SQL instance.

 A report BackupCCDatabases.log is created in the folder 
%user%\%appdata%\CorporateCompliance\Temp 

 A report BackupRestore.log with more technical details in relation to backing up 
(or restoring) of is created in the folder 
%user%\%appdata%\CorporateCompliance\Temp\

 When the size of the report BackupCCDatabases.log exceeds 2MBs, it will be 
renamed to BackupCCDatabases_old.log

 When the size of the report BackupRestore.log exceeds 2MBs, it will be 
renamed to BackupRestore_old.log

 Backup files will be saved in the location specified in the Corporate Compliance 
database backup settings.

 The naming of backup files is: CC_ database_name_yyyymmdd_hhmm.bak 
For example, CorporateCompliance_20101118_1045.bak 

Related topics
Backup files list
Take a backup
Restore from a backup file
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Deleting backup files
Backup settings
Change backup settings
Add backup file to the list
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